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MYOB US, Inc. Software License Agreement

This is an agreement between you, the end user and MYOB US, Inc. 
(“MYOB”). By installing and/or using this version of MYOB software (the 
“Software”), you are agreeing to become bound by the terms of this 
agreement.

IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT 
USE THIS SOFTWARE. PROMPTLY REMOVE IT FROM YOUR COMPUTER. 
You may then return the entire package and your receipt within 30 days to 
the place from which it was obtained, or to MYOB, for a refund of the 
purchase price. Until return of this package has been accepted, you are 
governed by this Agreement.

This Software is protected by copyright laws and international treaties and 
may only be used in accordance with the license terms.

LICENSE. MYOB hereby grants to you, the original purchaser, a paid-
up, non-transferrable (except as specified below), non-exclusive 
license (the “License”) to use the enclosed program and User’s 
Guide (the “Software”) subject to this Agreement.

a. SINGLE SITE. You may use the Software on the number of licensed worksta-

tions at a single location. You may transfer the Software from one such 

computer to another provided that you do not use or permit the usage of 

the Software on more than the licensed number of computers or computer 

terminals at a time.

b. COPIES. You may not copy or duplicate the Software, except as necessary 

solely for archival purposes, program error verification, or to replace defec-

tive storage media. You agree to retain the Software and all such copies in 

your possession.

c. RESTRICTIONS; TRANSFER. Except as permitted by this paragraph, you may 

not sublicense, lease, rent, lend, or distribute the Software or any lawful 

copies thereof or otherwise transfer any of your rights under this 

Agreement. Except when you use this license to obtain special upgrade 

pricing on Software from MYOB, you may transfer the Software (together 

with all back-up copies you have made) and the manual(s) on a permanent 

basis to a third party so long as you retain no copies, the transferee agrees 

to be bound by the terms of the Agreement, and you notify MYOB in 

writing of such transfer.

d. TERM. The License is effective until terminated. You may terminate the 

License at any time by destroying the Software together with all copies. The 
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License is automatically terminated if you violate any portion of this Agree-

ment. You agree upon any such termination to destroy the Software 

together with all copies. Upon termination, there will be no refund of any 

monies paid by you except in connection with the 30 day return policy set 

forth above. Termination of this License shall be in addition to and not in 

lieu of any other remedies available to MYOB.

LICENSE REGISTRATION. IF YOU ARE A NEW USER, YOU MUST REGISTER THE 
SOFTWARE WITH MYOB (for registration procedure, refer to Getting Started 
manual). You may only access the software TWENTY-FIVE (25) times with-
out registering. after the twenty-fifth time, the registration screen will 
appear but use of the software will be prevented until you register.

CONTINUING FULFILMENT. If MYOB elects, in its sole discretion, to produce sub-
sequent updates and revisions to the Software (collectively, “Updates”), you 
may receive such Updates as they become available. All Updates are subject to 
the terms of this License. 

COPYRIGHT PROTECTION. The Software is protected by United States and Inter-

national Copyright Law. ANY USE OF THE SOFTWARE, EXCEPT AS 

EXPRESSLY PERMITTED IN THIS LICENSE AGREEMENT, MAY SUBJECT YOU 

TO CIVIL DAMAGES AND LEGAL FEES, AND MAY BE A SERIOUS CRIME. 

TAX TABLES. YOU ASSUME FULL RESPONSIBILITY FOR THE SELECTION OF 

THE PAYROLL TAX TABLES AND SALES TAX TABLES (“TAX TABLES”) TO 

ACHIEVE YOUR INTENDED PURPOSES, FOR THE PROPER INSTALLATION 

AND USE OF THE TAX TABLES AND FOR VERIFYING THE RESULTS 

OBTAINED FROM USE OF THE TAX TABLES. MYOB DISCLAIMS ANY WAR-

RANTY OR CONDITION THAT THE FUNCTIONS CONTAINED IN THE TAX 

TABLES WILL MEET YOUR REQUIREMENTS OR THAT THE OPERATION OF 

THE TAX TABLES WILL BE INTERRUPTION OR ERROR FREE.

PROFESSIONAL ADVICE. MYOB IS NOT ENGAGED IN RENDERING LEGAL, 

ACCOUNTING OR OTHER PROFESSIONAL SERVICE. IF LEGAL ADVICE OR 

OTHER EXPERT ASSISTANCE IS REQUIRED, THE SERVICE OF A COMPETENT 

PROFESSIONAL PERSON SHOULD BE SOUGHT. IT IS YOUR RESPONSIBIL-

ITY TO KEEP INFORMED OF ACCOUNTING, TAX, AND/OR PAYROLL 

CHANGES THAT MAY AFFECT YOU AND TO ENSURE THAT YOU FOLLOW 

THESE CHANGES.
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CONFIDENTIALITY. The software constitutes confidential Information and con-

tains trade secrets of MYOB. You are not permitted to disclose the software to 

any third part except in accordance with this Agreement. You may not reverse 

engineer, disassemble, or decompile the software.

LIMITED WARRANTY AND DISCLAIMERS OF WARRANTY. MYOB warrants that the 

media on which the Software is recorded is free from defects in materials and 

workmanship under normal use for a period of 30 days from the date of your 

original purchase. THE SOFTWARE AND RELATED MATERIALS ARE PRO-

VIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR 

IMPLIED, INCLUDING WARRANTIES OF MERCHANTABILITY OR FITNESS 

FOR ANY PARTICULAR PURPOSE OR ANY OTHER STATUTORY OR COM-

MON LAW WARRANTIES. NO WARRANTY IS MADE REGARDING THE PER-

FORMANCE OF THE SOFTWARE OR THE RESULTS THAT MAY BE OBTAINED 

BY USING THE SOFTWARE. THE ENTIRE RISK AS TO THE INSTALLATION, 

USE, QUALITY, AND PERFORMANCE OF THE SOFTWARE IS WITH YOU. It is 

your responsibility to verify the results obtained from use of the Software.

Some jurisdictions do not allow the limitation or exclusion of implied warran-

ties, so the above limitation or exclusion may not apply to you. This warranty 

gives you specific legal rights and you may also have other rights which vary. 

This disclaimer of warranties and the limitation of liability below shall not be 

modified, diminished or affected by and no obligation or liability will arise or 

grow out of the rendering of technical, programming, or other advice or ser-

vice or the provision of support for the Software by MYOB.

LIMITATION OF REMEDIES. MYOB’s entire liability to you and your exclusive rem-

edy shall be the replacement of any defective CD-ROM returned by you to 

MYOB with proof of purchase during the 30-day limited warranty period, as set 

forth above. IN NO EVENT WILL MYOB BE LIABLE TO YOU FOR ANY 

DIRECT, INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES 

(INCLUDING BUT NOT LIMITED TO LOST REVENUES, DATA, PROFITS OR 

SAVINGS) ARISING OUT OF YOUR USE OR INABILITY TO USE THE SOFT-

WARE EVEN IF MYOB HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 

DAMAGES. IN NO EVENT SHALL THE LIABILITY OF MYOB ARISING FROM 

YOUR USE OR INABILITY TO USE THE SOFTWARE EXCEED THE FEE PAID BY 

YOU FOR THIS LICENSE. Some jurisdictions do not allow the limitation or 
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exclusion of liability for incidental or consequential damages so the above limi-

tation or exclusion may not apply to you.

GENERAL. This Agreement will inure to the benefit of MYOB, its successors, 
and assigns and will be construed under the laws of New Jersey, except for 
that body of laws dealing with conflict of laws. If any provision of this 
Agreement is deemed invalid by a court of competent jurisdiction, such 
provision shall be enforced to the maximum extent permitted and the 
remainder will remain in full force. This Agreement is the entire agreement 
between you and MYOB in respect of the software. 
MYOB AccountEdge, Version 3 us
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 Chapter 1
Getting
Started
Thank you for purchasing MYOB AccountEdge, which has been designed to make it easy 
for you to keep track of your important financial information.

Keeping track of where your money is going is an important part of managing your 
business. By using MYOB AccountEdge, you’ll soon see that there is more to managing 
your business than just keeping an eye on the cash book. If you’re using a computerized 
accounting system for the first time, you will find yourself organized, informed and in 
control of your business with MYOB AccountEdge.

If you’ve never worked with debits and credits, don’t worry—MYOB AccountEdge handles 
the ‘double-entry accounting system’ behind the scenes. It doesn’t hurt to have a rough 
idea of what it’s all about though; your accountant can help you understand the basics if 
you need assistance.

MYOB AccountEdge follows all the Macintosh conventions; so what you know from using 
other applications will translate easily to MYOB AccountEdge. What you know about file 
management, copying, cutting, pasting and entering information all apply to MYOB 
AccountEdge.

In addition to this User Guide, we have provided you with a comprehensive on-line help 
system– MYOB Help.

Use these tools and think of the way your business works. This will help you integrate 
MYOB AccountEdge’s many features with the needs of your business.

MYOB AccountEdge’s flexibility allows you to customize the application to fit in with the 
way you work. So it is important that you have a clear picture about your business and 
what accounting information you want to capture. 

For example, you might start thinking about your main areas of income and how your 
customers pay you for goods and services. Is your business a sole proprietorship, 
partnership or a corporation? As you read through this User Guide, take notes on the 
MYOB AccountEdge features you think will be useful to your business.
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Learning Tools
We, at MYOB, are committed to making MYOB AccountEdge a 
product that is easy to use. For that reason we have developed 
comprehensive learning tools that will teach you the fundamentals 
of MYOB AccountEdge, support you as you set up your company’s 
records and back you up in your everyday work with the product. 
Using these tools, you should find the answers to all your routine 
questions about how to use MYOB AccountEdge. If you have any 
questions, we recommend that you explore these tools before you 
call our Technical Support department.

The MYOB AccountEdge User Guide

This User Guide is intended for use with MYOB AccountEdge 
Version 3. 

This User Guide has been designed to be used in conjunction with 
MYOB Help, MYOB AccountEdge’s comprehensive online help. (For 
more information, see ‘MYOB Help’ on page 10.)

This User Guide contains the basic information you need to set up 
and run your MYOB AccountEdge system on a day to day basis.

More extensive information is available in the MYOB Help system. 
Where necessary—for example, for detailed field help, advanced 
procedures, overviews and helpful tips—the User Guide will refer 
you to MYOB Help.

References to MYOB Help

The User Guide uses the following methods to refer you to the 
MYOB Help for more information. 

Help button When completing a task in MYOB AccountEdge 
window, you can click Help in that window (see ‘Help buttons’ on 
page 11). MYOB Help will be displayed, providing you with a 
Chapter 1 Getting Started10
detailed description of each field in that window, and with 
instructions on tasks you can perform in that window.

Specific references The User Guide has direct references to 
specific topics in MYOB Help. Use the contents panel on the left side 
of MYOB Help to find the main entry, and then click on the relevant 
topic.

MYOB Help

MYOB Help is MYOB AccountEdge’s comprehensive online learning 
system. It can help you with every task you want to perform in 
MYOB AccountEdge). Depending upon your preferences and your 
access to the Internet, you can choose to view MYOB Help either on 
the World Wide Web (at http://help.myob.com) or using help files 
on your computer. If you have access to the Internet, you might 
want to use the Web-based version of MYOB Help, since it's 
updated continually and may provide extra information or learning 
tools that aren't available in your computer-based version. 

If you don’t have access to the Internet or you prefer to keep your 
phone line free for other activities, use the version of MYOB Help 
that was installed on your computer. 

You can switch between the Web-based version and the version on 
your computer by marking or clearing the I Prefer to Use Help 
From the Internet, Rather Than My Computer preference. (This 
option appears in the System view of the Preferences window.)

You can access MYOB Help by choosing MYOB AccountEdge Help 
from the Help menu or by clicking Help from any window in MYOB 
AccountEdge. You can also access MYOB Help by clicking the  
icon in the top right corner of a command center window. 
MYOB AccountEdge, Version 3 us



Help buttons

Help buttons make it easy to find answers to the questions you may 
have while working with MYOB AccountEdge. These buttons 
appear in the lower left corner of MYOB AccountEdge windows. 
When you click Help, MYOB Help appears in your Web browser, 
displaying information about the window you're currently viewing. 
With a few clicks, you can learn more about the individual fields and 
buttons in the window, step-by-step instructions for the tasks you 
can perform in the window, and more.

Using MYOB Help

MYOB Help is designed to answer your questions about MYOB 
AccountEdge and to help you make the most of your software. 

To display MYOB Help, click Help in any window in MYOB 
AccountEdge or choose AccountEdge Help from the Help menu. 
When MYOB Help is displayed, click the Site Help icon in the 
contents panel. A list of topics is displayed.

Click on a topic and read the information to become acquainted 
with MYOB Help and use it more effectively.

Other Learning Tools

In addition to the User Guide and MYOB Help, the following 
learning tools have also been provided. 

� The Getting Started guide (for new users only). The Getting 
Started guide details how to install and register your MYOB 
AccountEdge software. 

� Upgrade Instructions (for upgraders only). The Upgrade 
Instructions detail how to install MYOB AccountEdge Version 3 
and upgrade your company file.
User Guide
� A PDF version of the MYOB AccountEdge User Guide as well as PDF 
versions of other user documentation have been included in the 
Manuals folder on your MYOB AccountEdge CD-ROM. These files 
are also available in the Manuals folder in your MYOB 
AccountEdge application folder on your hard disk. You can read 
PDF files onscreen using Adobe Acrobat Reader or print them 
using your printer. You can install Adobe Acrobat Reader from the 
MYOB AccountEdge CD-ROM.
Learning Tools 11



Where to Start
If you haven’t installed MYOB AccountEdge yet, refer to your 
Getting Started guide or Upgrade Instructions for installation 
instructions before you read the rest of this chapter.

Start up MYOB AccountEdge. To do this, locate and double-click 
the MYOB AccountEdge icon in the folder that was created when 
you installed your software. If you used the defaults suggested 
during installation, this icon should be located in the MYOB 
AccountEdge folder. 

After a few moments, the Welcome to MYOB AccountEdge 
window (similar to the one shown below) is displayed.

This window is displayed every time you start MYOB AccountEdge. 

In this window, you are presented with five options:

� Open your company file—use this option to open your 
company file once it has been created. 

� Create new company file—create a company file for your 
business.

� Explore the sample company—experiment with a sample 
company’s data and learn how to use MYOB AccountEdge. 
See ‘Experiment With a Sample Company’s Data’ on page 12.
Chapter 1 Getting Started12
� What’s New in this version—learn about the exciting new 
features in this version of MYOB AccountEdge.

� Exit MYOB AccountEdge—close MYOB AccountEdge.

Experiment With a Sample Company’s Data

Before you create a new company file, we recommend that you 
experiment with the sample company’s data. We have provided a 
sample company file, called Widgets & Co., to allow you to 
experiment freely with MYOB AccountEdge’s features without 
damaging any of your own company’s fiscal information. This is an 
excellent way to learn how to use MYOB AccountEdge, to see actual 
accounting data that has already been entered into the MYOB 
AccountEdge system, and familiarize yourself with the way MYOB 
AccountEdge works.

To explore the Widgets company file

� Click Explore the sample company in the Welcome to MYOB 
AccountEdge window. The command center window of the 
sample company is displayed. 

NOTE : Manually locating the sample company file If the sample 
company file has been moved, a dialog box is displayed, requesting 
you to select the sample company file. Locate and open the file 
named Widgets & Co.

The command center window is always displayed on your 
computer screen when MYOB AccountEdge is running. Notice that 
the name of the sample company, Widgets & Co. is displayed in the 
top left corner of the window. 
MYOB AccountEdge, Version 3 us



Now that the Widgets & Co. company file is open, feel free to 
browse around the MYOB AccountEdge system and explore the 
accounting entries that have already been made for the sample 
company.

CAUTION : Do not enter your own financial data Do not enter 
your own company’s fiscal information into the Widgets & Co. 
company file. This company file is for learning purposes only. 
User Guide
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Creating a New Company File
When you make entries in MYOB AccountEdge, that information is 
stored within one file in your computer, called a company file. (A 
company file is a lot like a computerized filing cabinet, with all sorts 
of information about your business stored in it.) This single file 
allows you to work with your company’s financial information 
without spending a lot of time and effort on your computer’s file 
storage system. 

MYOB AccountEdge’s New Company File Assistant leads you 
through the process of creating a new company file, step-by-step. 

If you are setting up business for the first time, we strongly 
recommend that you consult your accountant or a Certified 
Consultant to help you set up MYOB AccountEdge correctly. 

Before you begin

Before you create your new company file using the New Company 
File Assistant, you will need to know the following information 
about your company.

What year is your current fiscal year?

The important thing to remember here is that the current fiscal year 
is not necessarily the current calendar year. 

In MYOB AccountEdge, and according to the standard used by 
most accountants, fiscal years take the name of the calendar year in 
which they end. For example, your fiscal year might run from 
October 2001 to the end of September 2002. Since the end of the 
fiscal year falls in 2002, the fiscal year is referred to as “fiscal year 
2002.”

Make sure you choose the correct fiscal year. If you are unsure, 
check with your accountant. 
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What is the last month of the fiscal year?

The fiscal year of many businesses ends in December, but if your 
company has a fiscal year structured like the example above, you’ll 
need to select another month, such as September.

What month will you be converting to using MYOB 
AccountEdge?

This is a very important selection. Your conversion month is the 
month in which you plan to start using MYOB AccountEdge. This 
month is particularly important in terms of your opening balances 
that will be entered later when you set up your company file.

Using the New Company File Assistant 

The New Company File Assistant leads you step-by-step through 
the process of creating a new company file. It consists of a series of 
interactive windows containing options that help you reach a 
particular goal. When you have finished making entries and 
selections, the New Company File Assistant will create a new 
company file for your company.

When using the New Company File Assistant, remember that in 
most instances, you can return to previous windows to review (and 
sometimes change) the entries you have made. You can also quit 
the Assistant while you are in any window that contains a Cancel 
button. If you quit the Assistant before the company file is created, 
you will need to start the Assistant from the beginning again. 

You can add or make changes to your initial selection later in the 
Company Information window (go to the Setup menu and 
choose Company Information). 
MYOB AccountEdge, Version 3 us



To create a new company file

1 Click Create new company file in the Welcome to MYOB 
AccountEdge window. The New Company File Assistant is 
displayed.

2 Click Next. The Company Information window is displayed. 

3 Enter your company’s name, address, phone number, fax number 
and e-mail address. Your company's name and address can be 
printed on invoices, bills and statements. 

4 Click Next. The Accounting Information window is displayed. 

5 Enter the following information in this window: 

� Enter your company’s current fiscal year. Remember, this is not 
necessarily the same as the calendar year.

� Enter the last month of the fiscal year.
� Choose the month in which you plan to start using MYOB 

AccountEdge from the Conversion Month pop-up menu.

CAUTION : Choose the conversion month carefully When this 
window is displayed, the conversion month defaults to the 
current month. If you accept this, you will not be able to enter 
transactions made before this month; you will need to enter them 
as historical information. 
User Guide
� Since it’s best to begin using a new accounting system at the 
start of a month, you might want to consider selecting the 
next month as your conversion month. Whatever your choice, 
note that you can only choose a month in the fiscal year you 
entered earlier. 

� Choose the preferred number of accounting periods. Most 
companies need only twelve accounting periods—one period 
for each month—to track their finances during the fiscal year. 
Some companies, however, make a significant number of year-
end adjustments and prefer to use thirteen accounting 
periods. The thirteenth period isn't an actual period of time; it's 
merely a “placeholder” period that contains year-end 
adjustments. If in doubt, choose thirteen periods. 

6 Click Next. Confirm the accounting information you entered. If you 
want to make any changes, click Back. Otherwise, click Next to 
continue. 

7 Specify how you would like to build your Accounts List and click 
Next. If you selected:

� I would like to start with one of the lists provided by MYOB 
AccountEdge, go to Step 8 to select your Accounts List.

� I would like to import a list of accounts provided by my 
accountant..., go to Step 9. After you have created the 
company file, see ‘Importing Accounting Data’ on page 197 
for more information about importing your Accounts List. 

� I would like to build my own Accounts List..., go to Step 9.

8 Select your Accounts List. To do this, choose the industry 
classification of your business. Then select the type of business that 
most closely matches your business. A suitable Accounts List is 
displayed. You'll be able to tailor this list to meet the exact needs of 
your business at a later time. Click Next.

9 In the Company File window, check the default name and location 
of your company file. If you want to make any changes to the 
Creating a New Company File 15



location or the file name, click Change. Enter a new location and file 
name in the dialog box that is displayed, and click OK.

10 Click Next. Your company file is created and the Conclusion 
window is displayed. Choose one of the following options. Click: 

� Setup Assistant, if you want to further customize your 
company file. This is the recommended option, especially if 
you need to build an Accounts List. At this point, the new 
company file doesn't contain much information about your 
company. Chapter 2 ‘Setting Up Your Company File’ on 
page 19 explains how to set up your company file so it 
contains all your company’s existing business information. 
MYOB AccountEdge’s Easy Setup Assistant makes this a simple 
process. 

� Command Center if you want to begin entering transactions 
right away. The command center window is displayed (see 
‘The command center’ on page 17 for more information 
about command centers). 
Chapter 1 Getting Started16
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Navigating in MYOB AccountEdge
The command center

There are eight command centers in MYOB AccountEdge. The 
following is an illustration of the Sales command center.

The command centers contain a row of icons in the top section of 
the window, which represent the eight divisions of MYOB 
AccountEdge. Each time you view the central location for all 
command centers, one of the icons is highlighted, and a flowchart 
of tasks is displayed below the row of icons. 

The highlighted icon is the current command center, and the 
flowchart displayed below the row of icons contains the major tasks 
associated with that command center. 

For example, when the Sales icon is highlighted, tasks such as Enter 
Sales and Print Invoices–typical tasks you’d complete in relation to 
Sales–are displayed in the flowchart.
User Guide
Each command also includes the following options:

� To Do List—You can use the To Do List to view the business tasks 
that affect your company on a regular basis. 

� Find Transactions—You can use Find Transactions to view 
summary information about each of your company's accounts, 
sales, purchases, cards, payroll and jobs. 

� Reports—You can use Reports to view a list of reports available 
in MYOB AccountEdge.

� Analysis—You can use Analysis to display windows that allow 
you to analyze a number of key aspects of your business.

There are two ways of selecting an option. You can either:

� click an option to display the window relevant to the command 
you are in 
or 

� click an option and hold down the mouse button. A menu 
appears, listing the available options for all command centers 
(not just the command center you are in). Make a selection from 
this list.

Tools in MYOB AccountEdge

Zoom arrows and search icons are used throughout MYOB 
AccountEdge to help speed data entry and simplify the ways you 
access windows in MYOB AccountEdge. They are described below.

Zoom arrows

Zoom arrows, displayed next to various fields throughout MYOB 
AccountEdge, allow you to review or “zoom” to more detailed 
information about a specific topic, such as a transaction or 
Navigating in MYOB AccountEdge 17



customer record. This detailed information is usually located in the 
window in which the topic was originally entered. 

A white zoom arrow indicates that you can zoom to more 
detailed information about a transaction and make changes to or 
delete the transaction, if you want.

A gray zoom arrow allows you to zoom to more detailed 
information about a transaction but the information is display only. 
If you want to change the information, you can reverse the 
transaction and re-enter it (see ‘Reversing a Transaction’ on 
page 115). Alternatively, you can change your security preference 
selection to make all transactions changeable (see ‘Setting up 
Preferences’ on page 21).

Search icons 

Search icons, displayed next to various fields throughout MYOB 
AccountEdge, allow you to open selection lists containing records 
you’ve previously entered into the MYOB AccountEdge system, 
such as customers and shipping methods. From the selection list, 
you can then select a record to appear in the field. 
Chapter 1 Getting Started18
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 Chapter 2
Setting Up

Your
Company

File
The more accounting information you have when you set up MYOB AccountEdge, the 
easier your transition will be. Although we would all like to have a complete set of 
balances on hand when setting up MYOB AccountEdge, the fact is that only a few 
businesses have all the information at their disposal. Ideally you should have the 
following information:

- a list of your accounts with their balances,

- a detailed list of your receivables,

- a detailed list of your payables,

- a bank reconciliation, showing your bank balance, your bank statement balance, 
uncleared checks and deposits not yet credited as of your MYOB AccountEdge 
conversion date, and

- a list of the items you sell and their selling price.

The absolute minimum information you need to set up your file is a bank reconciliation as 
described above.

Many businesses setting up MYOB AccountEdge for the first time find they fall somewhere 
in between the two extremes. They can provide a bank reconciliation, a list of receivables 
and payables and an inventory valuation. This is usually enough information to get 
started, as the remaining balances can be entered later.

This chapter is about setting up your business in MYOB AccountEdge. It shows you how to 
set up your preferences, accounts, sales, purchases, items, payroll, tax codes and jobs. You 
don’t need to set up all the features MYOB AccountEdge offers at once; if you prefer, you 
can just set up the minimum for your business and set up the other areas later.

Think carefully about what accounting transactions you want MYOB AccountEdge to 
track. For example, if you sell books, you may want separate income and cost of sales 
accounts for your fiction and non-fiction book sales. If you run a gas station you may want 
to track gas sales separately from oil and consumables. Keep it simple, as you can always 
add accounts to MYOB AccountEdge to track additional items and transactions.
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Overview
Before you start entering transactions in MYOB AccountEdge, you 
need to set up your company file. Setting up involves tasks such as 
customizing the way MYOB AccountEdge operates, setting default 
sales and purchase details, recording details of your customers and 
vendors, and so on.

To help you to quickly and efficiently set up your company file, 
MYOB AccountEdge includes the Easy Setup Assistant, which guides 
you through the necessary steps. 

The following checklist outlines what you should set up before 
entering transactions in MYOB AccountEdge. You can complete 
most of these tasks using the Easy Setup Assistant.

Once you complete the initial setup using the Easy Setup Assistant, 
you will be ready to start using your company file for your business. 
If you need to make changes to your setup or add to your records, 
you can do so directly from the command centers.

If you are in the final step of the New Company File Assistant, click 
Setup Assistant to start the Easy Setup Assistant.

Step Set up Refer to... 

1 Set up preferences page 21

2 Set up accounts page 22

3 Set up sales details page 25

4 Set up purchase details page 28

5 Set up payroll details page 31

6 Set up tax codes page 35

7 Set up items page 37

8 Set up bank accounts page 41

9 Set up jobs and categories (optional) page 42
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Or start the Easy Setup Assistant by choosing Easy Setup Assistant 
from the Setup menu. The following window is displayed.
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Setting up Preferences
MYOB AccountEdge has numerous preferences that you can set to 
customize the way the application operates. The Easy Setup 
Assistant will guide you through setting up some of them.

You can set the rest of the preferences or make changes to your 
initial selection later in the Preferences window (go to the Setup 
menu and choose Preferences). For more information about 
preferences, in MYOB Help, choose Setup> Personalizing your 
Company, click the topic Customizing your MYOB AccountEdge 
system and then click Customizing work preferences.

Click Customize in the Easy Setup Assistant window. 
The Customize Easy Setup Assistant is displayed. Each 
window contains a list of preferences that you can set by 
marking the checkbox next to the preference. Click 
Next to move through the windows; click Close when 

you have finished. 

Preferences in MYOB AccountEdge

The following is a list of a few preferences available in MYOB 
AccountEdge.

� Use Easy-Fill When Selecting From a List. You can use the Easy-Fill 
feature to quickly enter account names, item names or numbers 
and card names that you enter frequently. Easy-Fill will 
“recognize” the entry you're making and automatically fill in the 
rest of the entry for you. 

� Use Expandable Data Entry Fields in Windows. If you enter long 
descriptions on invoices and bills, you can view those 
descriptions in their entirety whenever the Description field is 
active.

� Warn Before Recording Post-Dated Transactions. Set this 
preference if you want to be notified whenever you enter a future 
User Guide
date as a transaction date—for example, if you mistakenly enter a 
date two months from now.

� Prompt for Backup when closing. Set this preference if you want 
to be reminded to back up your company file when you close it.

� Select and Display Account Name, Not Account Number. If you 
find it easier to find your accounts by their names rather than by 
their numbers, you can set up MYOB AccountEdge so that you 
can enter accounts and sort your account search lists 
alphabetically by using the name of the accounts rather than the 
numbers. 

� I Prefer to Use Help From the Internet, Rather Than My Computer. 
If you have access to the Internet, you can view the latest online 
help for MYOB AccountEdge on the World Wide Web, instead of 
using help files on your computer.

� Warn if Customer has an Outstanding Credit Before Applying a 
Payment. You can set this preference if you'd like to be notified 
that a customer has an existing customer credit whenever you 
apply one of the customer's payments to a sale.

� Transactions CAN’T be Changed; They Must be Reversed. Set this 
preference if you want to keep a strict audit trail. Your 
transactions will be considered unchangeable, and you won’t be 
able to make changes to or remove transactions you’ve recorded. 
Instead, you’ll need to reverse a transaction to completely remove 
the effects of that transaction on your records. 
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Setting up Accounts
The second step to setting up your company file is to set up your 
accounts. This includes:

� Reviewing your Accounts List

� Entering your account opening balances

The Easy Setup Assistant will help you complete these 
tasks quickly. Click Accounts in the Easy Setup Assistant 
window. The Accounts Easy Setup Assistant is displayed. 

Review your Accounts List

In the Accounts Easy Setup Assistant, click Next to go to the 
Accounts List window. This window displays the list of accounts 
you selected when you created your company file using the New 
Company File Assistant.

There are eight types of accounts in the Accounts List—Assets, 
Liabilities, Equity, Income, Expenses, Cost of Sales, Other Income 
and Other Expenses.

All accounts are assigned a level, which indicates their location in 
your Accounts List hierarchy. The eight account types are the only 
accounts that can be Level 1. Other accounts can be assigned Levels 
2, 3 or 4.

If you haven't already reviewed your existing accounts, do so now. 
(You can review an account’s details by clicking the zoom arrow 
next to the account.) You may want to enlist the help of your 
accountant or a MYOB Certified Consultant. Since your accounts 
are the foundation for the rest of your accounting records, it's 
important that they are complete and are capable of meeting your 
individual company's needs. 
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To create a new account

1 Click New. The Account Information window is displayed.

2 Specify whether the account is a Header account, Detail account or 
Detail Checking or Credit Card account.

If you are creating your Accounts List from scratch, it may be easier 
to enter all your Header accounts before entering your Detail 
accounts.

� Header accounts are non-postable accounts that contain Detail 
accounts. They serve no accounting purpose except to group 
and total Detail accounts for reporting clarity. Header accounts 
are displayed in bold type in your Accounts List. You are not 
required to use Header accounts.

� Detail accounts are postable accounts that add up to a 
particular Header account. You can create Detail accounts at 
levels 2, 3 or 4.

� Detail Checking account. This option is available if you are 
creating a Detail Asset account. Select this option if you intend 
to assign transactions to the account you are creating and you 
want to write checks using the funds in this account—for 
MYOB AccountEdge, Version 3 us



example, your bank checking account, Petty Cash account 
and Cash Drawer account. These accounts will be displayed in 
the accounts selection list in transaction windows.

� Detail Credit Card account. This option is available if you are 
creating a Detail Liability account. Select this option if you 
intend to assign credit card transactions to the account. 
Accounts with credit card privileges will be displayed in 
selection lists in transaction windows.

3 Enter information about the account, such as an account number 
and account name. Enter a currency if you are using the 
multicurrency feature.

NOTE : Account opening balances When creating or editing an 
account, note that you are not required to enter account opening 
balances. This is done later in the setup.

4 Click OK when you have finished. The account you created will now 
appear in your Accounts List. 

In this step of the Accounts Easy Setup Assistant, you can also edit 
existing accounts' names and numbers and delete accounts that 
you don't plan to use. You can also import accounts if you've been 
using another computerized accounting system. For detailed 
instructions on how to edit, delete and import accounts, click Help 
in this window. Also see “Changing a Record” on page 105, “To 
delete an account” on page 106, and “Importing Accounting Data” 
on page 197.

To change the level of an account If you want to change the level 
of an account in your Accounts List in order to change its hierarchy, 
you can do so later from the Accounts List window (go to the 
Accounts command center and click Accounts List). For 
instructions on changing account levels, in MYOB Help, choose 
Accounts> Maintaining Accounts > Changing, Removing or 
Inactivating Accounts and click the topic To change an account’s level.

When you have finished reviewing your Accounts List, click Next to 
enter your opening balances. See the following section for 
instructions. 
User Guide
Enter your account opening balances

Unless you're just starting a new business, most of your accounts 
probably already have balances—for example, you've made sales, 
paid bills, deposited money in your business' checking account and 
conducted a variety of other business activities that affect your 
accounts' balances. In this step, you'll enter those balances.

NOTE : Don’t enter inventory opening balances now If you are 
using MYOB AccountEdge to track your item quantities and values, 
don’t enter the opening balance of your inventory accounts at this 
point. This is done later when you set up your inventory (see 
page 37).

To properly assign opening balances to accounts, you need to enter 
the balance of each of your accounts as of the first day of your 
conversion month—the month you began using MYOB 
AccountEdge to track your business.

� If your conversion month is the first month of your fiscal year (for 
example, if your fiscal year runs from January to December, and 
your conversion month is January), enter the opening balances of 
your asset, liability and equity accounts only. (The opening 
balances of all your income, cost of sales and expense accounts 
should remain zero.)

� If your conversion month is not the first month of your fiscal year 
(for example, if your fiscal year runs from January to December, 
and your conversion month is August), enter the opening 
balances of all your accounts.
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To enter opening balances
1 Enter the opening balance for each account in the Opening 
Balance column.

NOTE : You should enter opening balances as positive numbers.

Don’t, for example, enter your liability accounts’ balances as 
negative numbers. MYOB AccountEdge knows whether your 
accounts usually have positive or negative balances. Enter negative 
amounts only if accounts truly have negative balances; as a rule 
these will be accounts used to record accumulated depreciation.

2 Check the Amount left to be allocated field at the bottom of the 
window. 

� If this field displays $0.00, the total of the opening balances 
you assigned to your asset accounts equals the total opening 
balances of your liability and equity accounts. 

� If this field displays an amount other than $0.00, check your 
opening balances again. This value indicates that either your 
opening balances are incomplete or incorrect. The amount 
that appeared in the Amount left to be allocated field will be 
assigned to a special equity account called Historical 
Balancing. If you cannot find the reason why the accounts 
don’t balance, click Help for more information. 

3 Once you have entered your account opening balances, click Next 
and then close the Accounts Easy Setup Assistant.
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You have completed setting up your accounts. If you want to make 
changes to or delete any accounts later, you can do so from the 
Accounts command center. See the Working with Lists chapter on 
page 101.

To continue with setting up your company file, see “Setting up Sales 
details” on page 25.
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Setting up Sales details
Most businesses rely upon sales of goods or services to generate 
revenue for them. In the Sales Easy Setup Assistant, you can set up 
information about your customers and other information related to 
sales.

Before you begin using the Sales Easy Setup Assistant, you may find 
it helpful to gather together a list of your customers, along with 
their addresses, phone numbers and so on. We also recommend 
that you gather a list of all the sales you've made to customers that 
haven't yet been fully paid off.

Click Sales in the Easy Setup Assistant window. Work 
your way through the Sales Easy Setup Assistant, 
entering the required information in the appropriate 
windows. Click Help in any window for detailed 
information about that window. 

Set up a default layout

In the Layout window, choose the sale layout that you expect to use 
most often. This layout will be assigned to all new customer cards 
but you can change the sale layout for your customers at any time. 
Click Next. 

Set up selling details

Use this window to set default entries that will speed up the task of 
creating new customer records. Remember that you can change 
these selections for any of your customers at any time. For more 
information on using this window, click Help. 

When you have finished, click Next.
User Guide
Select default tax codes

If you collect tax on sales, select the tax code that you use most 
often. Select whether freight charges are taxable for most of your 
customers. Your selections here will appear as the default in the 
Selling Details view of the new customer cards you create.

When you have finished, click Next.

Select a default payment method and credit 
terms 

Indicate the credit terms you generally extend to your customers 
and the default payment method. MYOB AccountEdge will use 
these credit terms as the default when you create new customer 
cards, but you can change these terms any time. Click Help for 
more information. 

When you have finished, click Next.
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Set up linked accounts for sales

Specify the default accounts that will be used to track your 
customer receipts and undeposited funds. The accounts you select 
must have checking privileges.

If you want to change an account that MYOB AccountEdge has 
selected for you, click the search icon next to that account and 
select an alternate account from the list that is displayed.

You can change your linked accounts later in the Sales Linked 
Accounts window (go to the Setup menu, choose Linked 
Accounts and then Sales Accounts). 

When you have finished, click Next.

Create customer cards

In this step, you'll enter information about each of your customers. 
MYOB AccountEdge requires that you create a record for each 
customer, but you can choose to enter as little or as much 
information as you like in these records.

1 Click New. The Card Information window is displayed.

2 Enter details about your customer. You don’t have to complete all 
the tabs in this window at this time. You can fill in the Profile and 
Selling Details (see graphic below) now and complete the others 
later through the Card File command center (see ‘To make changes 
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to a record’ on page 105). Click Help for detailed help on creating 
a card.

A Selling information The selections you make here will be used by 
default on quotes, orders and invoices that you 
create for this customer. You can override these 
selections when recording the sale. 

B Tax information The customer’s credit limit and tax information are 
entered here. 

C Credit terms The credit terms you entered earlier appear here 
by default. You can override them here for this 
customer.

A

C

B
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3 Click OK when you have finished, to return to the Sales Easy Setup 
Assistant. The card you created will now appear in the Customer 
List.

4 Repeat Step 1 - Step 3 for each customer card you want to create.

In this window of the Sales Easy Setup Assistant, you can also make 
changes to or delete existing cards. If you've kept customer 
information in another software application, you can import that 
information into MYOB AccountEdge. For detailed instructions on 
how to edit, delete and import customer cards, click Help in this 
window. See also “Importing Accounting Data” on page 197 for 
information about importing cards.

If you want to add customer cards, make changes to or delete 
existing cards later, you can do so from the Card File command 
center (see the Working with Lists chapter on page 101).

When you have finished, click Next.

Enter your historical sales

In MYOB AccountEdge, historical sales are those sales you've made 
that haven't been paid in full, as of the first day of your conversion 
month.

Click Add Sale to enter these historical transactions and the 
outstanding amounts. For instructions on entering historical sales 
for your customers, click Help in the Historical Sale window. 

When you have finished, click Next.

Click Close to close the Sales Easy Setup Assistant. See the following 
section to set up your purchase details. 
User Guide
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Setting up Purchase details
In the Purchases Easy Setup Assistant, you can set up your vendor 
information and other information related to purchases. You'll find 
these steps very similar to those you completed for your customers 
and sales.

Click Purchases in the Easy Setup Assistant window. 
Work your way through the Purchases Easy Setup 
Assistant, entering the required information in the 
appropriate windows. Click Help in any window for 
detailed information about that window. 

Set up a default layout

In the Layout window, choose the purchase layout that you expect 
to use most often. This layout will be assigned to all new vendor 
cards but you can change the purchase layout for your vendor at 
any time. Click Next.

Set up default buying details

Use this window to set default entries that will speed up the task of 
creating new vendor records. Remember that you can change these 
selections for any of your vendors at any time. For more information 
on using this window, click Help. 

When you have finished, click Next.

Select default tax codes

If you are charged tax on purchases, select the tax code that is used 
most often by your vendors in this window. Specify whether freight 
charges from most of your vendors are taxable. Your selections here 
will appear as the defaults in the Buying Details view of new vendor 
cards you create.
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When you have finished, click Next.

Set up default credit terms

Enter the credit terms that your vendors generally extend to you. 
MYOB AccountEdge will use these credit terms as the default when 
you create new vendor cards, but you can change these terms any 
time. Click Help for more information. 

When you have finished, click Next.

Set up the linked account for purchases

Specify the default account that will be used to pay bills from your 
vendors. If you want to change the account that MYOB 
AccountEdge has selected for you, click the search icon next to the 
account and select an alternate account from the list. 

You can change your linked accounts later in the Accounts Payable 
Linked Accounts window (go to the Setup menu, choose Linked 
Accounts and then Purchases Accounts).

When you have finished, click Next.
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Create vendor cards

In this step, you'll enter information about each of your vendors. 
MYOB AccountEdge requires that you create a record for each 
vendor, but you can choose to enter as little or as much information 
as you like in these records.

1 Click New. The Card Information window is displayed. 

2 Enter details about your vendor. You don’t have to complete all the 
tabs in this window at this time. You can fill in the Profile and 
Buying Details (see graphic below) now and complete the others 
later through the Card File command center (see ‘To make changes 
to a record’ on page 105). Click Help for detailed help on creating 
a card.

A Buying information The selections you make here will be used by 
default on quotes, orders and bills that you create 
for this vendor. You can override these selections 
when recording the purchase. 

A

C

B
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3 Click OK when you have finished, to return to the Purchases Easy 
Setup Assistant. The card you created will now appear in the vendor 
List.

4 Repeat Step 1 - Step 3 for each vendor card you want to create.

In this window of the Purchases Easy Setup Assistant, you can also 
edit or delete existing cards. If you've kept vendor information in a 
spreadsheet or another software application, you can import that 
information into MYOB AccountEdge. For detailed instructions on 
how to import, edit, and delete vendor cards, click Help in this 
window. See also “Importing Accounting Data” on page 197 for 
more information on importing cards.

If you want to add vendor cards, make changes to or delete existing 
cards later, you can do so from the Card File command center (see 
the Working with Lists chapter on page 101).

When you have finished creating your vendor list, click Next. 

B Tax information Your credit limit with this vendor and the vendor’s 
tax information are entered here. 

If you wish to report payments to vendors for 
inclusion on a 1099 statement, select how you 
wish to report the payments by entering a 
category in the Report Payments on 1099 as 
field. For more information about tracking vendor 
payments on a 1099 statement, in MYOB Help, 
choose Card File, click the topic Cards Overview 
and then Buying Details view (vendor cards).

If the Report Payments on 1099 as field is not 
available, this means that you have not set up 
payroll yet (see ‘Setting up Payroll details’ on 
page 31). After you have set up payroll, you can 
return to this window to set up the vendor card to 
track payments on 1099 statements.

C Credit terms The credit terms you entered earlier appear here 
by default. You can override them here for this 
vendor. 
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Enter your historical purchases

In MYOB AccountEdge, historical purchases are those purchases 
you've made that haven’t been paid in full, as of the first day of your 
conversion month. 

Click Add Purchase to enter these historical transactions and the 
amount you owe your vendors. For detailed instructions on how to 
enter historical purchases for your vendors, click Help in the 
Historical Purchase window.

When you have finished, click Next.

Click Close to close the Purchases Easy Setup Assistant.

If you use the Payroll feature in MYOB AccountEdge, see the 
following section to set up your payroll details.
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Setting up Payroll details
This section applies to you only if you will be using the Payroll 
feature in MYOB AccountEdge.

You'll probably find that it takes you longer to set up your payroll 
information than it did to set up your information in other areas of 
MYOB AccountEdge, particularly if you employ several people. Your 
effort here will be rewarded on payday, though; if you've been 
calculating paychecks manually, you'll find that these checks are 
much quicker and easier to calculate in MYOB AccountEdge.

In the Payroll Easy Setup Assistant, you'll load your tax tables, review 
your payroll categories and linked accounts, and enter details about 
your employees, their tax status and pay history.

Click Payroll in the Easy Setup Assistant window. Work 
your way through the Payroll Easy Setup Assistant, 
entering the required information in the appropriate 
windows. Click Help in any window for detailed 
information about that step. 

You can make changes to your initial selection later in the General 
Payroll Information window (go to the Setup menu and choose 
General Payroll Information).

Load tax tables

You must load the payroll tax tables into the application when you 
first set up Payroll. The tax tables contain the most recent payroll tax 
information and are provided with your software. 

Click Load Tax Tables. Once the tax tables are loaded, click Next. 
User Guide
Enter and confirm the payroll year 

Enter and confirm the current payroll year and click Next. 

Set up general payroll information

Specify the number of hours in your company’s typical work week 
(not the hours in a pay period). The number you enter here will be 
used as the default to calculate wages and payroll payable amounts 
(such as tax) on paychecks. You can override this on the paycheck 
as necessary.

Enter your Federal Tax ID number.

Enter your Federal Unemployment Tax Rate as a percentage. 

Select the ZIP code of the state to which you pay State 
Unemployment Tax. Then enter your State Tax ID number and your 
SUI Rate as a percentage.

Click Next when you have finished.

Set up your default linked accounts

In the Linked Accounts window, review the linked account 
selections MYOB AccountEdge has made for you. 

� Account for Writing Paychecks is the checking account you 
would usually use to write your paychecks.

� Account for Employer Expenses is the default account that is 
charged for your employer expenses.

� Account for Wages Paid is the default account that is charged 
for the gross wages and salaries paid to employees. You can 
change this account for each employee in the Employee Payroll 
Information window. 
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� Account for Deductions and Expenses is the default account to 
which the amounts withheld from the employee’s paycheck are 
allocated. 

To change a linked account, click the search icon next to it and 
select another account from the Accounts List. You can change the 
linked accounts for individual payroll categories through a payroll 
category’s Information window.

When you have finished, click Next to continue. 

Review your payroll categories 

A paycheck normally consists of five elements: wages, deductions, 
accruals, taxes and employer expenses. Collectively, these elements 
are referred to as payroll categories. Before you begin writing 
paychecks to employees, you'll create the payroll categories that are 
used by your business and are required by law, and then you'll 
assign each employee the payroll categories that apply to him or 
her. Then, when you use the Pay Employees window to pay an 
employee, the payroll categories you've assigned to the employee 
will automatically determine the various amounts that are 
associated with the paycheck.

MYOB AccountEdge provides you with a list of payroll categories 
that you can assign to your employees later in the setup process. 
Select the category type, and then review the list to see whether all 
the wages, deductions, accruals and expenses your company uses 
are included. You can delete a payroll category you don’t need by 
highlighting it and clicking the Delete <Payroll Category> button.

NOTE : You cannot delete or create a tax type If you select Taxes, 
you cannot delete an existing tax type or create a new tax; you can, 
however, view the tax tables and change the linked payables 
account. 

Review the payroll category details It’s a good idea to also review 
the details for each wage, deduction, accrual and expense to make 
sure it matches the way you do business. To do this, click the zoom 
arrow next to each category. The Information window for that 
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category is displayed. You can make changes to the information as 
required. For a detailed description of each field in this window, 
click Help. 

Creating a new payroll category You can create a new payroll 
category by selecting the category type in the Payroll Category 
List window and clicking New. The Information window for the 
selected category is displayed. For information on creating this 
payroll category, click Help. Also see ‘Creating Payroll Categories’ 
on page 120.

When you have finished, click Next.

Editing a payroll category To edit a payroll category, highlight the 
category you wish to change and click the edit button for that 
category. For example, to edit a wage category, click Edit Wage.

Deleting a payroll category To delete a payroll category, highlight 
the category you wish to remove and click the delete button for that 
category. For example, to delete a wage category, click Delete 
Wage.

Create employee cards 

In the Employee Cards window, click New. The Card Information 
window is displayed. Enter your employee details in the relevant 
tabs just as you did with customer and vendor cards. You can click 
Help in each tab for help on creating an employee card.

When completing the Payroll Details tab of the Card Information 
window, see ‘Entering payroll information’ below for instructions.

Entering payroll information

It is very important that you set up an employee's payroll 
information completely before you begin writing paychecks for that 
employee.

An employee’s payroll information is set up in the Payroll Details 
tab of the Card Information window and in the Employee Payroll 
MYOB AccountEdge, Version 3 us



Information window. In the Payroll Details tab, you are required 
to choose the Residence Code and Work Code that apply to the 
employee. In the Employee Payroll Information window 
(accessed by clicking Info in the Payroll Details tab), you are 
required to enter the employee’s pay details such as the pay basis, 
salary and pay frequency, and to assign payroll categories to the 
employee.

NOTE : It is very important that you enter payroll information 
correctly. If you don’t, your employees’ pay and tax amounts will 
not be calculated correctly.

To enter payroll information

1 Click the Payroll Details tab in the Card Information window. The 
Payroll Details view is displayed.

2 Enter the Residence Code and Work Code that applies to the 
employee.

3 Click Info. The Employee Payroll Information window is 
displayed. The information you enter in this window is used to 
determine wages, deductions, accruals, employer expenses and tax 
amounts for each employee, and helps calculate each pay period's 
paycheck amounts.
User Guide
A Wages Expense 
Account

Enter the Wages Expense account. The linked 
account you selected earlier in the setup appears 
here by default.

B Pay Basis Enter the Pay Basis for the employee. Pay Basis 
(Salary or Hourly) determines whether an 
employee is paid on the basis of number of hours 
worked or a fixed salary, although a salaried 
employee may be given “overtime” or their wages 
on an hourly basis. In this case, MYOB 
AccountEdge will calculate the equivalent hourly 
rate by the following formula:
Base Salary ÷ (Hours in working week x 52).

C Hourly/Annual Base 
Pay

Enter the employee’s Base Pay—annual or hourly, 
depending on their pay basis.

D Pay Frequency Enter the employee’s pay frequency.

E Social Security 
Number

Enter the employee’s Social Security Number. 

F Birth Date Enter the employee’s date of birth. MYOB 
AccountEdge calculates the employee’s age and 
displays it below this field. 

A
B
C
D

G

H

E
F
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4 After you have entered the employee’s pay details and assigned 
payroll categories, click History in the Employee Payroll 
Information window. 

The Pay History window is displayed. The Pay History window 
allows you to view individual employees' wage, deduction, accrual 
and tax amounts, as well as the employer expenses you've incurred 
for individual employees for the current and previous month(s) of 
the current payroll year.

5 If you're starting to use Payroll after the first pay period of the 
payroll year, enter the employee's pay history for the current payroll 
year up to the current date. You can enter pay history for specific 
months or quarters.

CAUTION : Avoid editing pay history figures MYOB AccountEdge 
uses the figures displayed in the Pay History window on some 
reports. If you change a card's pay history later in this window, keep 
in mind that the change you make will be displayed on the reports 
but may not accurately reflect your actual totals.

6 Click OK when you have finished entering the employee’s pay 
history. The Employee Payroll Information window is displayed. 

7 Close the Employee Payroll Information window. 

G Tax information Enter the appropriate tax information for this 
employee in these fields. If the employee is subject 
to state tax, be sure to enter both state and federal 
tax information.

H Payroll Categories Select all the payroll categories that apply to this 
employee by clicking in the Select column. Your 
selections in this step are very important, because 
they are the key components in determining the 
employee’s net pay amount. Be sure you carefully 
select all the payroll categories that apply to this 
employee. 

CAUTION: If you make changes to a payroll 
category’s details from this window (by clicking 
the zoom arrow next to a payroll category), these 
changes will affect ALL employees this category 
has been assigned to. 
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8 After you have finished creating the employee card, close the Card 
Information window and return to the Payroll Easy Setup Assistant. 
The card you created will now appear in the Employee List. 

Continue creating your employee cards. As with customer and 
vendor cards, you can also edit and delete existing employee cards; 
if you've kept employee information in a spreadsheet or another 
software application, you can import that information into MYOB 
AccountEdge.

For detailed instructions on how to import, edit and delete 
employee cards, click Help. See also “Importing Accounting Data” 
on page 197 for more information on importing cards.

If you want to add employee cards or make changes to or delete 
existing cards later, you can do so from the Card File command 
center (see the Working with Lists chapter on page 101).

Click Close to close the Payroll Easy Setup Assistant. Then close the 
Easy Setup Assistant.

See the following section to set up your tax codes.
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Setting up Tax Codes

If your business makes sales and purchases, you’re probably very 
familiar with the concept of including tax on the transactions you 
conduct with your customers and vendors, and you know how 
important it is to track these amounts carefully.

To help you keep on top of taxes, MYOB AccountEdge uses tax 
codes. Each tax code represents a particular tax rate, which is used 
to calculate tax on your transactions. You’ll set up taxes using the 
Tax Information window. Whenever you enter a sale or purchase 
that should be taxed, you’ll mark the Tx column and choose a tax 
code from the Tax selection list; the amount of the line item will be 
multiplied by the tax code’s tax rate.

You can assign tax codes to customers and vendors in their cards. 
These tax codes will appear by default in invoices and purchase 
orders that you create for these customers or vendors, saving you 
the trouble of selecting a tax code each time. 

MYOB AccountEdge provides you with an extensive list of tax codes 
that can be used in a variety of situations. In addition to this, you 
can also create all the tax codes your business needs. 

To create a tax code

1 Go to the Lists menu and choose Tax Codes. A list of all the tax 
codes that MYOB AccountEdge has already set up for you is 
displayed. 

2 Click New. The Tax Code Information window is displayed. 
User Guide
3 Complete the fields in this window. Click Help if you require 
detailed field help.

A Enter a three-digit code, description, type and rate. If you selected 
Consolidated as the Tax Type, see page 36. 

B If the Tax Type is Sales Tax, specify the linked account for tax 
collected. If the Tax Type is Import Duty, specify the linked account 
for accrued duty. 

Specify a linked card if applicable. 

A

B
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Consolidated tax codes

MYOB AccountEdge gives you the flexibility of creating 
consolidated tax codes by combining two or more tax codes. For 
example, the CST tax code (with a 8.25% tax rate) is composed of 
CTY (City Sales Tax) at 4%, STE (State Sales Tax) at 4% and MET 
(Metropolitan Tax) at 0.25%.

NOTE : You can only consolidate tax codes that are in your Tax 
Code List Therefore, make sure you first create the tax codes you 
want to consolidate. 
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Setting up Items
In MYOB AccountEdge terms, the word item is used to describe:

� A physical unit that your company may buy, sell and/or store.

� A service that your company wants to include on item invoices. 
For example, you could create items such as ‘Shipping’, 
‘Handling’, and so on.

In accounting terms, your company’s items should usually be 
considered current assets.

There are three steps to setting up items:

� Creating the items

� Entering open stock on hand quantities 

� Entering the opening value of your stock items 

To create an item

1 Go to the Inventory command center and click Items List. The 
Items List window is displayed.

2 Click New. The Item Information window is displayed.

3 Enter a unique number in the Item Number field. You can use up to 
thirty numbers, letters and symbols.

The backslash character (\) serves a special purpose in MYOB 
AccountEdge—any item number that begins with a backslash can 
be included on sales and purchase forms, but it won’t appear on 
printed forms.

4 Enter the name of the new item in the Name field using up to thirty 
characters.

HINT : Copy From button Click Copy From to copy another item’s 
information to this item record. From the displayed list, choose the 
item whose information you want to copy. All information for that 
item will be copied to the current item record except the item 
User Guide
number, item name, vendor item number, auto-build information 
and history information.

5 Specify whether you buy, sell and/or inventory this item by 
marking the relevant checkbox(es). The following table should give 
you an idea of which checkboxes to mark.

CAUTION : Make your selections carefully If you mark the I 
Inventory This Item checkbox for an item, use the item in a 
transaction, and then try to clear this checkbox, you will not be 
allowed to do so.

Mark For these items

I Buy this Item Non-inventory items that you want to order in the 
Purchases window.

I Buy this Item

I Sell this Item

You’re a broker or middle man moving goods or services.

If you allocate a purchase of this item to a job, you can then 
create a reimbursement invoice using the selling 
information you enter here. 

I Buy this Item 

I Sell this Item

I Inventory this 
Item

This is a normal inventoried item.

I Sell this Item This is a normal service item, useful for salespeople who bill 
their commissions, or those who provide a service and bill 
for their time. 

I Sell this Item

I Inventory this 
Item

Finished goods, if you manufacture something using other 
items that you inventory.

I Buy this Item 

I Inventory this 
Item

Raw material that you inventory and use to build other 
items. 

I Inventory this 
Item

Intermediate goods in the process. Parts used to 
manufacture finished goods. 
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6 When you marked the checkboxes in the previous step, you may 
have noticed the fields that appeared next to these checkboxes. 
Enter the appropriate account numbers (or names) in these fields. 
These will change according to the individual checkbox and 
combination of checkboxes you mark.

� In the Cost of Sales Account field, enter the account you want 
to use to track the costs associated with selling this item. 

� In the Income Account for Tracking Sales field, enter the 
account you want to use to track the income you receive from 
the sale of this item. 

� In the Asset Account for Item Inventory field, enter the 
account you want to use to track the total value of this item.

� In the Expense Account for Tracking Costs field, enter the 
account you want to use to track costs associated with 
purchasing this non-inventoried item. 
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7 Click the Buying Details tab. The Buying Details view of the Item 
Information window is displayed.

A Last Purchase Price The last purchase price you paid for the item 
(excluding tax) is displayed in this field.

B Buying Unit of 
Measure 

Enter the unit of measure (such as ‘gross,’ or ‘case’) 
by which you purchase the item. The buying unit is 
printed on the item purchase order. If, for 
example, you buy eggs by the carton (a dozen), 
when you order five units in a purchase, you’re 
ordering five cartons. It is very important that you 
set up your buying units correctly. 

C Number of Items 
per Buying Unit 

Enter the number of items that comprise a single 
buying unit. This is the number MYOB 
AccountEdge adds to your on-hand inventory for 
every buying unit. For example, if you buy eggs by 
the carton (a dozen) and want to track their 
purchase individually, enter twelve as the number 
of items per buying unit. When you order one 
carton, MYOB AccountEdge updates your item 
inventory by twelve items. 

If you leave this field blank, MYOB AccountEdge 
defaults to one. 

D I Pay Sales Tax Mark this checkbox if you pay sales tax when you 
purchase this item.

A
B
C

E
F
G
H

D
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8 Click the Selling Details tab. The Selling Details view of the Item 
Information window is displayed.

E Minimum Level for 
Restocking Alert 

Enter the minimum level of this item you want to 
keep in stock. When you reach this level, a reorder 
reminder appears in the To Do List.

F Primary Vendor for 
Reorders 

Enter the vendor from whom you usually purchase 
this item. 

G Vendor Item 
Number 

Enter the vendor’s number for the item.

H Default Reorder 
Quantity 

Enter a re-order level quantity for the item here. If 
you have set a minimum level for restocking alert, 
you can create an order for the items easily, using 
the Stock Alert tab in the To Do List. The default 
quantity showing on the order will be taken from 
this field.

A Base Selling Price Enter the retail price of one selling unit in this field.

B Selling Unit of 
Measure 

Enter the selling unit of the item in this field, such 
as ‘each’, ‘gross’, or ‘case’.You can enter up to five 
characters. The selling unit is printed on the item 
invoice. If, for example, you sell by the six-pack, 
when you sell five units, you will be selling five six-
packs. It is very important that you set up your 
selling units correctly. 

E

A
B
C

D
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9 Click the Items Details tab.

You can enter additional information about the item in this window. 
For information about adding a picture, see ‘Linking a picture to a 
record’ on page 202. For information about creating custom lists 
and fields, see ‘Creating custom fields’ on page 98 and ‘Creating 
custom lists’ on page 99.

C Number of Items 
per Selling Unit 

Enter the number of items that comprise a single 
unit in this field. This is the number MYOB 
AccountEdge subtracts from your on-hand 
inventory for every selling unit. For example, if you 
sell by the six-pack, enter six as the number of 
items per selling unit. When you sell one six-pack, 
MYOB AccountEdge reduces your item inventory 
by six items.

If you leave this field blank, MYOB AccountEdge 
defaults to one.

D Pricing Levels You can set pricing levels for different kinds of 
customers. See “Creating custom price levels” on 
page 97.

E I Collect Sales Tax Mark this checkbox if you collect sales tax when 
you sell this item.
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Enter opening stock on hand quantities and 
values

Once you have created your inventory items, you need to enter 
quantities on hand as at your conversion date and their values. This 
is done in the Count Inventory window. 

The Count Inventory window is also used to routinely adjust the 
quantities of your inventoried items (due to theft, spoilage, etc.) 
recorded in MYOB AccountEdge so they match the actual quantities 
you have in stock.

1 Go to the Inventory command center and click Count Inventory. 
The Count Inventory window is displayed.

This window lists all the items and their on-hand quantities 
currently on record in MYOB AccountEdge. This quantity is in 
inventory units, not buying units or selling units. For example, say 
you buy soft drink by the six-pack and inventory it by the can; a 
quantity of 24 in the On Hand column means you have twenty four 
cans in inventory, rather than twenty four six-packs.

NOTE : Print the Inventory Count Sheet You can print out the 
Inventory Count Sheet (which is a list of all your items) by clicking 
Print in the Count Inventory window. Enter your quantities on 
these stock sheets; then you can enter them easily in the Count 
Inventory window.

2 Enter the quantity counted in the Counted column for each item. 
Zeros appear in the On Hand column because MYOB AccountEdge 
has no record of any of your items yet. The Difference column will 
change to reflect the difference between the On Hand column and 
the Counted column. 

3 Click Adjust Inventory when you have entered all your item 
quantities. The Default Expense Account window is displayed. 

4 Click Continue to indicate to MYOB AccountEdge that you are 
making an opening adjustment to your inventory asset account. 
The Opening Balance Check window is displayed, informing you 
that MYOB AccountEdge has noticed that some of your on-hand 
inventory quantities are zero. 
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5 Click Opening Balances.

6 Click Adjust Balances to adjust the balances of your inventory asset 
account to match the inventory values. (If you have already entered 
opening balances for your inventory asset account, click Continue 
instead.) The Adjust Inventory window is displayed.

The Adjust Inventory window shows an adjusting entry in the 
scrolling list for each item you entered a quantity in the Counted 
column of the Count Inventory window.

7 Make any changes to the default entries in the Inventory Journal 
Number, Date and Memo fields. 

8 Enter the unit cost of each item (enter how much a single unit of 
each item cost you, not how much you’re selling it for).

Do not change the account number in the Account column. 

9 Click Record. MYOB AccountEdge will update the value of each 
item in the scrolling list.

You can print the Items List (Summary) report to check your 
inventory status. For more information on printing reports, see 
‘Using Reports’ on page 161. 
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Setting up your Bank Accounts

To ensure the accuracy of your business records, you should keep 
the record of your bank account balances in MYOB AccountEdge 
matched up with your bank’s records. This task is called reconciling 
accounts.

Reconciling your accounts for the first time

When you prepare to reconcile an account for the first time in 
MYOB AccountEdge, you may notice some of the checks you wrote 
and some of the deposits you made before you began using MYOB 
AccountEdge appearing on your bank statement. In order to 
reconcile the account, these transactions must also appear in the 
Reconcile Accounts window in MYOB AccountEdge. However, as 
you conducted the transactions before you began using MYOB 
AccountEdge, there will be no record of these transactions in MYOB 
AccountEdge. This situation must be resolved before you can 
reconcile the checking account.

To resolve the situation, you'll create a General Journal entry. Each 
uncleared check and uncleared deposit you conducted before using 
MYOB AccountEdge should be entered as line items on a General 
Journal entry. When you're ready to reconcile the checking account, 
each line of the General Journal entry will appear in the Reconcile 
Accounts window.

To reconcile your account for the first time

1 Go to the Accounts command center and click Record Journal 
Entry. The Record Journal Entry window is displayed. 

2 Enter your checking account in the Account column and create a 
General Journal entry for the checking account, with a separate 
debit for each deposit that hasn't cleared yet and a separate credit 
for each check that hasn't cleared yet. 
User Guide
It's unlikely that the debits will equal the credits in the Record 
Journal Entry window. If the Out of Balance field underneath the 
scrolling list shows an amount, you'll need to enter another line 
item with an amount that balances the debits and credits. 

3 Record the General Journal entry.

4 Go to the Banking command center and click Reconcile Accounts. 
The Reconcile Accounts window is displayed. 

5 Enter the account you want to reconcile in the Account field. The 
individual line items in the General Journal entry you just created 
(and any checks and deposits that you may have entered) appear in 
the scrolling list in the middle of the window. 

6 Enter the ending balance on the statement that your bank sent you 
in the New Statement Balance field. 

7 Enter the closing date that appears on your bank statement in the 
Bank Statement Date field. Only transactions dated on or before 
that date will appear in the scrolling list. 

8 Mark all the checks and deposits that are on your bank statement by 
clicking in the column on the left; also mark the balancing amount 
entry you created in Step 2. 

9 Click Reconcile. Your account should now reconcile. Click 
Reconcile again to complete the reconciliation process.
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Setting up Categories and Jobs 
MYOB Accounting can track financial information at three levels:

� Accounts level—view the profitability and financial information of 
your business as a whole.

� Categories level—view the profitability and financial information 
of your individual business divisions, departments, properties, 
offices or locations.

� Jobs level—view the profitability and financial information of the 
individual jobs or tasks carried out for customers and clients. 

The following example illustrates how accounts, categories and jobs 
are interrelated:

A car dealer has two lines of business–car sales and a service 
department. The car sales department sells both new and pre-
owned vehicles. The service department reqularly takes on multiple 
jobs for particular customers that last several days. The business 
owner could set up MYOB AccountEdge in the following way, 
although there are many ways in which the system could be set up:

Accounts level

The Accounts List could be set up to provide a basic overview of the 
business’ overall performance. For example, the following income 
accounts could be used:

4-0000 Income [Header]

4-1000 Car Sales [Header]

4-1010 New Car Sales [Detail]

4-1020 Pre-owned Car Sales [Detail]

4-2000 Service and Parts income [Header]

4-2010 Service Income [Detail]
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4-2020 Parts Income [Detail]

4-2030 Accessories Income [Detail]

When entering a transaction, the appropriate account is allocated 
to each individual amount (or line). A standard Profit & Loss 
statement can then be printed for the business showing a complete 
breakdown of the income and expenses generated by the business. 
At this level, though, it is difficult to see how well the two lines of 
business are performing; categories can provide this facility.

Categories level

Five categories could be set up: New Car Sales, Pre-owned Car 
Sales, Service, Parts and Accessories. When entering a transaction, 
the appropriate category is assigned to it. A profit and loss 
statement can then be prepared for each of these categories; this is 
an easy way to compare the division’s profitability and 
performance. At this level, though, it is difficult to see how 
profitable particular jobs or tasks have been; jobs can provide this 
facility.

Jobs level

Jobs could be set up to track income and expenses related to service 
jobs — this is particularly useful when multiple jobs are performed 
for a single customer. When you enter a transaction, the 
appropriate job number can be assigned to each individual amount 
(or line). This enables you to allocate several jobs to the various 
amounts in a transaction. For example, in the situation where a bill 
includes the purchase of parts for three customers you could specify 
the three jobs that the purchase relates to. A profit and loss 
statement can then be prepared for each job, and actual results can 
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be compared with budgeted values to produce a Jobs [Budget 
Analysis] report.

Setting up Accounts

You can set up your accounts using the Easy Setup Assistant (see 
‘Setting up Accounts’ on page 22) or in the Accounts command 
center (see ‘To add new accounts to your Accounts List’ on 
page 103).

Setting up Categories

If you have more than one division, department or company for 
which you want to track financial information, categories may be 
the solution for you. When entering sales, bills, receipts or 
payments, you can assign the transactions to a category, and then 
produce financial reports for each category.

Categories can be assigned to the following transaction types:

� Spend Money transactions

� Receive Money transactions

� General Journal Entries

� Sales

� Purchases 

� Inventory Transfers 

� Inventory Adjustments

� Paychecks 

� Historical Sales and Purchases

NOTE : You cannot allocate categories to certain transactions

There are certain transactions for which you cannot allocate a 
category. These are: Pay Bills, Receive Payments, Prepare Bank 
Deposit, Settle Returns and Credits/Debits and Pay/Receive 
Refunds. When entering these transactions, the categories assigned 
to the original transactions will be used when the new transaction is 
recorded. For example, the categories assigned to purchases 
User Guide
showing in the Pay Bills window will also be assigned to the bill 
payment. 

To set up your category preferences

1 Go to the Setup menu and choose Preferences.

2 Click the System tab.

3 Mark the Turn on Categories tracking checkbox. If you want to 
make the selection of a category mandatory for all transactions, 
choose Required from the drop-down list. 

To create a category

1 Go to the Lists menu and choose Categories. The Categories List 
window is displayed.

2 Click New. The Edit Category window is displayed.

3 Enter a category ID that will be used to identify the category, for 
example, Sales.

4 Enter the category’s complete name, for example New Car Sales

5 Enter a description of the category, or notes related to the category, 
for example, 100 High Street, New Car Sales Department.

6 Click OK.
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Setting up Jobs

You can use MYOB AccountEdge to keep an account and detail 
record of your jobs. Specific job-tracking tasks you can accomplish 
include:

� Organize jobs in a hierarchy 

� Set account-by-account budgets for each job 

� Link jobs to specific customers 

� Assign individual line items on transactions to jobs 

� Track reimbursable expenses for your jobs 

� Prepare reimbursement sales with markup 

� Extensively analyze profit and loss for a job

To create a job

1 Go to the Lists menu and choose Jobs. The Jobs List window is 
displayed. 

2 Click New. The Job Information window is displayed. 

3 Specify whether this is a Detail or Header job. Choose:

� Detail Job (Postable) if you want to assign transactions to this 
job throughout MYOB AccountEdge.

� Header Job (Non-Postable) if you don’t want to assign 
transactions to this job, but want to use it as a header for a 
group of Detail jobs. The Header job will display the totals of 
the Detail jobs in the Jobs List window.
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4 Enter information about the job, such as a job number, name, 
description and start date. For detailed field help, click Help.

5 Link a customer card to the job if you wish.

You can view details of all jobs linked to a customer in the Jobs tab 
of the customer’s card.

6 Click OK.

To change the level of a job

If you want to change the level of a job in your Jobs List in order to 
change its hierarchy, you can do so later from the Jobs List window 
(go to the Lists menu and click Jobs). For instructions on changing 
job levels, in MYOB Help choose Jobs > Finding and changing job 
information.

To enter job opening balances

If you started using MYOB AccountEdge while a particular job was 
in progress, you can create the job in MYOB AccountEdge, and then 
enter any account activity generated by the job so far in the Job 
Opening Balances window. 

You can only enter opening balances for Detail jobs. Header jobs 
take their balances from the Details jobs below them.

1 Go to the Setup menu, choose Balances and then Job Opening 
Balances. The Job Opening Balances window is displayed. 
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2 Enter the job number of the job for which you want to enter an 
opening balance, or click the search icon to select a job from the 
list.

3 Enter any opening balances for the job in the Opening Balances 
column. 

4 Repeat Steps 2 and 3 for each job for which you want to enter 
opening balances.

5 Click OK when you have finished.

To enter budget amounts for jobs

You can enter budget amounts for every Detail job in the MYOB 
AccountEdge system. The budget information you enter for each 
job is used to help you assess your progress on a particular job and 
to determine the job's effect on the state of your business. The 
amounts you enter will be assigned to accounts in your Accounts 
List for comparison purposes; once you begin recording 
transactions for the job, you'll be able to print the Jobs (Budget 
Analysis) report to see a comparison of the actual amounts and the 
amounts you've budgeted for the job.

1 Go to the Lists menu and choose Jobs. The Jobs List window is 
displayed.

2 Highlight the Detail job for which you want to enter budgets. 

3 Click Budgets. The Job Budgets by Account window is displayed, 
with the number of the job you selected in the Job Number field. 

All of your company's income, cost of sales, expense, other income 
and other expense accounts appear in the scrolling list.

4 Enter the amounts you've budgeted for specific accounts for this job 
in the Budgets column and click OK.
User Guide
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 Chapter 3
Receiving

and
Spending

Money
We all receive and spend money. Now, instead of just receiving and spending by check and 
cash, many of the transactions we make are by electronic transfer. These transfers can be 
made via the Internet, through ATMs and over the phone.

MYOB AccountEdge is packed with features to help you track all these transactions. It 
doesn’t matter if you are transferring money from one account to another, or spending or 
receiving money—it’s easy in MYOB AccountEdge.

This chapter shows you how to record the checks you have written, the checks you have 
received, your credit card purchases, your credit card payments, and your ATM and 
Internet withdrawals and transfers.

This chapter also shows you how to use the versatile Bank Register to enter transactions 
on-the-fly for your checking and credit card accounts. The Bank Register lets you record 
checks and deposits, pay bills, receive payments and enter sales and purchases all from 
one location. If you have online banking, you can import your downloaded bank and 
credit card statements into MYOB AccountEdge via the Bank Register and speed up 
transaction entry and account reconciliation. 

MYOB AccountEdge can handle as many check and credit card accounts as you like and 
allocate them to as many accounts as you like. If you are used to a manual multi-column 
cashbook system, you can think of MYOB AccountEdge as having the capacity to run 
multiple cashbooks with an infinite number of columns.

As you read on, you’ll see that you need to be aware of which check or credit card you are 
tracking, and which account is being affected by the transaction. For example, if you wrote 
a check to the phone company, you would use your checking account and allocate the 
transaction to the phone account. If you paid the phone company by credit card, you 
would use your credit card account and still allocate the transaction to the phone account. 
Simply record where the money is coming from and where it is going; MYOB AccountEdge 
will do the rest.
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Receiving Money
In MYOB AccountEdge, the term receiving money refers specifically 
to recording receipts other than payments relating to invoices. 
These include capital injections, interest, adjustments and so on. 
These types of receipts can be entered using the Receive Money 
window in the Banking command center, or by selecting the 
Receive Money transaction type in the Bank Register window.

Remember that MYOB AccountEdge tracks invoicing separately 
through the Sales command center, so any customer payments 
need to be entered using the Receive Payments window, or by 
selecting the Receive Payment transaction type in the Bank 
Register window. See ‘Receiving Payments’ on page 67 for more 
information.

NOTE : Recording receipts in the Bank Register You can use the 
Bank Register if you want to quickly record a batch of receipts and 
don’t need to record details of each receipt, or allocate them to 
multiple accounts. See ‘Entering Transactions in the Bank Register’ 
on page 53.

To receive money

1 Go to the Banking command center and click Receive Money. The 
Receive Money window is displayed. 

2 Choose one of the following:

� Deposit to account. Choose this option if you want the deposit 
recorded directly in an account. Specify the account by clicking 
the search icon and making a selection from the checking 
accounts that you’ve set up.

� Group with undeposited funds. Choose this option if you want 
the deposit to be recorded in the undeposited funds account 
(and not in a checking account). After you’ve grouped all the 
deposit transactions you want, you can then make a bank 
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deposit. For more information, see ‘Preparing a Bank Deposit’ on 
page 50.

3 Enter the payor. Click the search icon to select a card from the 
Cards List. 

4 Enter the amount received.

5 Enter the payment method. Click Details if you want to enter 
details about the payment. For example, if you are being paid by 
credit card, you can record the credit card number and expiration 
date. 

6 Enter the date of the deposit and a detailed comment to help you 
identify the deposit later.

7 Allocate the amount to the proper account(s).

A Enter the account(s) to which you want to assign the deposit in this 
column. Click the search icon to view the Accounts List.

B Enter the amount you want to assign to each account here. The total 
amount in this column must equal the amount in the Amount 
Received field before you can record the transaction.

C Assign the amount to a job by entering the job code here (optional).

D Enter a memo for each line item you enter in the transaction 
(optional).

BA C D
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8 If you want to assign the transaction to a particular category, click 
the search icon to select a category from the Category List.

For more information about categories, see ‘Setting up Categories 
and Jobs’ on page 42.

9 Decide what you want to do with the deposit. 

� To record the deposit, click Record.

� To store the deposit as a recurring deposit so that you can use it 
many times in the future, click Save Recurring. In the Save 
Recurring Template window, enter the necessary information 
and click Save Template. (See ‘Working with Recurring 
Transactions’ on page 116 for more information about creating 
and using recurring deposits.)

If you want to record the deposit as an actual transaction now, 
click Record in the Receive Money window. If you don’t want to 
record the deposit at this time, click Cancel.
User Guide
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Preparing a Bank Deposit
If you use the Undeposited Funds account to group payments from 
customers and other funds you receive, you can use the Prepare 
Bank Deposit window to create a batch bank deposit that will 
transfer funds from the undeposited funds account to the account 
of your choice as a single transaction. Undeposited funds dated up 
to and including the date you specify in the Prepare Bank Deposit 
window will be displayed. You have the option of grouping the 
receipts by payment method. 

To prepare a bank deposit

1 Go to the Banking command center and click Prepare Bank 
Deposit. The Prepare Bank Deposit window is displayed. 

2 In the Deposit to Account field, enter the account into which the 
funds selected in the Prepare Bank Deposit window will be 
deposited. 

3 If you want to group payments by payment method, click the 
Select Receipts by down arrow and choose Payment Method. 
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Specify the payment method in the adjacent field (for example, 
Visa). Only payments made using that method are listed.

4 Enter a date to display undeposited funds up to and including that 
date.

5 Use the Memo field to record the purpose of the transaction. We 
recommend that you make a detailed comment so you’ll be able to 
identify the transaction when you review your records later on. 

6 Select the receipts you want to include on the bank deposit by 
marking the Deposit column. 

7 Click Record.
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Spending Money
In MYOB AccountEdge, spending money refers to transactions that 
affect your company’s checking accounts, credit card accounts, 
petty cash accounts and other cash accounts. Checks are usually 
recorded in the Spend Money window or by selecting the Spend 
Money transaction type in the Bank Register window. 

If you want to make payments for bills entered using the Purchases 
command center, you will need to enter the payment using the Pay 
Bills window or by selecting the Pay Bill transaction type in the 
Bank Register window.

NOTE : Recording checks in the Bank Register You can use the 
Bank Register if you need to quickly record several checks and don’t 
need to record details of each check or allocate them to multiple 
accounts. See ‘Entering Transactions in the Bank Register’ on 
page 53.

To record a check

1 Go to the Banking command center and click Spend Money. The 
Spend Money window is displayed.

2 Click the search icon next to the Account field and select the 
checking or other bank account that will be used for this check.

3 Fill in the information in the check area of the window, just as you 
would if you were writing a paper check. Enter the Payee card, 
User Guide
check number, amount, memo, etc. Click Help for detailed field 
help.

If you want to change the default address displayed in the Payee 
field, click the down arrow and make a selection.

4 Allocate the check to the correct account(s).

5 If you want to assign the transaction to a particular category, click 
the search icon to select a category from the Category List.

A Enter the account(s) to which you want to assign the check amount 
in this column. Click the search icon to display the Accounts List. 

B Enter the allocation amount here. 

C Assign the check amount to a job by entering the job code 
here (optional). 

D Enter a memo for each line item you enter in the transaction 
(optional).

BA C D
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For more information about categories, see ‘Setting up Categories 
and Jobs’ on page 42.

6 Decide what you want to do with the check.

� To print and record the check, click Print. 

� To record the check, click Record. If you want to print this check 
later, you can do so from the Print Checks window. This window 
allows you to customize your checks and print them as a batch. 
For more information, see Chapter 12, ‘Printing Forms,’ on 
page 151.

� To store the check as a recurring check so that you can use it many 
times in the future, click Save Recurring. In the Save Recurring 
Template window, enter the necessary information and click 
Save Template. (For more information about saving and using 
recurring check, see ‘Working with Recurring Transactions’ on 
page 116.)

If you want to record the check as an actual transaction now, click 
Record in the Spend Money window. If you don’t want to 
record the check at this time, click Cancel.
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Entering Transactions in the Bank Register
The Bank Register allows you to quickly and efficiently enter all 
your transactions for both asset accounts with checking privileges 
and liability accounts with credit card privileges from one window. 
For example, you can enter the following transactions in the Bank 
Register: checks, deposits, payments to vendors, payments from 
customers, sales and purchases.

The main advantages of using the Bank Register to enter 
transactions (in preference to using transaction windows such as 
Spend Money and Pay Bills) are speed and convenience. You can 
record a customer payment, pay a bill and then write a check 
without having to open multiple windows and switch between 
them. Given that transactions can be recorded with minimum 
detail, you save valuable time when entering a batch of 
transactions. 

If you need to enter additional information about a transaction such 
as finance charges and discounts or change details such as the tax 
amount and payment method, you can use Split in the Bank 
Register to display the corresponding transaction window and 
continue with the rest of the transaction entry in that window. You 
can also use Split to allocate an amount to multiple accounts or 
apply payments to a particular invoice or bill.

NOTE : Importing your online bank and credit card statements 
using the Bank Register You can also use the Bank Register to 
import your bank and credit card statements into MYOB 
AccountEdge. If a statement contains any transactions that you have 
not entered into MYOB AccountEdge, you can add them quickly 
using the Bank Register. For more information, see ‘Importing 
Statements into MYOB AccountEdge’ on page 55.
User Guide
To enter a transaction in the Bank Register

1 Go to the Banking command center and choose Bank Register. 
The Bank Register window is displayed.

2 In the Account field, specify the checking or credit card account 
that will be used for this transaction. 

3 Choose the type of transaction from the Type drop-down list

4 Enter the ID or check number and the date of the transaction.

5 Enter the name of the card for whom this transaction is intended or 
click the search icon and select a card from the Cards List.

6 Enter the total amount of the transaction, including tax. 

NOTE : Overpayments to vendor If this is a vendor payment and 
you are overpaying them, an Out of Balance message will be 
displayed when you record the transaction. Click Split to open the 
source window and apply the overpayment.

NOTE : Payment Method If you selected the Receive Money, 
Enter Sale, Receive Payment or Enter Payment transaction type, 
note that the payment method and details used are the ones you 
assigned to the customer in the Payment Details view of the Card 
Information window. If no default payment method was assigned 
to the selected customer, no payment method is assigned to this 
transaction. If you want to change or specify a payment method, 
click Split, enter the payment details in the source window and then 
record the transaction. If the transaction type is Enter Sale, the Split 
button is not available; you will need to record the transaction, then 
click the zoom arrow next to the transaction in the Bank Register’s 
transaction history list to open the source window.
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7 For all transactions (except customer and vendor payments) enter 
the allocation account.

Note that the Split button is not available for Sales and 
Purchases. 

NOTE : If the transaction requires more than one allocation 
account If you need to allocate the amount to more than one 
account or the payment to more than one invoice or bill, click Split. 
The source window for this type of transaction is displayed. 
Continue entering the rest of the transaction from this window. 
Click Record when you have finished. Notice that the transaction 
you just recorded appears in the scrolling list of the Bank Register. 
You can now begin entering another transaction in the Bank 
Register. 

8 If you want to assign the transaction to a particular category, click 
the search icon to select a category from the Category List.

For more information about categories, see ‘Setting up Categories’ 
on page 43.
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9 Choose what you want to do with the transaction. 

� To record the transaction, click Record. 

� To store the transaction as a recurring transaction so that you can 
use it many times in the future, click Save Recurring. In the Save 
Recurring Template window, enter the necessary information 
and click Save Template. (Note that this option is available only 
for some transaction types.) For more information about saving 
and using recurring transactions, see ‘Working with Recurring 
Transactions’ on page 116.
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Importing Statements into MYOB AccountEdge
While some businesses record their transactions in MYOB 
AccountEdge as they are made, others prefer to leave them until the 
end of the month and enter them all at once.

Regardless of how you choose to do it, MYOB AccountEdge makes 
transaction entry and account reconciliation really simple.

If you have online banking, you can simply use the Get Statement 
feature in MYOB AccountEdge. Bank or credit card statement files 
that you have downloaded to your computer can be imported into 
MYOB AccountEdge simply by clicking Get Statement in the Bank 
Register or the Reconcile Accounts window. MYOB AccountEdge 
will then automatically match transactions on your statement with 
the transactions you entered in your company file. Matched 
transactions will be marked as cleared for reconciliation, making it 
easy to reconcile your account at month-end. 

If MYOB AccountEdge cannot find a match, you have the option of 
matching the transactions manually with uncleared transactions in 
MYOB AccountEdge, adding them to MYOB AccountEdge or 
skipping them altogether. Unmatched transactions are usually 
account fees, government taxes, and penalty charges applied by 
the bank.

NOTE : Download your statement Before you import your bank or 
credit card statement into MYOB AccountEdge, you will need to 
download the statement file from your bank. Your bank’s website 
should provide instructions on downloading this file. The following 
file formats are supported by MYOB AccountEdge: OFX, QFX, QIF 
and OFC. Make sure you save the bank file in one of these formats. 
User Guide
To import your statement

You can also import your statement by clicking Get Statement in 
the Reconcile Accounts window. 

1 Go to the Banking command center and click Bank Register. The 
Bank Register window is displayed. 

2 Enter the account in the Account field. 

3 Click Get Statement. The Open dialog box is displayed. 

4 Locate and select the statement file that you downloaded.

5 Click Open. The transactions in your statement will be 
automatically matched with the transaction in your file by using the 
the check number and amount as the criteria for matching checks 
and the amount as the criterion for matching deposits. If:

� there are any unmatched transactions, the Unmatched 
Statement Transactions window is displayed. Go to Step 6.

� all your transactions match, that’s it! These transactions will be 
marked as cleared in the Reconcile Accounts window. 

6 Choose what you want to do with the unmatched transactions. 

� If you want to match a transaction, highlight that transaction 
and click Match Transaction. The Match Transaction window is 
displayed, listing the uncleared transactions in your company file 
for the specified account. Select the transaction that you want to 
match with the statement transaction and click Match. The 
transaction will be marked as cleared. Repeat this step for each 
transaction that you want to match. 

� If you want to add a transaction to your company file, highlight 
the transaction and click Add Transaction. The Spend Money 
window or the Receive Money window (depending upon the 
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type of transaction you are adding) will be displayed. Enter the 
details of the transaction and record it. The transaction is shown 
as cleared. Repeat this step for each transaction you want to add 
to MYOB AccountEdge.

CAUTION : Match or add all transactions We recommend you 
finish adding or matching every transaction in the unmatched 
transaction list before you click Done. If you open the statement file 
again, the original unmatched statement list reappears.

7 When you have finished matching and adding transactions, click 
Done. Any transactions that were not matched are skipped. A list of 
all the transactions that were cleared are displayed. 
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Tracking Credit Card Purchases
The following procedures show you how to track purchases you 
make with your company’s credit cards, using the Spend Money 
window. You can also use the Bank Register for this purpose (for 
more information, see ‘Entering Transactions in the Bank Register’ 
on page 53).

To record purchases made with a company credit 
card

Before you begin recording credit card purchases, make sure you 
create a liability account such as Visa or American Express to track 
the amount owed to each credit card provider. For information on 
creating an account, see ‘To add new accounts to your Accounts 
List’ on page 103. 

1 Go to the Banking command center and click Spend Money. The 
Spend Money window is displayed.

2 Click the search icon next to the Pay from Account field and select 
the credit card account you want to use.

3 Enter the date, amount of the credit card purchase, payee and 
memo. 

4 In the scrolling list area of the Spend Money window, enter the 
allocation account you want to use. This is usually an expense 
account.

5 Click Record to record the credit card purchase.
User Guide
To record credit card payments

1 Go to the Banking command center and click Spend Money. The 
Spend Money window is displayed. 

2 Enter the checking account that you are using to make this 
payment in the Account field. 

3 Enter the credit card company’s name in the Payee field.

4 Enter the amount you paid.

5 In the scrolling list area of the Spend Money window, enter the 
liability account you’ve created to track purchases made with this 
credit card.

6 Record the transaction. 
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Recording Miscellaneous Transactions
To void a check number

You may want to void a check for any number of reasons. You may, 
for example, find that one of your check forms is damaged and not 
usable for printing or that you have made a mistake when writing 
the check manually.

Follow the steps below to void a check that you have not recorded 
in MYOB AccountEdge. If you want to make changes to a check you 
have already recorded in MYOB AccountEdge, see ‘Changing a 
transaction’ on page 114.

1 Display the Spend Money window and choose the check account 
from which you want to void the check number. 

2 Enter the check number you want to void in the Check No. field. 
However, do not enter an amount in the Amount field. There is also 
no need to assign allocation accounts.

3 Click Record and then confirm that you want to void the check.

To record ATM Withdrawals and Transfers

1 Display the Spend Money window and choose the account from 
which you want to withdraw the amount. 

2 In the Check # field, enter a non-numeric word or phrase to 
describe the withdrawal. That way, you’ll know the transaction isn’t an 
actual check when you view it in a list or on a report. This will also allow 
you to skip the transaction when you print a range of numbered 
checks.

3 Complete the other fields in the window as normal.

4 Click Record to record the transaction.
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To record Internet or phone banking withdrawals 
and transfers

1 Display the Spend Money window and choose the account from 
which you will withdraw the amount. 

NOTE : Vendor payments If you are entering a payment to a 
vendor for a recorded purchase, you should enter it in the Pay Bills 
window. See ‘Paying Bills’ on page 82.

NOTE : Vendor card for Internet or phone banking You can set 
up a supplier card for Internet and phone booking and record your 
customer reference number in the Custom field vendor card for 
Internet or phone banking

2 In the Check # field, enter a non-numeric word or phrase to 
describe the withdrawal. That way, you’ll know the transaction isn’t an 
actual check when you view it in a list or on a report. This will also allow 
you to skip the transaction when you print a range of numbered 
checks.

3 Link the transaction to a card if you want. 

4 Complete the other fields in the window as normal.

5 Enter the receipt number in the Memo field and record the 
transaction.
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 Chapter 4
Entering

Sales and
Payments
Where would your business be without sales? All businesses need sales to make a profit, 
but to survive in a competitive environment you need to be informed as to what’s selling, 
how long your customers are taking to pay you, and how successful your marketing has 
been at generating sales.

MYOB AccountEdge will help you take control of your sales and customers. As well as 
handling all your accounting requirements, MYOB AccountEdge’s ability to handle 
quotes, orders and invoices, and its reporting features are designed to help you and your 
salespeople make sales.

For example, you can use MYOB AccountEdge to help you prepare quotes for your 
customers, then a week later, contact your customers, bring up a list of the quotes you have 
given, and turn the quotes into orders. When the goods are shipped, you can turn the 
orders into invoices, print your customized packing slips, and e-mail or print your fully 
customized invoices. If the need arises, you can follow up the invoices with fully 
customized statements.

You can use MYOB AccountEdge’s powerful sales tracking features to find out who is 
buying what, when and from which salesperson. You can use MYOB AccountEdge to find 
out who owes you money, how much and what for. If your customized statement fails to 
get a response, you can use the powerful mail merge facilities to send a personalized 
reminder letter.

Handling customer payments couldn’t be easier. Payments—including under and 
overpayments—can be deposited to any of your checking or credit card accounts. Customer 
returns can be easily applied to open invoices or, if the need arises, payments can be 
returned to your customers.
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Entering Sales
You can enter a sales transaction as a Quote, Order or Invoice. 

� You can enter a quote in MYOB AccountEdge to provide an 
estimate or sales quote to a customer without creating a 
transaction. A quote has no impact on your inventory levels and 
can be changed to an order or an invoice when your customer is 
ready to buy. 

� An order is a sale where no service or goods have been delivered. 
While orders don’t affect your financial numbers, they do affect 
your committed inventory numbers in the Analyze Inventory 
window and reports. Orders don’t create a transaction in MYOB 
AccountEdge unless the customer has paid you a deposit.

� An invoice is usually created when you have delivered the items 
or services the customer ordered and can expect payment from 
the customer. It will update the appropriate accounts, including 
the account for tracking receivables. Invoices can be open, closed 
or credits. An invoice can’t be changed to a quote or an order. 

Entering sales in the Bank Register

While sales are usually recorded in the Sales window, miscellaneous 
one-time sales that have been paid for can be recorded in the Bank 
Register. The advantage of using the Bank Register for this type of 
sale is that you can quickly record the transaction with minimum 
detail. The Miscellaneous sale layout is used by default for sales 
entered in the Bank Register. The payment method entered in the 
customer’s card is used as the default. For more information, see 
‘Entering Transactions in the Bank Register’ on page 53.
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To enter a sales transaction, you’ll complete the following:

� Choose the type of sale you want 
� Enter information about the customer
� Enter the line items—the items or services you are selling
� Enter additional information about the sale
� Complete the sale

Step 1: Choose the type of sale you want 

Choose the status and layout for the transaction you are creating. 
The layout displayed in the Sales window is determined by the 
default you selected when setting up sales details (using the Sales 
Easy Setup Assistant) or in the customer’s card. 

1 Go to the Sales command center and choose Enter Sales. The 
Sales window is displayed.

2 Choose the status from the pop-up menu in the upper left corner of 
the window. 

3 If you want to change the layout, click Layout. The Select Layout 
window is displayed. 

4 Choose the layout (Service, Item, Professional, Time Billing or 
Miscellaneous) you want to use and click OK. 

Note that the Miscellaneous layout is used only for adjustments 
and other sales that will not be printed. 
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Step 2: Enter information about the customer

The information you enter in the top section of the Sales window 
will determine a number of things about the sale, including the 
customer’s terms for the sale and the identification numbers 
assigned to the transaction.

To change the customer’s credit terms for this 
transaction

When you enter a customer’s name in the Customer field, the 
terms you’ve assigned to the customer appear next to the 
customer’s name automatically. If you want to change these terms 
for this particular transaction, follow the steps below. 

NOTE : Changes only affect the current transaction. If you want 
to change the credit terms that will be used for all future sales to this 
customer, you should make that change in the Selling Details tab of 
the customer’s card.

1 Click the zoom arrow next to the Terms field. The Credit Terms 
window is displayed. Information about the terms for the 
transaction is displayed in the window.

A Enter the customer’s name. Click the search icon to display your 
customer list.

B Click the zoom arrow to alter the credit terms for this sale only. See 
the following section.

C Enter the invoice number here.

D If the customer gave you a purchase order for this transaction, enter 
that purchase order number here.

B CA D
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2 Make the necessary changes in the Credit Terms window and then 
click OK to close the window. The Sales window is displayed again, 
with the new credit terms appearing next to the Terms field. 

Step 3: Enter the items or services you’re 
selling

The scrolling list in the middle of the Sales window is where you 
enter details of what you are selling. In this area, you’ll enter item 
numbers, activity ID numbers, descriptions, account numbers (or 
names depending upon your selection in the Preferences window) 
and various other information that will serve as the detail for your 
transaction.

When you enter information in one row in the scrolling list, you 
enter one line item of the transaction. You can enter as many line 
items on a sale as you want.

The actual fields that appear in the scrolling list differ, depending 
upon the type of sale you’re creating. The following illustrations 
briefly describe the line item entries you can make for item and 
service sales in the Sales window; click Help for a detailed 
description of the line items’ columns.

NOTE : Add lines, subtotals and headers to invoices You can add 
lines, headers and subtotals to invoices to make it easy to separate 
and subtotal different categories of sales in one invoice. For more 
information, see ‘Adding lines, subtotals and headers to invoices’ on 
page 63.
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A Ship Enter the quantity to be delivered.

B Backorder Enter the quantity of the item to be placed on 
backorder. An order for this amount will be created 
automatically when you click Record. 

C Item Number Press TAB and choose an item from your item list.

D Description A description of the item is displayed automatically. 
You can change this if you want.

E Price The price of the item is displayed automatically. You 
can change this if you want.

F Discount Enter a volume discount as a percentage.

G Total The total price of the items is calculated automatically.

H Job Enter a job number here to assign a line item to a 
specific job (optional). For more information about 
jobs, see ‘Setting up Categories and Jobs’ on page 42.

I Tax  Mark the Tx column if the line item is taxable.

J Description On a service, professional or miscellaneous invoice, 
enter a description of the goods or services sold.

K Acct # or Name On a service, professional or miscellaneous invoice, 
choose the account to which to allocate the sale. Press 
TAB and choose an account from your Accounts List. 
This is usually an Income account. You should not 
select your account for ordinary sales. 

A DC E F HB IG
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Service sale

Item sale
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Step 4: Enter additional information about 
the sale

The actual fields that appear at the bottom of the Sales window 
differ, depending upon the type of sale you’re creating. Click Help 
for a detailed description of each field in the window.

A Optional fields Enter optional information, such as the name of 
the salesperson, a comment, method, promised 
date of goods or services, and the referral source 
(how the customer found you). Enter text or click 
the search icon to choose from the Select From 
List window.

B Already Printed or 
Sent

Mark this checkbox if you do not want to print the 
sale.

C Journal Memo The Journal Memo is generated automatically. You 
can change this if you want.

D Tax Click the zoom arrow if you want to view or 
change the tax amounts assigned to the sale.

E Freight Enter any charges for freight. Mark the field to the 
right if freight is taxable. 

F Paid Today Enter an amount here to indicate how much 
money the customer paid you at the time of the 
sale or, if you’re creating an order, how much 
money the customer gave you as a deposit. 

G Payment Method Enter the payment method that the customer used 
to pay you. Click Details to enter details of the 
payment method.

H Tax Code If you want to change the tax code used for this 
sale, enter a different tax code here. 

A B DC FE HG
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Step 5: Complete the sale

Now that you’ve finished making entries in the Sales window, there 
are a number of tasks you can perform with the transaction. Be sure 
to review all the following options before you choose what you 
want to do.

� Record the sale. To record the sale without printing it, click 
Record. 

� Print and record the sale. If the sale you’ve created is an item, 
service, time billing or professional invoice, you can print and 
record the transaction at the same time. Click Print in the Sales 
window. For more information about printing invoices, see 
Chapter 12, ‘Printing Forms,’ on page 151.

� Record and e-mail the sale. You can prepare an e-mail containing 
the sale directly from MYOB AccountEdge. Click Send To and 
choose E-mail. Review and make entries in the E-mail window 
and click Send. The e-mail which will include a PDF (Portable 
Document Format) attachment, will be sent to your default e-
mail application’s Outbox. Send the file from your e-mail 
application as you normally do. 

� Record and fax the sale. 

OS 8.6- 9.x users Click Send To and choose Fax. A dialog box 
from your fax application’s is displayed. Send the fax, using your 
fax application as you normally do. 

Mac OS X users Click Send To and choose Fax. A dialog box 
from your fax application’s is displayed. Select your fax driver 
from the printer destinations and send the fax, using your fax 
application as you normally do. 

� Record and save the sale to disk as a PDF. You can save the sale as 
a PDF (Portable Document Format) file which you can attach to 
an e-mail. Click Send To and choose Disk. In the dialog box that 
is displayed, enter a file name and location for the file and click 
Save. 
User Guide
� Save the sale as a recurring sale so that you can use it many times 
in the future. Click Save Recurring. In the Save Recurring 
Template window, enter the necessary information and click 
Save Template. (For more information about creating and using 
recurring transactions, see ‘Working with Recurring Transactions’ 
on page 116.) If you want to record the sale as an actual 
transaction now, click Record in the Sales window. If you don’t 
want to record the sale at this time, click Cancel.

Adding lines, subtotals and headers to 
invoices

You can add lines, headers and subtotals to invoices, making it easy 
to separate and subtotal different categories of a sale on one 
invoice. 

To insert a blank line 

1 Position the mouse pointer anywhere on the line item above which 
you want the blank line to appear.

2 Go to the Edit menu and choose Insert Line. 

To insert a header

You can group several line items by inserting a header.

1 Position the insertion point in the line item above which you want 
the header to appear.

2 Go to the Edit menu and choose Insert Header. A blank line will 
appear in the scrolling list with the cursor positioned in the 
Description column.
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3 Type the text for the header. The text appears in gray, as shown 
below.

To insert a subtotal

1 Position the insertion point in the first line below the items to be 
subtotaled.
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2 Go to the Edit menu and choose Insert Subtotal. As shown below, 
a line will appear, displaying the subtotal of all the line items above 
it.

To delete a blank line, line item, header or subtotal

1 Position insertion point in anywhere on the blank line, line item, 
header or subtotal you want to delete.

2 Go to the Edit menu and choose Delete Line.
Changing the Status of a Sale

You can easily change the status of a sale. If you enter a quote or an 
order in MYOB AccountEdge, you can convert it to an invoice once 
your customer is ready to buy your product or service. A quote can 
be changed to an order or invoice. An order can only be converted 
to an invoice. The status of an invoice cannot be changed. 

To convert a quote to an order or invoice

You can convert a quote to an order or invoice from the Sales 
window or from the Sales Register.

1 Locate and display the quote. To do this:

� in the Sales window, enter the name of the customer whose 
quote you want to convert. Select the quote from the list that is 
displayed and click Use Sale, or

� from the Sales Register, click the Quotes tab. Find the quote 
using the search filters at the top of the window and highlight it. 

2 Convert the quote. To do this:

� Click Order to convert the quote to an order, or
� Click Invoice to convert the quote to an invoice.

Three new fields appear in the Sales window: Paid Today, Payment 
Method and Balance Due.

3 Make any necessary changes to these and other fields. Change the 
transaction date to today’s date.

4 Click Record. The new order or invoice is created in MYOB 
AccountEdge. The original quote will remain in the Sales Register 
unless you have indicated in the Sales view of the Preferences 
window that you want quotes to be deleted once they are recorded 
as orders or invoices.
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To convert an order to an invoice 

You can convert an order to an invoice from the Sales window or 
from the Sales Register. If you want to convert several orders at 
once, see the following section.

1 Locate and display the order. To do this: 

� in the Sales window, enter the name of the customer whose 
order you want to convert. Select the order from the list that is 
displayed and click Use Sale, or

� from the Sales Register, click the Orders tab. Find the order 
using the search filters at the top of the window and highlight it. 

2 Click Invoice to convert the order to an invoice.

3 Make the necessary changes to the information in this window. 
Change the transaction date to today’s date.

4 Click Record. The new invoice is created in MYOB AccountEdge 
and the original order is removed. 
User Guide
To convert several orders to invoices at once

You can convert several orders to invoices at once using the To Do 
List window. Keep in mind that the conversion will occur 
automatically and will be recorded with today’s date; you won’t get 
a chance to review or change any of the transactions before they’re 
converted. If you’re not sure you want to convert a particular order, 
we suggest you use the Sales window to manually make the 
conversion (see previous procedure). 

1 Click To Do List from any command center. The To Do List window 
is displayed. 

2 Click the Orders tab to display a list of all your sales and purchases. 
If you want to view details about a specific order, click the zoom 
arrow to the left of the customer’s name. 

3 Select the orders you want to convert to invoices by clicking the 
Action column.

4 Click Record as Actual.
Reviewing your Sales Information
An important part of managing your business revolves around 
collecting your sales data and understanding its effects on your 
overall financial picture. MYOB AccountEdge contains a number of 
tools that you can use to review your sales information so you can 
make better decisions about your business. 

� The Sales Register gives you an overall picture of your sales 
activity—open and closed invoices, orders, quotes, returns, 
credits, etc. See ‘To find a transaction using the Sales Register’ on 
page 110.
� Find Transactions helps you find individual sales transactions 
quickly. See ‘To find a transaction using Find Transactions’ on 
page 110.

� The To Do List displays all open sales and recurring sales and 
orders, sorted by overdue dates.

� The Analyze Sales window can help you understand the “big 
picture” of your sales activity graphically. See ‘To analyze your 
sales activity’ on page 66.

� Sales reports help you keep track of your sales activity.
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� The Transaction Journal lists journal entries of your sales and 
other transactions. See ‘To find a transaction using the 
Transaction Journal’ on page 113.

� You can view seven years of sales history for an item or a 
customer: for the past five past years, the current year and the 
next year.

To view a list of all unpaid sales, sorted by days 
overdue 

1 Click To Do List in any command center. The To Do List window is 
displayed.

2 Click the A/R tab. A list of all unpaid sales is displayed. 

3 The Overdue column shows the number of days a receivable is 
overdue (a negative number in the Overdue column indicates that 
the payment is not yet due). The number of days an invoice is 
overdue is calculated by checking the original date of the sale, 
comparing it to today’s date and looking at the customer’s credit 
terms.

4 If you want to send a collection letter using mail merge to 
customers with overdue payments, select those customers by 
clicking in the Action column.

5 If you have installed OfficeLink, click Mail Merge to create the letter 
directly in your word processor. Otherwise, click Disk to create a 
merge file that you can open in your word processor.

In MYOB Help, choose Forms and Reports > OfficeLink and click the 
topic Creating personalized letters using Officelink for more 
information on creating collection letters using OfficeLink.
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To analyze your sales activity

Understanding the “big picture” of your sales activity will help you 
spot business trends and anticipate your company’s future needs. 
The Analyze Sales window can help you perform this important 
task by providing various illustrations—in graphs or in lists—of your 
sales activity.

1 Go to the Sales command center and click Analysis. The Analyze 
Sales window is displayed. 

2 Click Filters and choose the sales figures, time periods and other 
criteria you want to view. Click OK. The information you selected 
appears in the Analyze Sales window.

3 Use the buttons in the Analyze Sales window to view illustrated 
reports of your sales activity. For more information, click Help in this 
window. 

To view sales reports 

There are a number of sales reports in MYOB AccountEdge that can 
help you track your sales activity. For example, you can run the 
Receivables Aging report to view your customers’ current balances 
sorted by aging periods. The Analyze Sales (Item) report tells you 
at a glance which stock items are selling best. The Referral Source 
report is great for marketing purposes—find out which referral 
source is bringing your business the most money. 

� To view a list of all your sales reports, go to the Reports menu and 
choose Index to Reports. Click the Sales tab in the Index to 
Reports window. For information on displaying, customizing and 
printing your reports, see Chapter 13, ‘Using Reports,’ on 
page 161.
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To view sales history

You can view sales history for an item, a customer or an employee. 

� Display the Item Information window for an item or the Card 
Information window for a card, and then click the History tab.
User Guide
The History tab displays a total of seven years’ sales history for the 
item or card: five past years, the current year and the next year. For 
more information, click Help in this window.
Receiving Payments
In MYOB AccountEdge, when customers make payments for the 
sales you’ve conducted with them, you record the payments in the 
Receive Payments window; here you can apply the payment to 
one or more of the customer’s outstanding sales balances. If the 
customer is paying immediately after having purchased 
merchandise or services, you should enter the payment amount in 
the Paid Today field of the invoice.

While you would normally use the Receive Payments window to 
enter customer payments, you can also use the Bank Register 
window for this purpose. The Bank Register is a real time-saver 
when you need to enter several customer payments and don’t wish 
to record detailed information (such as payment methods and 
discounts) for each payment. Note that whenyou use the Bank 
Register for customer payments the entire payment is 
automatically allocated to the oldest invoices first.

To receive payments

1 Go to the Sales command center and choose Receive Payments. 
The Receive Payments window is displayed. 

2 Choose the account that will be used to receive the customer 
payment.

� Deposit to account. Choose this option if you want the deposit 
recorded directly into an account. Specify the account by clicking 
the search icon and making a selection from the checking 
accounts that you’ve set up.

� Group with undeposited funds. Choose this option if you want 
the deposit to be recorded in the undeposited funds account. 
After you’ve grouped all the customer payments you want, you 
can then make a bank deposit. 

See ‘If a customer has overpaid you...’ on page 68 if a customer 
has paid you more than what they owe. 

3 Enter details of the customer payment, such as the customer name, 
amount received and payment method. Click Details to enter 
details of the payment. 

4 Adjust the memo and payment date if you want. You can change 
the ID number that is automatically generated. However, we 
recommend that you use the default number to ensure you don’t 
use duplicate IDs.

5 Indicate which sales will be affected—what debt will be reduced or 
“paid off,” in effect—by the customer payment by entering 
amounts in the Amount Applied column. If the customer is paying 
a deposit for an order, look for “Order” in the Status column.
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6 Make these entries in the scrolling list in the bottom half of the 
Receive Payments window. For detailed field help, click Help.

A Discount If you intend to award an early-payment discount 
for a sale, assign the discount to the appropriate 
invoice in this column. Note that MYOB 
AccountEdge won’t allow you to assign a discount 
to an invoice that is not being settled in full. If you 
want to give the customer a discount, you can give 
them a customer credit. See ‘Creating Customer 
Credits’ on page 70.

B Amount Applied Enter how much of the customer payment you 
want to apply to each sale in this column.

C Finance Charge If part of the payment was used to pay finance 
charges, enter the finance charge amount here. 
See ‘Adding Finance Charges’ on page 69 for more 
information. 

D Out of Balance Keep in mind that the amount(s) you apply in the 
Amount Applied column will accumulate in the 
Total Applied field; and the Total Applied amount 
(plus finance charges) must equal the amount that 
appears in the Amount Received field in the top 
half of the window before you can record the 
transaction. The Out of Balance amount must be 
zero before you can record the transaction.

BA C D
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7 Click Record to record the customer payment. 

NOTE : Preparing a bank deposit of the undeposited funds 
transaction If you chose to group the payment with other 
undeposited funds, you will need to create a transaction within 
MYOB AccountEdge to reflect the deposit of these funds into the 
bank. You would normally do this at the end of the working day, 
after the day’s customer payments have been banked. For more 
information, see ‘To prepare a bank deposit’ on page 50.

NOTE : If a customer has overpaid you... If a customer overpays 
their account, it is very important that the entire payment is entered 
into the system. The full payment should be entered in the Amount 
Received field and in the Amount Applied column in the scrolling 
list. When you record the payment, MYOB AccountEdge will 
automatically create a credit invoice for the overpaid amount. This 
can either be refunded to the customer or applied to a future 
invoice. For more information, see ‘Settling customer credit’ on 
page 71.
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Adding Finance Charges
Finance charges are amounts added to an outstanding balance as a 
penalty for late payment. A finance charge can be added to a 
customer’s statement; amounts paid by a customer to cover the 
charge are then recorded in the Receive Payments window.

Setting up and using finance charges

To use finance charges, set up the linked accounts for tracking late 
payment charges in the Linked Accounts window (go to the Setup 
menu, choose Linked Accounts and then Accounts).

Set the percentage you will be charging for late payments in the 
customer cards. 

To show on a statement the finance charge owed by a customer, 
mark the Add Finance Charges to Amount Due checkbox in the 
Print Statements window.

When your customer pays the late payment charge, enter the 
amount in the Finance Charge field of the Receive Payments 
window. 

Although MYOB AccountEdge does not track the history of finance 
charges, you can perform an account inquiry (using Find 
Transactions) on the finance charge linked accounts to view the 
amounts paid. 

The finance charge payable by your customers will only appear on 
their statements; so you may want to keep a copy of the statements 
sent to customers.
User Guide
How finance charges are calculated

MYOB AccountEdge looks at all open invoices and calculates their 
due dates (using the invoice terms). The overdue balance is then 
multiplied by 1/30th of the monthly finance charge interest rate 
(also entered in the invoice) for every day it is overdue.

If, during the overdue period, the customer makes a partial 
payment, MYOB AccountEdge adjusts the finance charge 
accordingly; the calculation is based on the daily overdue balance 
for every open invoice.

Deleting finance charges

When you enter a finance charge in the Receive Payments window, 
two transactions are recorded—the customer payment and a 
corresponding transaction in the Sales Journal.

Therefore, if you want to delete a finance charge payment, you 
must delete both transactions. If only one entry is deleted, the 
Receivables Reconciliation report may show an Out of Balance 
amount equal to the finance charge. 

When you delete one of the entries, you will be reminded to delete 
the other entry for the finance charge. Note that the warning will 
appear even though you may have already deleted the 
corresponding invoice or payment.
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Creating Customer Credits
In MYOB AccountEdge, a customer credit is a transaction that 
indicates you owe money to a customer.

Recording credits

At various times you may want to issue a customer credit to a 
customer. This may be in order to rectify a problem or simply record 
a customer credit that you may have offered. You can create a 
customer credit in one of the following ways:

� Reverse an existing sale. Use this method if you are crediting 
the customer for the entire sale.

� Manually create a credit. You can use this method if you are 
crediting the customer for part of a sale. 

To reverse an existing sale

Use this method if you want to credit a customer for the entire sale 
and not just part of it. Note that your company file must be set to 
“unchangeable” before you can reverse an invoice; that is, the 
Transactions CAN’T be changed; they must be reversed 
checkbox must be marked in the Security view of the Preferences 
window.

1 Find and display the invoice. See ‘Finding a Transaction’ on 
page 110.

2 Go to the Edit menu and choose Reverse Sale. After a few 
moments, a customer credit is displayed in the Sales window.

3 If you want, you can make a few changes to the customer credit 
(such as the date and memo), but you can’t change the accounts, 
amounts and quantities that are associated with the credit. 

4 Click Record Reversal. 
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To manually create a credit

NON-ITEM SALES

Choose this method of creating a customer credit if you want to 
credit the customer for a returned non-item sale. 

1 Go to the Sales command center and choose Enter Sales. The 
Sales window is displayed. 

2 Choose the status and layout for the sale. 

3 Enter the customer details and credit details, and select the account 
number to be credited. This is normally an income account called 
Sales Returns. Enter the amount of the credit as a negative amount.

4 Click Record. 

ITEM SALES

Choose this method of creating a customer credit if you want to 
credit the customer for a returned item. 

1 Go to the Sales command center and choose Enter Sales. The Sales 
window is displayed. 

2 Choose Item as the layout and enter the customer details.

3 Enter negative quantities for the items being returned in the Ship 
column. The cost of the items is displayed as negative.

4 Click Record. 
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Settling customer credit 

You can choose from two ways of settling a customer credit :

� By applying the customer credit to one or more of the customer’s 
unpaid sales, thereby reducing the amount of money the 
customer owes you, or

� By writing a refund check for the amount of the customer credit.

To apply customer credits

Follow the steps below to locate the customer credit you want and 
then apply the credit to one or more of the customer’s outstanding 
sales.

1 Go to the Sales command center and click Sales Register. The 
Sales Register window is displayed. 

2 Click the Returns & Credits tab.

3 Click the Search by down arrow and choose Customer. Enter the 
customer’s name in the adjacent field. A list of credits for that 
customer is displayed. 

4 Highlight the credit you want to apply and click Apply to Sale. The 
Settle Returns & Credits window is displayed, listing all open sales 
assigned to the customer.
User Guide
If you marked the Apply Customer Payments Automatically to 
Oldest Invoice First checkbox in the Sales view of the Preferences 
window, amounts will appear next to the oldest invoices in the 
Amount Applied column. However you can apply the credit to the 
customer’s oldest open sales; apply the credit amount to any one 
transaction; or you can divide it among many transactions in the 
list. Keep in mind, however, that the total amount you apply in the 
Amount Applied column must equal the amount that appears in 
the Credit Amount field.

5 Enter the amounts you want to apply to each open sale in the 
appropriate field in the Amount Applied column.

6 Enter the customer credit amount in the Finance Charge field only 
if you want to apply part of a customer credit to any unpaid finance 
charges the customer may have accrued. 

7 If you want to give a discount to the customer for a particular sale, 
enter the discount amount in the sale’s Discount column. 

8 Click Record to apply the customer credit. 

NOTE : If the transaction is unbalanced... If the transaction is 
unbalanced, that is, if the total amount entered in the Amount 
Applied column doesn’t equal the amount displayed in the Credit 
Amount field at the top of the window, a message will be displayed. 
Click OK to close the message. Then check that the amounts you 
have applied to the various transactions are correct. If you change 
the amount in the Credit Amount field, keep in mind that you can 
only enter an amount less than the original customer credit amount. 
If you choose to do this, the customer credit won’t be fully applied; 
the remaining amount will continue to appear as a credit.
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To write a refund check

You can choose to pay the customer for the amount of a customer 
credit using the Pay Refund function in the Sales Register. 

1 Go to the Sales command center and click Sales Register. The 
Sales Register window is displayed. 

2 Click the Returns & Credits tab.

3 Click the Search by down arrow and choose Customer. Enter the 
customer name in the adjacent field. A list of credits for that 
customer is displayed. 

4 Highlight the credit you want to refund and click Pay Refund. A 
refund check for the amount of the customer credit is displayed in 
the Settle Returns & Credits window. 

5 Make any necessary changes to the information in the window.

If you change the amount in the Amount field, keep in mind that 
you can only enter an amount less than the original customer credit 
amount. If you choose to do this, the customer credit won’t be fully 
settled; the difference will continue to appear as a customer credit.

6 Click Record to record the check or click Print to print and record 
the refund check. For more information about printing checks, see 
‘Printing Forms’ on page 153.
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 Chapter 5
Entering

Purchases

Just as a business needs sales, it also needs purchases. Surviving in a competitive 
environment means these purchases have to represent value for money—MYOB 
AccountEdge will help you obtain value.

As with sales, MYOB AccountEdge will help you take control of your purchases and 
creditors. As well as handling all your accounting requirements, MYOB AccountEdge’s 
ability to handle quotes, orders and bills can help you make better purchases.

For example, you can use MYOB AccountEdge to record quotes from your vendors, then a 
week later bring up a list of the quotes you have been given; you can then use MYOB 
AccountEdge to fax or e-mail the successful vendors for you and easily turn the quotes into 
orders. When the goods are supplied, you can turn the orders into bills. If the need arises, 
MYOB AccountEdge will help you track down lost or damaged goods, and seek 
replacements or refunds.

You can use MYOB AccountEdge to find out what is being bought, when and from which 
vendors. You can easily find out how much you owe, to whom, and for what.

Handling vendor payments couldn’t be easier. MYOB AccountEdge offers you the choice of 
cash, check and credit card. Any purchase returns can be easily applied to open purchases 
or, if the need arises, a refund can be deposited to any of your checking or credit card 
accounts.
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Entering Purchases
You can enter a purchase transaction as a Quote, Order or Bill.

� You can enter a quote in MYOB AccountEdge to easily store an 
estimate or quote you received from one of your vendors, 
without creating a transaction. A quote has no impact on your 
inventory levels and can be changed to an order or bill when 
you’re ready to purchase.

� An order is a purchase where no service or goods have been 
received. While orders don’t affect your financial numbers, they 
do affect your inventory numbers “on order” in the Analyze 
Inventory window and reports. Orders don’t create a transaction 
in MYOB AccountEdge unless you have paid a deposit to the 
vendor. An order can be changed to a bill.

� A bill is usually created when you have received the items or 
services you ordered and are required to pay the vendor. 
Recording a bill will update the appropriate accounts, including 
the account for tracking payables. Bills can be open, closed or 
debits. A bill can’t be changed to a quote or order.

Entering purchases in the Bank Register

While purchases are usually recorded in the Purchases window, 
miscellaneous one-time purchases that you have paid for can be 
recorded in the Bank Register. The advantage of using the Bank 
Register for this type of purchase is that you can quickly record the 
transaction with minimum detail. The Miscellaneous purchase 
layout is used by default for purchases entered in the Bank Register. 
For more information, see ‘Entering Transactions in the Bank 
Register’ on page 53.
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To enter a purchase transaction, you’ll complete the steps below. 

� Choose the type of purchase you want

� Enter vendor information

� Enter line items—the items or services you are purchasing

� Enter additional information about the purchase

� Complete the purchase

Step 1: Choose the type of purchase you want 

Choose the required status and layout for the transaction you are 
creating. The layout displayed in the Purchases window is 
determined by the default you selected when you set up purchase 
details (using the Purchases Easy Setup Assistant) or the vendor’s 
card. 

1 Go to the Purchases command center and click Enter Purchases. 
The Purchases window is displayed.

2 Choose the required status from the pop-up menu in the upper left 
corner of the window. 

3 Click Layout if you want to change the layout. The Select Layout 
window is displayed. 

4 Choose the layout (item, service, professional or miscellaneous) that 
you want to use and click OK.

Step 2: Enter information about the vendor

Regardless of the type of purchase you’re creating, you should pay 
special attention to the top section of the Purchases window. The 
information you enter here will determine a number of things about 
the purchase, including the vendor’s terms for the purchase and the 
identification numbers assigned to the transaction.
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To change your credit terms for this transaction

When you enter a vendor’s name in the Vendor field, your 
company’s credit terms with that vendor appear next to the 
vendor’s name automatically. If you want to change these terms for 
this particular transaction, follow the steps below.

NOTE : Changes affect only the current transaction If you want 
to change the credit terms that will be used for all future purchases 
from this vendor, you should make that change in the Buying 
Details tab of the vendor’s card.

1 Click the zoom arrow next to the Terms field. The Credit Terms 
window displays information about the terms for the transaction.

2 Make the changes you want in the Credit Terms window and then 
click OK to close the window. The Purchases window is displayed 
again, with the new credit terms displayed next to the Terms field.

A Enter the vendor’s name. Click the search icon to display your 
vendor list.

B Click the zoom arrow to alter the terms for this purchase only. See 
the following section.

C Enter the purchase number here.

D If the vendor gave you an invoice number for this transaction, enter 
it here.

A B C D
User Guide
Step 3: Enter the items or services you are 
purchasing

The scrolling list in the middle of the Purchases window is where 
you enter details of what you are buying. In this area, you’ll enter 
item numbers, descriptions, account numbers (or account names 
depending upon your selection in the Preferences window) and 
other information that will serve as the detail for your transaction.

When you enter information in one row in the scrolling list, you 
enter one line item of the transaction. You can enter as many line 
items on a purchase as you want. The actual fields that appear in the 
scrolling list differ, depending upon the type of purchase you’re 
creating.

NOTE : Add lines, subtotals and headers to purchases You can 
add lines, headers and subtotals to purchases to make it easy to 
separate and subtotal different categories of purchases in one bill. 
For more information, see ‘Adding lines, subtotals and headers to 
purchases’ on page 77

.
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A Received Enter the quantity of the item being received.

B Backorder Enter the quantity of the item placed on backorder.

C Item Number Press TAB and choose an item from your item list.

D Description A description of the item is displayed automatically. You 
can change it if you want.

E Price The price of the item is displayed automatically. You can 
change it if you want.

F Discount Enter a volume discount you received from the vendor in 
percentage form.

G Total The total price of the items is calculated automatically.

H Job Enter a job number here to assign a line item to a specific 
job (optional). For more information about jobs, see 
‘Setting up Categories and Jobs’ on page 42.

I Tx  Mark the Tx column if you are paying tax for this line 
item.

J Description On a service, professional or miscellaneous purchase, 
enter a description of the goods or services purchased.

K Acct # or Name On a service, professional or miscellaneous purchase, 
choose the account to which to allocate the purchase. 
Press TAB and choose an account from the Accounts List. 
For normal purchases, this would be an expense 
account. 

Service purchase

A B C D E F G H I

J K

Item purchase
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Step 4: Enter additional information about 
the purchase

The actual fields that appear at the bottom of the Purchases 
window differ, depending upon the type of purchase you’re 
creating. Click Help in this window for detailed field help.

A Optional fields Enter optional details, such as a comment, 
shipping method, and the date the goods or 
services were promised. Enter text or click the 
search icon to choose from the Select From List 
window.

B Already Printed or 
Sent

Mark this checkbox if you do not want to flag the 
purchase for printing at this stage.

C Journal Memo The Journal Memo is generated automatically. You 
can change it if you want.

D Tax If you want to view or change the tax amount of 
the purchase, click the zoom arrow. 

E Freight Enter any charges for freight. If the freight charge 
is taxable, enter a tax code in the field to the right. 

F Paid Today Enter an amount here to indicate how much 
money you paid at the time of the purchase or, if 
you’re creating an order, how much money you 
gave as a deposit.

G Tax Code If you want to change the tax code assigned to this 
purchase, enter a different tax code here. 

A B DC E F G
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Step 5: Complete the purchase

Now that you’ve finished making entries in the Purchases window, 
there are a number of tasks you can perform with the transaction. 
Make sure you review all the following options before you choose 
what you want to do.

� Record the purchase. To record the purchase without printing it, 
click Record. 

� Print and record the purchase. If the purchase you’ve created is an 
item, service or professional purchase, you can print and record 
the transaction at the same time. Click Print in the Purchases 
window. For more information about printing purchase forms, 
see Chapter 12, ‘Printing Forms,’ on page 151.

� Record and e-mail the purchase. You can e-mail the purchase 
directly from your e-mail application. Click Send To and choose 
E-mail. Review and make entries in the E-mail window as 
required and click Send. The e-mail will be sent to your default e-
mail application’s Outbox. Send the file from your e-mail 
application’s as you normally do. 

� Record and fax the purchase. Click Send To and choose Fax. A 
dialog box from your fax application is displayed. Send the fax 
using your fax application as you normally do. 

� Record and save the purchase to disk as a PDF. You can save the 
purchase as a PDF (Portable Document Format) file which you 
can attach to an e-mail. Click Send To and choose Disk. In the 
dialog box that is displayed, enter a file name and location for the 
file and click Save. 

� Save the purchase as a recurring purchase so that you can use it 
many times in the future. Click Save Recurring. In the Save 
Recurring Template window, enter the necessary information 
and click Save Template. (For more information about creating 
and using recurring transactions, see ‘Working with Recurring 
Transactions’ on page 116.)
User Guide
If you want to record the purchase as an actual transaction now, 
click Record in the Purchases window. If you don’t want to 
record the purchase at this time, click Cancel. 

Adding lines, subtotals and headers to 
purchases

You can add lines, headers and subtotals to purchases, making it 
easy to separate and subtotal different categories of purchases on 
one bill. 

To insert a blank line 

1 Position the insertion pointer anywhere on the line item above 
which you want the blank line to appear.

2 Go to the Edit menu and choose Insert Line.

To insert a header

You can group several line items by inserting a header.

1 Position insertion pointer in the line item above which you want the 
header to appear.

2 Go to the Edit menu and choose Insert Header. A blank line will 
appear in the scrolling list with the cursor positioned in the 
Description column.

Type the text for the header. The text appears in gray, as shown 
below.
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To insert a subtotal

1 Position insertion pointer in the the first line below the items to be 
subtotaled.

2 Go to the Edit menu and choose Insert Subtotal. As shown below, 
a line will appear, displaying the subtotal of all the line items above 
it.
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To delete a blank line, line item, header or subtotal

1 Position the mouse pointer anywhere on the blank line, line item, 
header or subtotal you want to delete.

2 Go to the Edit menu and choose Delete Line.
Changing the Status of a Purchase
You can change the status of a purchase. If you enter a quote or 
order in MYOB AccountEdge, you can easily convert it to a bill once 
the amount is payable. The order must be converted to a bill to 
show up as a payable. A quote can be changed to an order or a bill. 
An order can only be converted to a bill.

To convert a quote to an order or bill

You can convert a quote to an order or a bill from the Purchases 
window or from the Purchases Register.

1 Locate and display the quote. To do this:

� in the Purchases window, enter the name of the vendor whose 
quote you want to convert. Select the quote from the list that is 
displayed and click Use Purchase, or

� from the Purchases Register, click the Quotes tab. Find the 
required quote using the search filters at the top of the window 
and highlight it. 
2 Convert the quote. To do this: 

� Click Order to convert the quote to an order, or

� Click Bill to convert the quote to a bill.

3 Review and update the information in the Purchases window as 
necessary. Change the transaction date to today’s date.

4 Click Record. The new bill or order is created in MYOB 
AccountEdge. The original quote will remain in the Purchases 
Register unless you have indicated in the Purchases view of the 
Preferences window that you want quotes to be deleted once they 
are recorded as orders or bills. 
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To convert an order to a bill

You can convert an order to a bill in the Purchases window or from 
the Purchases Register. If you want to convert several orders to bills 
at once, see ‘To convert several orders to together’.

1 Locate and display the order. To do this: 

� in the Purchases window, enter the name of the vendor whose 
order you want to convert. Select the order from the list that is 
displayed and click Use Purchase, or

� from the Purchases Register, click the Orders tab. Find the 
required order using the search filters at the top of the window 
and highlight it. 

2 Click Bill to convert the order to a bill.

3 Review and update the information in the Purchases window as 
necessary. Change the transaction date to today’s date.

4 Click Record. The new bill is created in MYOB AccountEdge and the 
original order is removed. 
User Guide
To convert several orders to together

You can convert several orders to bills at once in the To Do List 
window. Keep in mind that the conversion will occur automatically; 
you won’t get a chance to review or change any of the transactions 
before they’re converted. If you’re not sure you want to convert a 
particular order, we suggest you use the Purchases window to 
make the conversion manually (see ‘To convert an order to a bill’). 

1 Click To Do List from any command center. The To Do List window 
is displayed. 

2 Click the Orders tab to display a list of all your orders. 

If you want to view details about a specific order, click the zoom 
arrow to the right of the vendor’s name.

3 Select the orders you want to convert to bills by clicking the Action 
column.

4 Click Record as Actual. 
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Reviewing your Purchase Information
An important part of managing your business centers around 
collecting your purchase data and understanding its effects on your 
overall financial picture. MYOB AccountEdge contains a number of 
tools that you can use to review your purchase information so you 
can make better decisions about your business. 

� The Purchases Register gives you an overall picture of your 
purchase activity—open and closed purchases, orders, quotes, 
returns, etc. See ‘To find a transaction using the Purchases 
Register’ on page 111.

� Find Transactions helps you find individual purchase 
transactions quickly. See ‘To find a transaction using Find 
Transactions’ on page 110.

� The To Do List displays all open purchases, recurring purchases 
and orders, sorted by overdue dates.

� The Analyze Payables window can help you understand the “big 
picture” of your purchase activity graphically. See ‘To analyze 
payables’ on page 81.

� Purchase reports help you keep track of your purchase activity.

� The Transaction Journal lists journal entries of your purchases 
and other transactions. See ‘To find a transaction using the 
Transaction Journal’ on page 113.

� You can view seven years of purchase history for an item or 
vendor for the past five years, the current year and the next year. 
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To view a list of all unpaid purchases, sorted by 
days overdue

You can view a list of all unpaid purchases in the To Do List and 
enter vendor payments for those purchases. 

1 Click To Do List from any command center. The To Do List window 
is displayed.

2 Click the A/P tab. A list of all unpaid purchases is displayed. 

The Overdue column shows the number of days a payable is 
overdue (a negative number in the Overdue column indicates that 
the payment is not yet due). The number of days a bill is overdue is 
calculated by checking the original date of purchase, comparing it 
to today’s date and looking at your credit terms with the vendor.

3 Click the Action column for each bill you want to pay off. The linked 
Checking Account For Paying Bills will be used for all vendor payments 
made from the To Do List.

CAUTION : Transactions are recorded automatically If you choose 
to make vendor payments by marking the Action column in the To 
Do List window, keep in mind that the transactions will be recorded 
automatically; you won’t be able to change any of the payments 
before they’re recorded. You can choose to manually enter a 
payment in the Pay Bills window by clicking the zoom arrow next to 
the transaction. See ‘Paying Bills’ on page 82.

4 Click Pay Bills. 
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To analyze payables

The Analyze Payables window allows you to view detailed 
information about how much you owe vendors and how long 
you’ve owed them. 

This analysis is based upon all bills and payments recorded in your 
company file. 

1 Go to the Purchases command center and click Analysis. The 
Analyze Payables window is displayed.

2 Click Filters and set your filters in the Aging Date window.

3 Display the required view of the Analyze Payables window. The 
Summary view displays all the money that you owe vendors, 
totalled by vendor. The Vendor Detail view displays all the money 
that you owe the vendor whose name appears in the Vendor Detail 
field. The Purchase Detail view displays all the transactions 
assigned to the purchase that appears in the Purchase Detail field.

The information in this window is based upon the selections you 
made in the Aging Periods fields of the Reports & Forms view of 
the Preferences window and the entries you made in the Aging 
Date window.

To view purchase reports 

There are a number of purchase reports in MYOB AccountEdge 
which can help you track your purchase activity. For example, you 
can run the Payables Aging report if you want to analyze your 
payables as of a past date. The Analyze Purchases (Item) report 
shows you at a glance the inventory items on which you are 
spending the most money. 

To view a list of all your purchase reports, go to the Reports menu 
and choose Index to Reports. Click the Purchases tab in the Index 
to Reports window. For information on displaying, customizing 
and printing your reports, see ‘Using Reports’ on page 161.
User Guide
To view purchase history for an item or vendor

You can view the purchase history for an item or vendor. 

Display the Item Information window for an item or the Card 
Information window for a vendor, and then click the History tab. 
The History tab displays a total of seven years’ purchase history for 
the item or card: five past years, the current year and the next year. 
For more information, click Help in this window. 
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Paying Bills
Payments to your vendors are made in the Pay Bills window in the 
Purchases command center. When you pay bills in MYOB 
AccountEdge, you apply the payment to one or more of your 
outstanding purchase balances.

Paying vendors using the Bank Register While you would 
normally use the Pay Bills window to pay your vendors, you can 
also use the Bank Register window for this purpose. The Bank 
Register is a real time-saver when you have several bills to pay and 
don’t need to record detailed information (such as discounts and 
finance changes) for each payment.

The disadvantage of using the Bank Register for vendor payments 
is that if you have several outstanding bills with a vendor, you 
cannot conveniently choose the bill you want to pay or split a 
payment between bills—the entire payment is automatically 
allocated to the oldest bill. (You should use the Pay Bills window for 
this type of transaction; see the procedure below.) For more 
information, see ‘Entering Transactions in the Bank Register’ on 
page 53.
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To pay bills

1 Go to the Purchases command center and choose Pay Bills. The 
Pay Bills window is displayed.

2 Enter the account the will be used to make this payment in the 
Account field.

3 Mark the Already Printed checkbox if you’re recording a paper 
check that has already been written or if you’re recording another 
type of transaction (such as a petty cash payment) that doesn’t 
require a printed check at the end of the transaction.

4 Enter the details of the payment, such as the vendor’s name, 
amount and payee address. If you want to use an alternate address, 
click the Payee down arrow and make a selection, or simply type 
the address you want to use.

5 Change the memo and payment date if necessary. 

You can change the check number that is automatically generated. 
However, we recommend that you use the default number to 
ensure you don’t use duplicate check numbers.

NOTE : If you receive an alert message If you have outstanding 
debit memos with this vendor, a message is displayed. You’ll have 
the opportunity to settle the debit memos immediately or at a later 
date. See ‘Settling vendor debits’ on page 85.
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6 Indicate which bills will be affected—what debt will be reduced or 
“paid off”—by the payment. Make these entries in the scrolling list 
in the bottom half of the Pay Bills window.

A Discount If you taking an early-payment discount for a 
purchase, assign the discount to the appropriate 
bill in this column. Note that MYOB AccountEdge 
won’t allow you to assign a discount to a bill that 
you are not settling in full. If this is the case and you 
want to record a discount that the vendor has 
given you, you can create a vendor debit. See 
‘Creating Vendor Debits’ on page 84.

B Amount Applied Enter how much of the payment you want to apply 
to each bill in this column. 

C Finance Charge If part of the payment was used to pay finance 
charges, enter the finance charge amount here.

D Out of Balance Keep in mind that the amount(s) you apply in the 
Amount Applied column will accumulate in the 
Total Applied field. The Total Paid amount must 
equal the amount that appears in the Amount 
field in the top half of the window before you can 
record the transaction. The Out of Balance 
amount must be zero before you can record the 
transaction. 

BA C D
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7 Decide what you want to do with the payment. 

� To print and record the payment, click Print. For more 
information about printing forms, see ‘Printing Forms’ on 
page 153.

� To record the payment, click Record.

If you want, you can print this payment later. For more 
information, see ‘Printing Forms’ on page 151.

What are Finance Charges?

Finance charges are amounts added to an outstanding balance as a 
penalty for late payment. If your vendor has added a finance charge 
to your account, you can enter the payment to cover that charge in 
the Pay Bills window.

To use finance charges in MYOB AccountEdge, set up the linked 
account for tracking late payment charges in the Accounts 
Payables Linked Accounts window (go to the Setup menu, choose 
Linked Accounts and then Purchases Accounts).

If you have paid the late payment charge, enter it in the Finance 
Charge field in the Pay Bills window. 

Although MYOB AccountEdge does not track the history of finance 
charges, you can perform an account inquiry (using Find 
Transactions) on the finance charge linked accounts to view the 
amounts paid. 

Deleting Finance Charges

When you enter a finance charge in the Pay Bills window, two 
transactions are recorded—the payment and a corresponding 
transaction in the Purchases Journal.

Therefore, if you want to delete a finance charge payment, you 
must delete both transactions. If only one entry is deleted, the 
Payables Reconciliation report may show an Out of Balance 
amount equal to the finance charge. When you delete one of the 
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entries, you will be reminded to delete the other entry for the 
finance charge. Note that the warning will appear even though you 
may have already deleted the corresponding payment. 
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Creating Vendor Debits 
In MYOB AccountEdge, a vendor debit is a transaction that indicates 
that a vendor owes your company money.

Recording vendor debits

When you’re creating a vendor debit for the first time, you may 
have to create an account designated for tracking returns and 
allowances. Make sure the new account is an income account. See 
‘To add new accounts to your Accounts List’ on page 103 for more 
information on creating an account.

You can create a vendor debit in one of the following ways:

� Reverse an existing purchase. Use this method if you are reversing 
the entire original purchase.

� Manually create a debit. 

To reverse an existing purchase

Use this method if you want to create a vendor debit for the entire 
purchase and not just a part of it. Note that your company file must 
be set to “unchangeable” before you can reverse a purchase; that is, 
the Transactions CAN’T be changed; they must be reversed 
preference must be set in the Security view of the Preferences 
window.

1 Find and display the bill. See ‘Finding a Transaction’ on page 110.
2 Go to the Edit menu and choose Reverse Purchase. After a few 
moments, a vendor debit will be displayed in the Purchases 
window.

3 If you want, you can make a few changes to the vendor debit (such 
as the date and memo), but you can’t change the accounts, 
amounts and quantities that are associated with the debit. 

4 Click Record Reversal. 

To manually create a debit

You create a debit differently for non-item purchases versus item 
purchases.

NON-ITEM PURCHASES

Choose this method if you want to create a vendor debit for a non-
item purchase that you returned. 

1 Go to the Purchases command center and choose Enter 
Purchases. The Purchases window is displayed. 

2 Choose the required status and layout for the purchase. 

3 Enter the vendor details and debit details, and select the account 
number to be debited. This is normally an expense account called 
Purchases Returns. Enter the amount of the debit as a negative 
amount.

4 Click Record. 
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ITEM PURCHASES

1 Go to the Purchases command center and choose Enter Purchases. 
The Purchases window is displayed.

2 Choose Item as the layout and enter the vendor details.

3 Enter negative quantities for the items you are returning in the 
Received column. The cost of the items are displayed as negative 
amounts. 

4 Click Record.

Settling vendor debits

You can choose from two ways of settling a vendor debit: 

� By applying the vendor debit to one or more of your unpaid 
purchases with the vendor, or 

� By recording a refund check from the vendor for the amount of the 
vendor debit.

To apply a vendor debit to an unpaid purchase

Follow the steps below to locate the vendor debit you want and 
then apply the debit to one or more of your unpaid purchases.

1 Go to the Purchases command center and click Purchases 
Register. The Purchases Register window is displayed. 

2 Click the Returns & Debits tab.

3 Click the Search by down arrow and choose Vendor. Enter the 
vendor name in the adjacent field. A list of debits for that vendor is 
displayed. 

4 Highlight the debit you want to apply and click Apply to Purchase. 
The Settle Returns & Debits window is displayed, listing all open 
purchases that you’ve made from the vendor. 
User Guide
5 Enter the amount you want to apply in the appropriate field in the 
Amount Applied column. 

If you marked the Apply Bill Payments Automatically to Oldest Bill 
First preference in the Purchases view of the Preferences window, 
amounts will appear next to the oldest bill in the Amount Applied 
column at the top of the scrolling list. MYOB AccountEdge is 
suggesting that you apply the debit to your oldest open purchases; 
however, you can apply the debit amount to any one 
transaction—or you can divide it among many transactions—in the 
list. Keep in mind, however, that the total amount you apply in the 
Amount Applied column must equal the amount that appears in 
the Debit Amount field.

6 Enter an amount in the Finance Charge field only if you want to apply 
part of the vendor debit to any unpaid finance charges you may have 
accrued. 

7 If the vendor gave you a discount for a particular purchase, enter 
the amount in the purchase’s Discount column. 

8 Click Record. 

If the transaction is unbalanced, that is, if the total amount 
entered in the Amount Applied column doesn’t equal the 
amount displayed in the Debit Amount field at the top of the 
window, a message will be displayed. Click OK to close the 
message. Then check that the amount you have applied to the 
various transactions is correct. 

If you change the amount in the Debit Amount field, keep in 
mind that you can only enter an amount less than the original 
vendor debit amount. If you choose to do this, the vendor debit 
won’t be fully applied; the remaining amount will continue to 
appear as a debit.

9 Click Record to apply the vendor debit.
Creating Vendor Debits 85



To receive a refund check

1 Go to the Purchases command center and click Purchases 
Register. The Purchases Register window is displayed. 

2 Click the Returns & Debits tab.

3 Click the Search by down arrow and choose Vendor. Enter the 
vendor name in the adjacent field. A list of debits for that vendor is 
displayed. 

4 Highlight the debit that is being refunded and click Receive 
Refund. A refund transaction for the amount of the vendor debit is 
displayed in the Settle Returns & Debits window. 

5 If necessary, make changes to the information in the window.

If you change the amount in the Amount Received field, keep in 
mind that you can only enter an amount less than the original 
vendor debit amount. If you choose to do this, the vendor debit 
won’t be fully applied; the remaining amount will continue to 
appear as a debit.

6 Click Record to record the receipt of the refund check.
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 Chapter 6
Managing

Your
Inventory
In Chapter 2, ‘Setting Up Your Company File,’ on page 19, we looked at creating and 
working with inventory items. If the items you created are marked I Inventory This 
Item, you are using what accountants call the Perpetual inventory system and this 
chapter is for you.

The Perpetual inventory system keeps track of your items; so you can track how many 
goods are in stock, how much are they worth, from whom did you buy and to whom did 
you sell? 

From time to time, businesses running a Perpetual inventory system may find that their 
theoretical inventory levels differ from what is on the shelves. These variations can be 
caused by data entry errors, spoilage and theft and, if common, should be investigated. 
This chapter shows you how to compensate for inventory variations.

Sometimes the quantity of items recorded in MYOB AccountEdge may be correct, but their 
values are incorrect. A range of items may become outdated, damaged or for some other 
reason lose value. This chapter shows you how to revalue your stock.

Many retailing and manufacturing businesses combine existing inventory items to create 
new inventory items. For example, a retailer may combine a bottle of perfume, lotion and 
bath salts and make up a gift pack. Manufacturers combine raw materials to create new 
inventory items. This chapter shows you how to track your inventory transfers and 
automate the transfers using the Auto-Build features.
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Making Inventory Adjustments
From time to time you may need to adjust item quantities and 
values. For example, if your inventory gets damaged, you may have 
to write off some of your inventory or revalue it. When this happens, 
it’s important that you make your adjustments in MYOB 
AccountEdge carefully so that your records remain accurate. 

Follow the procedure below to make a one-time adjustment for a 
single item or a few items using the Adjust Inventory window. 

However, if you need to update the quantities of several items, you 
can do it quickly from the Count Inventory window. See ‘Counting 
Inventory’ on page 93. 

NOTE : Print the Items List (Summary) report When making an 
an inventory adjustment, you may find it useful to print out the 
Items List (Summary) report, which gives you the on-hand 
quantities of all your items. You can then determine what the 
adjustment should be. 
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To make an inventory adjustment

1 Go to the Inventory command center and click Adjust Inventory. 
The Adjust Inventory window is displayed.

2 Enter details of the adjustment. For complete field help, click Help. 

A Enter the quantity by which you want to increase or decrease the quantity 
held. Do not enter the new total quantity; enter only the adjustment 
quantity. 

Enter the quantity in inventory units, not buying or selling units. 

If you enter a positive number, that number is added to your on-hand 
inventory. If you enter a negative number, that number is subtracted from 
your on-hand inventory.

B The cost of each unit transferred in or out of inventory is entered here. The 
average cost of the item is displayed by default. The average cost is 
calculated as the total cost of the item divided by the number of units on 
hand.

C The Amount field displays the quantity multiplied by the unit cost. If you 
change it, the unit cost is automatically recalculated.

D The allocation account is usually a cost of sales or expense account if you 
are increasing or decreasing the value of the Inventory account. 

A CB D
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3 If you want to assign the transaction to a particular category, click 
the search icon to select a category from the Category List.

For more information about categories, see ‘Setting up Categories’ 
on page 43.

4 Click Record to save the inventory adjustment.

The following are some examples of inventory adjustments. 

Example 1 In the following example, the inventory adjustment 
will increase the number of units on hand by two and the total value 
of the item on hand by $800. The adjustment has been allocated to 
the Inventory adjustment account (Shrinkage & Spoilage). 

Example 2 In the following example, the inventory adjustment 
will increase the quantity of the item by two units but will not adjust 
the total value of the item on hand. That will reduce the average 
cost of the item. An account is not required in this case as there is no 
adjustment to the balance of the inventory account.

Example 3 In the following example, the inventory adjustment 
will increase the total value of the item on hand by $120 but will not 
change the inventory quantity. The adjustment has been allocated 
User Guide
to the Inventory adjustment account (Shrinkage & Spoilage). The 
average cost of the items will increase as a result of this adjustment.
Making Inventory Adjustments 89



Making Inventory Transfers
In MYOB AccountEdge, transferring inventory is the process of 
taking one or more items, known as components, and combining 
them to make up another item, known as a finished item. For 
example, you could create an inventory transfer to turn 
components like timber and fabric into finished items like furniture. 
Alternatively you could create a kit composed of a number of 
articles. 

Use the Transfer Inventory window for a one-time transfer of 
stock. For routine transfers, use the Auto-build feature. See ‘Auto-
building Items’ on page 91.

1 Go to the Inventory command center and click Transfer 
Inventory. The Transfer Inventory window is displayed. 

2 Enter the line items for the finished item and for the components. 
For detailed field help, click Help in this window.

A On one line, enter the item number of the finished item you want to 
create. On the next lines, enter the item numbers of the component items 
you want to transfer.

A CB

D
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3 If you want to assign the transaction to a particular category, click 
the search icon to select a category from the Category List.

For more information about categories, see ‘Setting up Categories’ 
on page 43.

4 Click Record to save the inventory transfer.

B Enter the transfer quantity. Enter a positive number for the finished item 
(this number is added to your on-hand inventory). Enter a negative 
number for the component items (this number is subtracted from your on-
hand inventory).

C Enter the cost of each unit transferred in or out of inventory. MYOB 
AccountEdge defaults to the average cost of the item. The average cost is 
calculated as the total value of the item divided by the number of units on 
hand.

D The Out of Balance field must be zero before you can record the 
transaction. That is, the amount in the Amount field for the finished item 
must be equal to the sum of the amounts in the Amount field for the 
components.
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Auto-building Items
Transferring inventory is a simple process if you choose to 
automatically build finished items using MYOB AccountEdge’s 
Auto-build inventory feature. 

There are two stages:

� See ‘Create a new Auto-Build item’ below to specify the 
components required.

� See ‘Auto-build a finished item’ on page 92 to quickly create 
finished items.

Step 1: Create a new Auto-Build item 

1 Go to the Inventory command center and click Items List. The 
Items List window is displayed.

2 Click the zoom arrow of the item you want to Auto-Build. The Item 
Information window is displayed. 

3 Click the Auto-Build tab. 

4 Enter the minimum level of the item you want to have in inventory 
before you re-order (or re-construct) the item in the Minimum 
Level for Restocking Alert field.
User Guide
5 Click Edit List. The Auto-Build Information window is displayed.

6 Specify the number of item units the listed components will make in 
the List what it takes to build field. If bulk quantities of materials 
are purchased to build an item, it may be easier to specify the 
materials required to build a larger quantity of the item, such as ten 
or twenty.

7 Enter the item details of each of the components. 

a Click in the Item Number column and press TAB. Your Items List 
is displayed. 

b Highlight the first item required to build the new finished item 
and then click Use Item. The item number and name are dis-
played in the Auto-Build Information window.

c In the Quantity field, enter the number of components required 
to build the specified quantity of the finished item. 

8 Repeat the previous step for each of the components required to 
build the new item. Click OK when you have entered them all.
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9 Click OK in the Item Information window. 

Step 2: Auto-build a finished item

1 Go to the Inventory command center and click Auto-Build. The 
Auto-Build Inventory window is displayed.

2 When you click Build Items, the Transfer Inventory window 
displays the details of the transfer that will occur when the finished 
item is built. Review the entries in this window to make sure the 
quantities, unit costs, and total inventory values are correct. Note 
that the quantities of the components in the list are displayed as 
negative numbers, while the quantities of the finished items in the 
list are shown as positive numbers.

A This column displays all items that you've designated as finished items.

B The On Hand, On Order and Net on Hand columns show the current 
record of your finished items.

C Enter the quantity of finished items you want to build in this column.
(Click None if you want to change all numbers in the Qty to Build column 
to zero).

D Click Build Items to begin creating an inventory transfer for the items for 
which you've made an entry in the Qty to Build column.

B

C
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3 Click Record to record the inventory transfer and update your 
inventory quantities and values.

You can also auto-build items using the To Do List. In the MYOB 
Help, choose Inventory > Transferring Inventory > click Auto-building 
items.
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Counting Inventory
You may recall entering your opening inventory quantities using the 
Count Inventory window when you set up your company file. 

You can also use the Count Inventory window to make 
adjustments to item quantities during regular inventory counts or 
any time you find discrepancies between the actual quantity of 
items you have in inventory and your MYOB AccountEdge records 
of those quantities.

The Count Inventory window will speed the process of updating 
the quantities of items. By using this window, you can quickly create 
one inventory adjustment for all the items whose quantities you 
need to change.

Each inventory adjustment you make must be allocated to a specific 
account so your accounting records accurately reflect the reasons 
why your inventory needed adjusting. For example, many 
businesses use one account—often called 
“Shrinkage/Spoilage”—to track natural loss or theft of their items.

Before you count inventory in MYOB AccountEdge

� Make sure you record any inventory transfers before counting 
your inventory. Otherwise, missing inventory that was really used 
to build another item will be accounted for as an expense, such 
as loss or shrinkage. See ‘Making Inventory Transfers’ on page 90 
for more information. 

� Count the actual items in your inventory. You can use the 
Inventory Count Sheet report, which lists all your inventory 
items, for this purpose. 

NOTE : You can either print the Inventory Count Sheet by clicking 
Print in the Count Inventory window or, if you want to set filters, 
from the Index to Reports window. 
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To count inventory

1 Go to the Inventory command center and click Count Inventory. 

2 In the Count Inventory window, enter the actual quantities of the 
inventory items in the Counted column. Any discrepancy between 
the counted quantity and the on-hand quantity is displayed in the 
Difference column.

3 Click Adjust Inventory to display the Adjustment Information 
window.

You can specify a default allocation account with which you can 
track the adjustments you entered in the Count Inventory window. 
This saves you having to enter an account on every line of the 
inventory adjustment. This account is normally an expense account 
such as shrinkage. It should not be your inventory asset account. 

Keep in mind, however, that you don’t need to enter a default 
allocation account in the Adjustment Information window. If it’s 
necessary for you to use different accounts to track the adjustments 
you made in Step 2, you’ll get the chance to enter those accounts in 
the next step. 

4 Click Continue. The Adjust Inventory window is displayed. A line 
item for each adjustment you entered in the Count Inventory 
window in Step 2 is displayed.

5 Take a look at the Account column. If you entered a default 
allocation account in Step 3, that account appears in the Account 
column for each line item. If you didn’t enter a default allocation 
account, enter the accounts you want to use to track each item’s 
change in quantity. Click Record.
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Reviewing your Inventory Information
Managing inventory can be a time consuming task for a business if 
accurate and complete records are not kept. It is important to be 
able to review and explain item movements over time, for example 
purchases and sales, as well as manual transfers and adjustments 
that are made due to shrinkage, spoilage or theft. You also need to 
be able to see quickly what you have and what you need to meet 
customer orders.

MYOB AccountEdge contains a number of tools that you can use to 
review your inventory information so you can make better decisions 
about your business. 

� The Items Register gives you an overall picture of your inventory 
transfers, adjustments, sales and purchases for all items, or it can 
be filtered to show the history of a single item. See ‘To find a 
transaction using the Items Register’ on page 112.

� Find Transactions helps you find individual inventory 
transactions quickly. See ‘To find a transaction using Find 
Transactions’ on page 110.

� The To Do List displays an alert for all items that need to be 
purchased or built. See ‘To view a list of all items that need to be 
built or purchased.’

� The Analyze Inventory window can help you understand the 
“big picture” of your itemorders and commitments easily. See ‘To 
analyze inventory’ on page 95.

� Inventory reports help you keep track of your item quantities 
and value. See ‘To view inventory reports’ on page 95.

� The Transaction Journal lists journal entries of your inventory 
adjustments and other transactions. See ‘To find a transaction 
using the Transaction Journal’ on page 113.
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� You can view sales and purchase history for an item or vendor 
for the past five years, the current year and the next year. See ‘To 
view sales and purchase history for an item’ on page 95.

To view a list of all items that need to be built or 
purchased

The Stock Alert view of the To Do List lists all items that need to be 
built or purchased to fulfill customer orders and it enables you to 
easily enter the necessary orders or Auto-Build transactions. 

1 Click To Do List from any command center. The To Do List window 
is displayed.

2 Click the Stock Alert tab. A list of all items that need to be ordered 
or built is displayed. The On Hand column shows the quantity of 
the item actually on hand. The On Order column shows the 
quantity of this item already on order. The Committed column 
shows the quantity of this item on backorder for customers.

3 Click the Action column for each item you want to build or order. 
When you click Order/Build, an order will automatically be entered for 
the items that are purchased. The restocking information entered in the 
Buying Details view of the Item Information window is used to 
determine the vendor and quantity to order (see ‘To create an item’ 
on page 37) or the items to build.

CAUTION : Transactions are recorded automatically If you choose 
to build or order items by marking the Action column in the To Do 
List window, keep in mind that the transactions will be recorded 
automatically; you won’t be able to change any of the details before 
they’re recorded. You can choose to manually enter an order or 
Auto-Build transaction by clicking the zoom arrow next to the item.

4 Click Order/Build. 
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To analyze inventory

The Analyze Inventory window allows you to view detailed 
information about how much stock you have on hand, what is 
committed, on order and available. 

This analysis is based upon all the sales orders and purchase orders 
recorded in your company file. 

1 Go to the Inventory command center and click Analysis. The 
Analyze Inventory window is displayed.

2 Display the required view of the Analyze Inventory window. The 
Summary view displays all inventoried items, while the Item# view 
displays all the customer and vendor orders for a selected item.

To view inventory reports 

MYOB AccountEdge has several reports which you can generate to 
keep track of your inventory. Following is a list of some of the 
reports you may find useful. For information on finding, 
customizing and printing reports, see ‘Using Reports’ on page 161. 

� Analyze Inventory report. The summary and detailed versions 
of this report serve as your ‘order book.’ You can view a list of all 
your sales orders and purchase orders for all or selected items.

� Items List (Summary) report. This report shows information 
about your items, including their on-hand quantities and total 
value. The Items List (Summary) report also shows an item’s 
current average cost price, which is important to know when 
making inventory adjustments. You can use this report to 
compare your total inventory value to the total of your Inventory 
asset accounts. 

� Pricing report. This report lists your item prices—useful for 
sending to your customers. You could also convert this report to 
HTML and post your price list on an intranet or Internet site.
User Guide
To view sales and purchase history for an item

Display the Item Information window for an item and then click 
the History tab. The History tab displays a total of seven years’ 
purchase and sales history for the item: five past years, the current 
year and the next year. For more information, click Help in this 
window. 
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Setting Item Prices
You can quickly change the default selling prices of the items you 
sell using the Set Item Prices window. 

You can still change prices at the point of sale, which will override 
the default price for that sale only.

Average Cost and Last Cost

Average Cost is calculated by MYOB AccountEdge as the total cost 
of the item (what you paid when you purchased the item or the cost 
entered when you transferred the item into inventory) divided by 
the number of units on hand. 

Last Cost is the purchase price on the most recent purchase. If the 
most recent item activity is an inventory transfer, the unit transfer 
cost is used.

Note that you cannot adjust prices based on a markup of the 
current selling price—for example, a 10 percent increase on the 
current selling price. 

To change the price of items

1 Go to the Inventory command center and click Set Item Prices. 
The Set Item Prices window is displayed.

This window lists all your current inventory items, their current 
price, and the average or last cost of each item.

If an item is not listed, it means that you haven’t marked the I Sell 
option for the item. 

2 Click in the Current Price column of an item and enter a new price. 
Do this for each item price you want to change.
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MYOB AccountEdge accepts unit prices up to four decimals. On the 
invoice, it multiplies the unit price by the quantity sold before 
rounding to cents. 

3 Click OK.

To change the price of multiple items at once

You can change the prices of multiple items at once using pricing 
shortcuts.

1 Go to the Inventory command center and click Set Item Prices. 
The Set Item Prices window is displayed.

2 Mark the Shortcut column next to the items whose prices you want 
to update. If you want to update the prices of all your items, you can 
leave the Shortcut column blank. 

3 Click Shortcuts. The Pricing Shortcuts window is displayed.

4 Make as many entries as you want in this window, including how 
you want the price rounded, the basis for calculating the price, and 
so on. For detailed field help, click Help.

5 Click Update x Items Only to update the items you marked in step 
2. 
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Customizing Inventory 
MYOB AccountEdge has three features that allow you to specifically 
customize how you record information and prices for your 
inventory:

� Custom price levels, which you can use to assign a price level 
(one of six) to a customer for purchases of five different quantities 
of the item. There are six price levels for each of the five quantity 
breaks. For example, you might have quantity breaks of five, ten, 
twenty, fifty and hundred. For each of these breaks, you can set 
six different price levels for your customers.

� Custom fields, which you can use to ensure certain information 
is always recorded for an item, such as Warranty, Warehouse 
Location and Voltage. These should be used for information that 
you don’t need to use as report filters.

� Custom lists, which you can use to record information about an 
item and then be able to run reports per custom list. For 
example, if you are running a trailer rental business, you might 
have custom lists of ‘Color,’ ‘Type,’ and ‘Location.’ This means 
you could run a report to include only blue cage trailers at the 
Main Street station.

Creating custom price levels

MYOB AccountEdge has a pricing matrix for handling inventory. 
Using five quantity breaks and six price levels, you can structure 
your pricing according to customer status and sales quantities. This 
gives you full control of giving discounts to customers for bulk sales 
of an item.

For example, a level three customer might pay $140 for a single 
quantity of the item, but if they purchased five units of the item, 
they would only have to pay $100 each for them.
User Guide
NOTE : Volume Customer Discount Note that the Volume Customer 
Discount for each customer in the Card File applies to a sale over and 
above the quantity break price levels you set up. 

Setting custom price levels includes the following steps:

� Naming your price levels

� Specifying price levels for an item

� Assigning a price level to a customer

To name your price levels

1 Go to the Lists menu, choose Custom Lists and Field Names and 
then Price Levels. 

2 Enter names for each of the price levels as you want them to appear 
in the Selling Details tab of the Item Information window. Click 
OK.

To specify price levels for an item

1 Display the Item Information window for the item and click the 
Selling Details tab. 

The Base Selling Price you entered for this item in the upper section 
of the Selling Details tab appears at Level A (or whatever you have 
chosen to label this field). 

2 In the remaining fields (Levels B to F, or whatever you have chosen 
to label them), enter the selling price of this item. Make an entry for 
each price level you want to use. For detailed help, click Help. 

In the next Over field, enter the new quantity break, where for sales 
of this quantity and above, you assign different price levels. Assign 
the different price levels for this quantity break.
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3 Continue to enter up to five quantity breaks, for each of which you 
can enter up to six price levels. Note that each quantity break must 
specify a quantity greater than the previous quantity break and less 
than the next. 

To assign a price level to a customer

1 Display the customer’s Card Information window and click the 
Selling Details tab. 

2 Enter the price level you want to assign to the customer in the Item 
Price Level field.

You can assign one of the six price levels or the item’s Base Selling 
Price to the customer.

3 Click OK.

Creating custom fields

The three custom fields are an optional feature of MYOB 
AccountEdge inventory that are used simply to record additional 
information about your items. Unlike custom lists, custom fields 
cannot be used to filter inventory reports. Examples of how you 
might name the custom fields include ‘warranty,’ ‘warehouse 
location,’ and ‘manufacturer.’ 

1 Go to the Lists menu and choose Custom Lists and Field Names 
and then Items. 

2 Enter the new field names in the Name of Custom Field fields and 
click OK. These field names will now appear in the Item Details tab 
of the Item Information window, for all items.

You can customize your invoices and purchases to include the 
custom fields on your purchases and invoices. For more information 
on customizing forms, see ‘Customizing Forms’ on page 155. 
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Creating custom lists

MYOB AccountEdge allows you to create three custom lists that you 
can use to sort and group your inventory items. 

An example of a custom list might be ‘Color,’ in which you create 
list entries of ‘yellow,’ ‘red,’ ‘green’ and ‘blue.’ When you create or 
edit your items, you can assign them one of these colors. When you 
run an Inventory report such as the Analyze Inventory (Summary) 
report, you can choose to include only red items in the report. 

Creating custom lists includes the following steps:

� Naming the custom list
� Creating custom list entries
� Assigning a custom list entry to an item

To name the custom list

1 Go to the Lists menu, choose Custom List and Field Names, and 
then Items. 

2 Enter names for each of the three custom lists in the appropriate 
fields and click OK. These custom list names will now appear in the 
Item Information window.

To create custom list entries

1 Go to the Lists menu, choose Custom Lists and then Items. The 
Custom Lists window is displayed. 

2 Click the Custom List drop-down menu and choose the list for 
which you want to make entries.

3 Click the New button and enter the name of the list entry. For 
example, if you have a Color list, you would enter a color, such as 
Yellow.

4 Repeat Step 3 until you have created all your list entries, and then 
click OK.
User Guide
To assign a custom list entry to an item

1 Display the Item Information window for the item and click the 
Item Details tab. 

2 Click the search icon next to a custom list and choose the required 
entry. 

Custom lists and inventory reports

MYOB AccountEdge allows you to generate reports using your 
custom lists as report filters. This means that you can generate a 
report to include only those items with a certain list entry, such as 
the color red. For more information on setting report filters, see 
‘Filtering reports’ on page 163.

Printing custom lists on your purchases and 
invoices

You can customize your invoices and purchases to include custom 
lists. See ‘Printing Forms’ on page 151 for more information on 
customizing and printing forms. 
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 Chapter 7
Working

With Lists

MYOB AccountEdge’s system of lists is like your address book or your schedule and can, 
along with your transactions, be your research assistant. By lists we mean MYOB 
AccountEdge’s system of organizing cards, accounts, jobs, payroll categories, items, tax 
codes, time billing activities, currencies and categories. These lists can be accessed from 
the Lists menu and from the command center from where you would be most likely to use 
them. For example, the Items List is available from the Inventory command center.

Lists streamline the repetitive tasks of keeping your accounts by creating records that you 
can use time and time again. For example, the customer, item, tax code and account you 
use to record a sale can be used as many times as you need. Lists also allow MYOB 
AccountEdge to keep track of the companies that owe you money, the items you have sold, 
and the tax codes being used.

If you create vendor and customer cards, you can use MYOB AccountEdge’s contact log 
system (see Chapter B, ‘More Tools for Managing Your Business,’ on page 201) to keep a 
detailed record of all your dealings with your business contacts. For example, you can 
record sales and purchase information, notes about conversations and more within the 
contact logs.

MYOB AccountEdge’s lists can be easily edited and modified to suit your own 
requirements. For example, you can modify account and job levels to affect how they 
appear in reports. You can also inactivate records you don’t use frequently to keep your lists 
short and up to date.

Lists can greatly assist your marketing efforts. For example, you could use a combination 
of customer lists, identifiers, contact logs and e-mail addresses to create a list of customers 
who live near you and have contacted you within the past six months. You could then use 
MYOB AccountEdge to create an Adobe Acrobat PDF file of your current price list and e-
mail or fax it to these customers. The marketing possibilities are almost limitless.
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Adding a New Record
Lists are made up of individual records. For example, each item in 
your Items List is a record, as is each job in your Jobs List. You can 
add as many records as you want to a list. 

Adding a new card

When you set up your company file, you created cards for your 
existing customers, vendors and employees using the Easy Setup 
Assistant. 

You can add any number of new cards to your Card List any time 
you want. In addition to customer, vendor and employee cards, you 
can also create personal cards for your friends and relatives. 

The procedure for creating a card from the Card File command 
center is very similar to creating a card using the Easy Setup 
Assistant. 

To add a new card to your Cards List

1 Go to the Card File command center and click Cards List. The 
Cards List window is displayed. 

2 Click New. The Card Information window is displayed. 

3 Choose the required card type—Customer, Vendor, Employee or 
Personal.

4 Complete the fields in the relevant tabs in this window. For detailed 
field help on creating a card, click Help in each tab.

You may want to take advantage of the following optional, but 
useful, features in the Card Details tab:

� Identifiers, which are useful for grouping your cards and limiting 
information you view for that group. See ‘Organizing your cards’ 
on page 202.
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� Picture, which allows you to link a PICT file to a card. See ‘Linking 
a picture to a record’ on page 202.

� Custom lists and fields lets you record additional information 
about a card that may be specific to your business. See 
‘Recording additional information about your cards’ on 
page 202.

Adding a new account

When you set up your company file using the Easy Setup Assistant, 
you reviewed your Accounts List and perhaps created some new 
accounts. 

If your business requires any additional accounts, you can add them 
to your Accounts List any time you want from the Accounts List 
window. The procedure for creating an account from the Accounts 
List window is very similar to creating an account using the Easy 
Setup Assistant. 
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To add new accounts to your Accounts List

1 Go to the Accounts command center and click Accounts List. The 
Accounts List window is displayed.

2 Click New. The Account Information window is displayed. 

3 Enter information about the new account. For detailed field help, 
click Help.

Adding other records

If you want to add:

� an item, see ‘To create an item’ on page 37. The procedure for 
adding new items to your Items List is the same as for creating 
item records during setup.

� a tax code, see ‘To create a tax code’ on page 35.

� a job, see ‘To create a job’ on page 44. 

� a category, see ‘To create a category’ on page 43

� a payroll category, see ‘Creating Payroll Categories’ on page 120.

� a time billing activity, see ‘To create an activity’ on page 134.

� a foreign currency, see ‘Set up records for foreign currencies’ on 
page 142.

Adding records using Easy–Add

You can create new records easily using Easy Add. Accounts and 
customer, vendor, employee and personal cards can be added to 
your lists on the fly as you perform your daily business tasks in 
MYOB AccountEdge. 
User Guide
To create a new record using Easy-Add

Let’s assume you want to add a customer card while entering a sale.

1 In the Sales window, click the search icon next to the Customer 
field. The Select from List window is displayed, with a list of your 
customer cards.

2 Enter the name you want to add in the Look for field and click 
Easy–Add. The customer card is added to your Cards List. You can 
now proceed to complete your task with the new card. 

3 Whenever you have time, go to the Card Information window and 
enter the rest of the customer details.

Easy-Add is not available from some transaction windows such as 
Spend Money where MYOB AccountEdge cannot predict the type 
of card (vendor, employee, etc.) that you want to create. 
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Finding a Record
Records are stored and displayed in lists. For example, the Jobs List 
window lists the jobs you have created, the Accounts List, your 
accounts, and so on. As lists get long, it can take time to locate a 
record. MYOB AccountEdge provides you with the following tools 
to quickly find a record. 

Tabs Some lists are divided into separate views or tabs. For 
instance, the Accounts List is divided by account type into eight 
tabs, making it easier for you to find an account. For example, if you 
are looking for an Asset account, click the Assets tab. Within the 
tab, you can use the scroll lists to find the record.

Search fields The Cards List and Items List have a Search field 
that you can use to locate a record quickly. Simply type a few 
characters of the card name or item number in the Search field. If 
you have specified in the Preferences window that you want to 
select items by item name and cards by card ID, enter the item name 
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or card ID instead. The record that most closely matches your entry 
will be highlighted in the list.
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Advanced Search filters

You can use advanced search filters such as recontact date and ZIP 
code to search for a single card or a group of cards. In the Cards List 
window, click Advanced. Enter the relevant filters to narrow your 
User Guide
search. The Cards List will display only those cards that fit your 
selection criteria.
Changing a Record
In MYOB AccountEdge, you can easily and conveniently update 
information you initially entered for your records. For example, you 
can update contact details for a card or the selling price of an item 
by simply displaying the record and typing in the changes.

You can make changes to information you recorded for your 
accounts, cards, items, payroll categories, tax codes, time billing 
activities, foreign currencies, reporting categories and jobs.

NOTE : Making changes to records that have been used in 
transactions Some restrictions apply when making changes to 
records that have been used in transactions. For example, if you’ve 
recorded sales or purchases with an item, you won’t be able to clear 
the I Buy This Item, I Sell This Item or I Inventory This Item 
checkboxes. If you want to change these selections, you’ll first need 
to remove the transactions to which the item is assigned. 

NOTE : Making changes to payroll categories Keep in mind that 
when you change a payroll category, you change the payroll 
category for all employees who are assigned that payroll category. 
Most likely, the employees’ paycheck amounts will be different after 
you change their payroll categories. You may find it easier to create 
a new payroll category and assign it to the employees concerned 
rather than change an existing category.
To make changes to a record

1 Display the list to which the record belongs. For example, if you are 
making changes to an account, display the Accounts List window; 
if you are changing a tax code, display the Tax Code List window, 
and so on. You can do this by using the Lists menu. 

2 Locate the record you want to change in the list. Use a search 
method described in ‘Finding a Record’ on page 104, if necessary.

3 Once you locate the record, click the zoom arrow next to it. The 
record details are displayed in the Information window. 

4 Make the required changes and click OK.
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Deleting a Record
You can delete a record that you no longer need. However, a record 
must meet certain criteria before it can be deleted. For example, 
most records cannot be deleted if they have been used in 
transactions.

Deleting an account

You can remove an account from the MYOB AccountEdge system if 
the account meets the following criteria:

� The account isn’t a Level 1 account.

� The account has a zero balance.

� No journal entries are assigned to the account.

� None of your recurring templates use the account.

� The account isn’t used as a linked account for any transaction 
types.

� The account isn’t linked to any of the items you’ve entered in the 
Item Information window.

To delete an account

1 Make a backup of your company file. 

2 Go to the Accounts command center and click Accounts List. The 
Accounts List window is displayed.

3 Click the zoom arrow next to the account you want to delete so that 
the account details are displayed in the Account Information 
window.

4 Go to the Edit menu and choose Delete Account.
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Deleting other records

Note the following before deleting cards, items, tax codes, payroll 
categories, time billing activities, foreign currencies, reporting 
categories and jobs. You can only delete the following...

� A card, item, tax code, payroll category, foreign currency or job 
that has not been used in a transaction. You need to delete the 
transactions before you can delete the record.

� A card that has not been used in a quote, order or recurring 
template.

� A foreign currency record that has not been linked to a card. 

� An item that is not in inventory. 

� Payroll categories with a zero balance. The Base Salary and Base 
Hourly wage categories cannot be deleted. Wages, deductions, 
accruals and employer expenses that have been recorded on 
current paychecks—that is, paychecks that have been recorded 
in the current payroll year—can’t be deleted.

� An activity when all the activity slips you’ve recorded for it have 
been purged.

� An activity slip, when the Time Billing invoice on which it was 
billed is deleted or purged.

To delete other records

1 Display the list to which the record belongs to. For example, if you 
are deleting an item, display the Items List window; if you are 
deleting a card, display the Cards List window, and so on. (If you 
are deleting an activity slip, display the View Activity Log window.) 
You can do this by using the Lists menu or from the appropriate 
command center. 
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2 Locate the record you want to delete and click the zoom arrow next 
to it. The record details are displayed in the Information window. 
(If you are deleting an activity slip, the record details are displayed 
in the Enter Activity Slip window).
User Guide
3 Go to the Edit menu and choose Delete. For example, if you want 
to delete a Time Billing activity, choose Delete Activity.
Inactivating/Reactivating a Record
If you have accounts, cards, items, jobs or time billing activities that 
you rarely use–for example, you created a card for a one-time sale 
or purchase–inactivating them after use will remove them from 
selection lists. Your list of records will be shorter, and consequently 
selecting the record you need will be easier. You can still use an 
inactive record in transactions by manually entering the record 
name.

To inactivate (or reactivate) a record

1 Display the list to which the record belongs to. For example, if you 
are inactivating a card, display the Cards List window. You can do 
this by using the Lists menu or from the appropriate command 
center.

2 Locate the record you want to inactivate or reactivate and click the 
zoom arrow next to it. The record details are displayed. For cards 
and items, make sure the Profile tab is displayed.

3 Mark the Inactive checkbox.

4 To reactivate the record, simply clear the checkbox.
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 Chapter 8
Working

With
Transactions
It is one thing to enter your data, but there comes a time when you need to find it. MYOB 
AccountEdge allows you to search for transactions by journal, account, card, payroll 
category, sale, purchase, report categories and job number.

You can simply look for transactions over a given date range, or set up more sophisticated 
searches. For example, you could look for checks between a given date range where the 
memo contains specific words. MYOB AccountEdge’s powerful search functions mean you 
will always be able to find the information you want quickly.

Once you have found your transaction, you can easily zoom back to the original 
transaction window. Here you can change, delete or reverse the transaction. Changing and 
deleting transactions bring with it auditing and security questions; so many larger 
businesses prefer to reverse their transactions. Reversing transactions keeps their audit 
trail complete.

As businesses have many repetitive transactions that occur weekly, monthly or yearly, 
MYOB AccountEdge allows you to set up recurring transaction templates. This is where 
you create templates for the transactions you record regularly and then tell MYOB 
AccountEdge to remind you when they are next due. Many businesses set up MYOB 
AccountEdge to remind them of their monthly obligations like rent. They may set up 
weekly reminders about sales and purchases; some businesses even set up recurring 
General Journal entries to record depreciation on a monthly basis.

MYOB AccountEdge has many features that can handle the repetitive tasks associated 
with running a business. It also makes it easy to locate and correct transactions. So read 
on and take advantage of these time-saving features.
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Finding a Transaction
MYOB AccountEdge has several search methods that can help you 
find a transaction quickly and conveniently. The method you use 
depends on the information you have at hand.

Find Transactions Use the Find Transactions function to find 
General Journal entries, sales, purchases, checks, deposits, and 
vendor and customer payments. Find Transactions has an 
advanced search tool which allows you to locate a transaction using 
a number of filters, including date, transaction ID, amount, memo, 
source journal, account, card, payroll category, report category and 
job. 

Sales Register Use the Sales Register to quickly access 
transactions relating to sales such as open, closed and recurring 
invoices, quotes, orders, credits and returns. This search method is 
most useful if you know the transaction date or customer’s name. 

Purchases Register Use the Purchases Register to find 
transactions relating to Purchases such as quotes, orders, open, 
closed and recurring purchases, debits and returns. This search 
method is most useful if you know the transaction date or vendor’s 
name.

Bank Register Use the Bank Register to find Spend Money and 
Receive Money transactions, cash sales and purchases, vendor 
payments and customer payments.

Transaction Journal Use this method to search for any transaction 
by source journal. You can search for inventory transfers, 
adjustments, etc., using the Transaction Journal. 
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To find a transaction using Find Transactions

1 From any command center, click Find Transactions. 

2 In the Find Transactions window, click the appropriate tab—for 
example, the Account tab to search by account.

3 Filter your search using the Search By and Date range fields. For 
example, to search for all transactions made in October 2002 
relating to customer Huston & Huston Packaging, you would make 
the following selections in the Card tab.

4 Click Advanced if you want to narrow your search further. For more 
information about the fields in this window, click Help. 

When the transaction(s) that fit your search criteria are displayed in 
the Find Transactions window, you can view them in detail by 
clicking the zoom arrow next to each transaction.

To find a transaction using the Sales Register

The Sales Register allows you to view an overall picture of your 
sales activity. Using just one window, you can quickly and efficiently 
look at open and closed invoices, quotes, orders, returns and credits 
and recurring templates. You can even view a list of all sales, if you 
choose.

You can perform several functions using the Sales Register, such as 
deleting a sale (see ‘To delete a transaction’ on page 115), 
converting the status of a sale (see ‘Changing the Status of a Sale’ 
on page 64) and changing the details of a sale (see ‘Changing a 
transaction’ on page 114).
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If one of your customers gives you a deposit, you can click the zoom 
arrow next to the relevant sales transaction in the Sales Register 
window to display the Sales - Edit window. Then, clicking Payment 
will display the Receive Payments window. In this window, you can 
record the deposit.

You can also display the Settle Returns and Credits window 
directly from the Sales Register if you want to apply a customer 
credit to a sale or offer a refund.

1 Go to the Sales command center and click Sales Register. The 
Sales Register window is displayed.

2 Click the tab of the sales category you’d like to view—for example, 
Open Invoices.

3 Filter your search using the Search By and Date range fields.

When the transactions that fits your search criteria is displayed in 
the Sales Register window, you can view them in detail by clicking 
the zoom arrow next to each transaction.
User Guide
To find a transaction using the Purchases Register 

The Purchases Register allows you to view an overall picture of 
your purchase activity. Using just one window, you can quickly and 
efficiently look at open and closed purchases, quotes, orders, 
returns and debits and recurring templates. You can even view a list 
of all purchases, if you choose. 

You can perform several functions using the Purchases Register, 
such as changing the status of a purchase (see ‘Changing the Status 
of a Purchase’ on page 78) and making changes to or deleting a 
purchase (see‘Working With Transactions’ on page 109 for more 
information). 

If you make a payment to one of your vendors, you can easily access 
the Pay Bills window from the Purchases Register and record the 
payment.

You can also display the Settle Returns & Debits window directly 
from the Purchases Register if you want to apply a vendor debit to 
one of your unpaid purchases with the vendor.

1 Go to the Purchases command center and click Purchases 
Register. The Purchases Register window is displayed.

2 Click the tab of the type of purchase you’d like to view, for example 
Open Bills.

3 Filter your search using the Search by and Date range fields.

When the transactions that fits your search criteria is displayed in 
the Purchases Register window, you can view them in detail by 
clicking the zoom arrow next to each transaction.
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To find a transaction using the Bank Register

You can use the Bank Register to find checks, Spend Money and 
Receive Money transactions, cash sales or purchases, vendor 
payments and customer payments.

1 Go to the Banking command center and click Bank Register. The 
Bank Register window is displayed. 

2 Specify the checking or credit card account you used for the 
transaction in the Account field. 

3 In the Dated From and To fields, enter the date range within which 
the transaction was recorded. All transactions between (and 
including) these dates will be listed.

4 Locate the transaction you want using the scroll bar and then click 
the zoom arrow to the left of the transaction to view it in its original 
window.
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To find a transaction using the Items Register

Use the Items Register to find inventory adjustments, sales and 
purchases for all items or for a single item. This search method is 
most useful if you know the transaction date. 

The Items Register gives you quick access to transactions relating 
to items. When the register is filtered to show a single item, a 
running balance of the item’s quantities and value is displayed.

1 Go to the Inventory command center and click Items Register. 
The Items Register window is displayed.

2 Specify whether you want to view transactions for all items or a 
single item by making the appropriate selection in the Search By 
field.

3 In the Dated From and To fields, enter the date range within which 
the transaction was recorded. All transactions between (and 
including) these dates will be listed.

4 Locate the transaction you want using the scroll bar and then click 
the zoom arrow to the left of the transaction to view it in its original 
window.
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To find a transaction using the Transaction 
Journal 

The Transaction Journal groups all your accounting entries into 
one of seven journals: General, Disbursements, Receipts, Sales, 
Purchases, Inventory and All. You can also display the Transaction 
Journal window by clicking Journal in a transaction window such as 
Sales.

1 Click Transaction Journal from any command center (except Card 
File). The Transaction Journal window is displayed. 

Click the appropriate tab—for example, the Sales tab to find a sales 
invoice, the Disbursements tab to find a check or vendor payment, 
and so on.

2 In the Dated From and To fields, enter the date range within which 
the transaction was recorded. All transactions between (and 
including) these dates will be listed. 

3 Locate the transaction you want using the scroll bar and then click 
the zoom arrow to the left of the transaction to view it in its original 
window.
User Guide
 Finding a Transaction 113



Changing or Deleting a Transaction
If you are part way through entering a transaction, you can erase it 
and start again by choosing Erase from the Edit menu. 

Occasionally, however, you may need to make changes to or delete 
a transaction you have already recorded. A transaction can be 
edited or removed only if it is changeable, that is, you have turned 
off the Transactions CAN’T be changed; they must be reversed 
(system-wide) setting in the Security view of the Preferences 
window. A changeable transaction is distinguished by a white zoom 
arrow next to it. 

NOTE : Making unchangeable transactions changeable You can 
make an unchangeable transaction changeable at any time simply 
by turning off this preference in the Security view of the 
Preferences window.

If you want to maintain a strict audit trail, you should consider 
leaving this preference on and reversing the transaction (see 
‘Reversing a Transaction’ on page 115).

Remember, when you delete a transaction, it is permanently 
removed from your records; any changes you make to a transaction 
permanently alters your records. 

Changing a transaction

Follow the instructions below to change a transaction.

CAUTION : Transactions that cannot be changed You cannot 
change a customer payment, vendor payment, paycheck, refund 
check or a bank deposit once it has been recorded. You can only 
delete or reverse these transactions.
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To change a transaction

1 Find and display the transaction in its original transaction window. 
See ‘Finding a Transaction’ on page 110 for instructions.

2 Make the necessary changes to the transaction. 

3 Click OK when you’re done. 

Deleting a transaction

Follow the instructions below to delete a transaction. Note the 
following when deleting a transaction.

Sales and purchases You can only delete a sale or purchase that 
does not have a payment applied to it. If you have recorded a 
payment for a sale or purchase, you must first delete the payment 
and then delete the transaction. Any discounts that may have been 
given must also be deleted before the transaction can be deleted.

If you applied a vendor debit towards a purchase, you must delete 
the debit before you can delete the purchase. A customer credit 
applied to a sale must be deleted before the sale can be deleted.

Receipts in the undeposited fund transactions account If you 
want to delete an individual receipt that was recorded on a bank 
deposit of receipts grouped in the undeposited funds account, you 
must first delete the bank deposit. When you delete a bank deposit, 
all of the receipts included in the bank deposit are returned to the 
Prepare a Bank Deposit window. You can then delete the required 
receipt from this window. 

Reconciled transactions Note that if you delete a reconciled 
transaction, your bank reconciliation will be out of balance. 
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To delete a transaction

1 Find and display the transaction in its original transaction window. 
See ‘Finding a Transaction’ on page 110�for instructions.
User Guide
2 Go to the Edit menu and choose Delete. The transaction will be 
removed permanently from your records.
Reversing a Transaction
If your accountant requires that you maintain an audit trail of all 
your accounting entries, you should reverse a transaction rather 
than change or delete it. 

A reversal transaction is a new transaction that replicates the 
original transaction, with debit amounts shown as credit amounts 
and vice versa. After posting a reversal transaction, you have two 
transactions (the original and the reversal), but the account 
balances appear as if the original transaction never happened. 

You can only reverse a transaction if it is unchangeable, that is, if the 
Transactions CAN’T be changed; they must be reversed 
(system-wide) checkbox is marked in the Security view of the 
Preferences window. An unchangeable transaction is distinguished 
by a gray zoom arrow next to it.

NOTE : Making changeable transactions unchangeable You can 
make a changeable transaction unchangeable at any time simply by 
turning on this preference in the Security view of the Preferences 
window.

When you reverse a transaction, remember that you cannot change 
the accounts or amounts. Also be aware of the date of a reversal 
transaction. If you use the current date when you reverse a 
transaction from a prior month, the month-end financials for the 
prior month will not reflect the reversal transaction. If you use the 
original date for the reversal transaction, your prior month financials 
should be reprinted as they would have changed. 
NOTE : Customer and vendor payments Be aware that if an early 
payment discount was applied to the sale or purchase to which you 
originally applied the payment, you also need to reverse the 
discount. (You can find discount transactions the same way you find 
vendor or customer payments; look for a transaction with the label 
Discount in the Find Transactions window.) 

To reverse a transaction

1 Find and display the transaction you want to reverse. See ‘Finding a 
Transaction’ on page 110 for instructions.

2 Go to the Edit menu and choose Reverse. For example, if you want 
to reverse a sale select Reverse Sale. After a few moments, a new 
transaction containing corresponding negative amounts exactly 
opposite of the amount in the original transaction is displayed.

3 If you want, you can make a few changes to the new transaction, 
such as the date and memo, but you can’t change the accounts and 
amounts that are associated with it. 

4 Click Record to record the reversal transaction. At this point, the 
transaction is reversed and all account balances are returned to their 
previous levels. 
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Working with Recurring Transactions
If you have transactions that must be written time and time 
again—for example, a rent check or depreciation expenses—they 
can be saved as recurring templates. You can make the following 
transactions recurring: sales, purchases, checks, deposits and 
General Journal entries. 

When you save a transaction as recurring, MYOB AccountEdge puts 
a copy of it in a separate list of recurring transactions. Any time you 
need to use one, all you need to do is simply click Use Recurring, 
select the appropriate template, verify the details and record it. 

To create a recurring template

1 Enter the details of the transaction in a transaction window. Then, 
instead of clicking Record, click Save Recurring. The Save 
Recurring Template window is displayed.

2 Enter a name to identify the template.

3 Specify the frequency of the transaction and a reminder date. 

If you specify the frequency and a reminder date, MYOB 
AccountEdge will post a reminder in your To Do List and, if the 
transaction affects a checking account, adjust for it on your Cash 
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Flow Worksheet. Note that a recurring transaction with a frequency 
of Other is not included in your Cash Flow Worksheet.

4 Click Save Template.
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To use a recurring template

You can use a recurring template from a transaction window such as 
Spend Money or Record Journal Entry, from the Sales Register, 
Purchases Register, Bank Register or from the To Do List. The 
advantage of using the To Do List is that you can process several 
recurring transactions at once.

TO PROCESS A SINGLE RECURRING TRANSACTION

1 Open a transaction window, for example Sales, and click Use 
Recurring. A list of recurring templates that you have created is 
displayed. 

2 Select the required template and click Use Recurring. The 
transaction is displayed, ready to be modified (if needed) and 
recorded.

3 Verify the date, amount, account and other details and make any 
necessary changes.

4 Click Record. 

TO PROCESS MULTIPLE  RECURRING TRANSACTIONS

1 From any command center, click To Do List.

2 Click the appropriate tab—Sales for recurring sales, Purchases for 
recurring purchases and Transactions for all other recurring 
transactions. 

When the list of transactions is displayed, you can click the zoom 
arrow to the left of a transaction to view it in detail.
User Guide
3 In the To Do List window, click the Action column to mark any 
recurring transactions you want to process.

4 Click Record to process all the transactions you have selected. 
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To change a recurring template

To change a recurring template’s name or frequency, click Use 
Recurring in a transaction window, select the template and click 
Edit Frequency. To change the detail (memo, accounts, amounts, 
etc.) of a template, wait until the next time you need to use it. When 
it is displayed, change it before recording. The next time you use 
the recurring template, the new detail will be displayed.

To delete a recurring template

To delete a recurring template from your list, click Use Recurring in 
a transaction window, select the template, and click Delete.

Deleting a recurring template only removes it from your list of 
recurring templates. All actual transactions recorded previously 
using the recurring template are not affected.
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 Chapter 9
Paying Your
Employees
Payroll is one area of business that has to be correct every time. Unlike many other areas of 
business where errors can be adjusted at a later date, employees immediately notice errors 
in their paychecks. 

Fortunately, the MYOB AccountEdge payroll system is capable of accurately calculating 
pay for both wage and salary earners. It can calculate overtime rates, union fees and other 
deductions, employer expenses, and accruals such as vacation pay and sick leave, along 
with tax deductions. The system is also capable of paying employees in cash, as well as 
printing attractive paychecks. 

The MYOB AccountEdge payroll system is flexible because it allows you to create an 
unlimited number of wage, accrual, deduction, and expense categories which allows it to 
keep track of payroll amounts for the most demanding businesses. These categories are 
applied to an employee’s pay information to form the default values for the employee’s 
paycheck. If necessary, any default values can be overridden on the paycheck to ensure the 
pay amounts are always correct.

As a rule, the MYOB AccountEdge payroll system is considered suitable for businesses 
with anywhere between one and twenty employees, although larger businesses successfully 
use the MYOB AccountEdge payroll system. 

When you write a paycheck in MYOB AccountEdge, the system automatically updates your 
accounting records and keeps track of employees’ vacation accruals. It also keeps track of 
the payroll taxes due, making your job easier when it’s time to file payroll taxes. And at 
year-end, you can print out W-2 forms for your employees to use at tax time. For more 
information, see ‘Starting a New Payroll Year’ on page 182. 

Remember, if you are concerned about employee privacy, you can always use the security 
features to restrict access to this and other areas of MYOB AccountEdge.
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Creating Payroll Categories
A paycheck normally consists of five elements: wages, accruals, 
deductions, taxes, and employer expenses. Collectively, these 
elements are referred to as payroll categories. Before you begin 
writing paychecks to employees, you must create the payroll 
categories that are used by your business. You must then assign 
each employee the payroll categories that apply to him or her. 
Then, when you pay an employee (in the Pay Employees window), 
the payroll categories you’ve assigned to each employee will 
automatically determine the various amounts that are associated 
with the paycheck. 

If you set up your payroll using the Payroll Easy Setup Assistant, a 
set of payroll categories was automatically created for you. If this 
default set of payroll categories doesn’t fully suit your company’s 
needs, you can create custom payroll categories.

Before you create payroll categories

Before you create payroll categories, you need to have loaded your 
tax tables and set up your general payroll information in MYOB 
AccountEdge. For more information, see ‘Setting up Payroll details’ 
on page 31.

NOTE : Single-user access Please note that the task of creating a 
payroll category requires single-user access. For more information, 
see ‘Tasks that require single-user access’ on page 193.
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Wage Categories

In MYOB AccountEdge, money paid to employees for labor or 
services is referred to as wages. Wages are determined on an hourly, 
salary, or other basis. Some examples of wages are salary, bonus, 
commission, and overtime. In addition, some other forms of 
payment, such as some types of employee benefits, are also 
considered wages for tax purposes, and are referred to as non-cash 
wages. Company car benefits and excess life insurance are 
examples of non-cash wages. 

All types of employee payment, regardless of whether they’re based 
in cash, need to exist in the MYOB AccountEdge system so you can 
pay your employees properly.

To create a Wage category

1 Go to the Payroll command center and click Payroll Categories. 
The Payroll Category List window is displayed. 

2 Click the Wages tab. 

3 Click New. The Wages Information window is displayed. (For 
detailed field help, click Help in this window.)

4 Enter a descriptive name for the wage in the Wages Name field. 

5 Indicate whether the wage is paid on an hourly or salary basis. 

6 If the wage is hourly, enter the rate of pay in the Pay Rate field.

7 Mark the Optional Account checkbox if you want to override the 
wages expense account assigned to each employee in the 
Employee Payroll Information window. Enter a different account 
in the Override Account field.
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8 Mark the Non-Cash Wages checkbox if this wage represents non-
cash wages. 

9 Click Employee to assign this wage to specific employees. The 
Linked Employees window for the wage is displayed. 

10 Mark the Select column for every employee to whom you want to 
assign the wage and click OK. 

11 Click Exempt to indicate from which taxes and deductions this 
wage is exempt. The Wages Exemptions window for the wage is 
displayed. 

12 Mark the Exempt column for the taxes and deductions that should 
be exempted and click OK. 

13 When you complete all entries in the Wages Information window, 
click OK to record the new wage.

Accrual categories

In MYOB AccountEdge, accruals are hours that accumulate on 
paychecks that help you pay special wages, such as vacation pay or 
sick pay. 

When you create an accrual in MYOB AccountEdge, you’ll link it to 
an hourly wage. Whenever you pay that particular hourly wage, the 
accrual hours associated with that wage will be automatically 
decreased by the appropriate amount. For example, if you include a 
week’s worth of vacation pay on an employee’s paycheck, that 
employee’s vacation accrual will be decreased by the number of 
hours in one work week.
User Guide
To create an Accrual category

1 Go to the Payroll command center and click Payroll Categories. 
The Payroll Category List window is displayed. 

2 Click the Accruals tab. 

3 Click New. The Accrual Information window is displayed. (For 
detailed field help, click Help in this window.)

4 Enter a descriptive name for the accrual in the Accrual Name field. 

5 Choose the method by which you want accrual hours to be 
accumulated for this accrual in the Type of Accrual field. 

6 Choose whether you want accrual hours to be carried over to the 
next payroll year. 

7 Enter the hourly wage to which you want to link this accrual in the 
Linked Wages Category field. 

8 Click Employee to assign this accrual to specific employees. The 
Linked Employees window for the accrual is displayed.

9 Mark the Select column next to each employee to whom you want 
to assign the accrual. Click OK when you have finished. 
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10 Click Exempt if you’ve chosen a percentage of Gross Hours or 
Federal Hours as the basis for calculating the accrual. The Accruals 
Exemptions window is displayed. 

11 Mark the Exempt column next to each hourly wage category that 
should be exempt and click OK. 

12 When you have completed all the entries in the Accrual 
Information window, click OK to record the new accrual. 

Deduction categories

In MYOB AccountEdge, deductions are any amounts other than 
taxes that are subtracted from an employee’s gross pay.

To create a Deduction category

1 Go to the Payroll command center and click Payroll Categories. 
The Payroll Category List window is displayed. 

2 Click the Deductions tab. 

3 Click New. The Deduction Information window is displayed. (For 
detailed field help, click Help in this window.)

4 Enter a descriptive name for the deduction in the Deduction Name 
field. 
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5 In the Linked Payable Account field, enter the account you want to 
use to track the amounts withheld for this deduction. 

6 In the Type of Deduction fields, choose the deduction type and 
enter a rate for the deduction, if any. 

7 In the Deduction Limit fields, enter the maximum amount that can 
be withheld for this deduction.

8 Click Employee. The Linked Employees window for the deduction 
is displayed.

9 Mark the Select column for every employee that you want to assign 
the deduction to and click OK.

10 Click Exempt to indicate from which taxes this deduction is 
exempt. The Deduction Exemptions window is displayed. 

11 Mark the Exempt column for the taxes that should be exempt and 
click OK.

12 Click OK to record the new deduction.

Employer Expense categories

In MYOB AccountEdge, employer expenses are your company’s costs 
of having employees. Employer expenses are calculated on 
employees’ paychecks, but they don’t affect the employees’ net 
pay. Instead, they affect the amounts you must contribute to the 
employee (such as pension contributions), to the government, or to 
other institutions.

You can also track the balance of an employer expense for each 
employee and carry over any remaining expense balance to the 
next payroll year.
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To create an Employer Expense category

1 Go to the Payroll command center and click Payroll Categories. 
The Payroll Category List window is displayed. 

2 Click the Expenses tab. 

3 Click New. The Employer Expense Information window is 
displayed. (For detailed field help, click Help in this window.)

4 Enter a descriptive name for the employer expense in the Employer 
Expense Name field. 

5 Enter the accounts you want to use to track the amounts withheld 
by this employer expense in the Linked Expense Account and 
Linked Payable Account fields.

6 Choose the type of employer expense you want to create in the 
Type of Expense field. 

� If you selected Other in the Type of Expense field, choose the 
rate by which this expense is calculated in the Expense Basis 
field. Enter the maximum amount that can be withheld for this 
expense in the Expense Limit field. 
User Guide
� If you selected SUI or SDI in the Type of Expense field, enter 
information in the State Code, State Tax ID and SUI Rate or SDI 
Rate fields. 

7 Click Employee if you want to assign the new employer expense to 
specific employees. The Linked Employees window for the 
employer expense is displayed. 

8 Mark the Select column for every employee you want to assign the 
employer expense to and click OK.

9 If you selected Other in Step 6, click Exempt to indicate which 
wages should not be assigned to this employer expense. The 
Employer Expense Exemptions window for the wage appears. 

10 Mark the Exempt column for the wages that should be exempt and 
click OK.

11 Click OK to record the new employer expense.
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Understanding Payroll Taxes

In MYOB AccountEdge, payroll taxes are amounts that are 
calculated and deducted from employee paychecks according to 
regulations established by government taxation authorities. Payroll 
taxes must be assigned to employees before they can be used on 
paychecks. 

Since tax laws change frequently, it’s important that you use the 
most up-to-date payroll tax amounts and percentages when you 
write your paychecks. To keep your payroll tax calculations up-to-
date, payroll taxes are administered in MYOB AccountEdge by the 
use of special tax tables, which are included in your MYOB 
AccountEdge package. 

To determine the date of the payroll tax tables 

1 Go to the Apple menu and selected About AccountEdge.

Since the accuracy of your payroll records is at stake, you cannot 
add, change or remove any payroll taxes from the tax tables in MYOB 
AccountEdge. However, for a modest fee you can receive the latest 
tables from MYOB automatically, whenever payroll tax laws change. 
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Assigning payroll taxes to employees

Payroll taxes must be assigned to employees before they can be 
used on paychecks. For more information, see ‘To enter payroll 
information’ on page 33.
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Changing or deleting a Payroll Category
You follow similar procedures to edit or delete any of the payroll 
categories. For more specific information, look up the references in 
the two procedures below.

To edit a Payroll Category

� In MYOB Help, choose Payroll > Managing Payroll Categories > 
Changing payroll categories, and then click the appropriate topic:

� ‘To Change a Wage’

� ‘To Change an Accrual’

� ‘To Change a Deduction’

� ‘To Change an Employer Expense’

To delete a Payroll Category

� In MYOB Help, choose Payroll > Managing payroll categories > 
Changing payroll categories, and then click the appropriate topic:

� ‘To delete a Wage’

� ‘To delete an Accrual’

� ‘To delete a Deduction’

� ‘To delete an Employer Expense’
User Guide
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Paying Your Employees
In MYOB AccountEdge, paychecks are transactions that you use to 
pay your employees. Like regular checks, paychecks can affect your 
company’s checking acounts, credit card accounts, petty cash 
accounts, and other cash accounts. Many companies, however, use 
a special payroll checking account from which to pay employees. 

To write a paycheck 

1 Set up employee and payroll information.

2 Select the account for the paycheck.

3 Enter the employee’s name.

4 Review the paycheck information.

5 Distribute vacation and sick pay (optional).

6 Distribute other types of wages (optional).

7 Complete the paycheck.

Step 1: Set up employee and payroll 
information

Creating paychecks in MYOB AccountEdge is a quick and simple 
process—if you’ve taken the time to carefully set up your company’s 
payroll information. 

1 Set up your company’s payroll information – see ‘Setting up Payroll 
details’ on page 31.

2 Create employee cards and payroll categories – see ‘Creating 
Payroll Categories’ on page 120.
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Step 2: Select the account for the paycheck

1 Go to the Payroll command center and choose Pay Employees. 
The Pay Employees window is displayed. 

2 Click the search icon next to the Account field and select the 
checking account that will be used for this check. Only accounts 
you’ve specifically designated as checking accounts or credit card 
accounts are displayed in the list. 

Step 3: Enter the employee’s name

1 Enter the employee’s name in the Employee field or click the search 
icon and select the employee’s card from the Cards List. 

When you enter the employee’s name, MYOB AccountEdge 
automatically calculates all the employee’s wages, accruals, 
deductions, employer expenses, and payroll taxes—collectively 
known as payroll categories—and displays the appropriate amounts 
in the Pay Employees window.

2 Verify that the date, check number, and memo that MYOB 
AccountEdge has automatically generated for this paycheck are 
correct. You can change them if you want. 
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Step 4: Review the paycheck information 

All payroll categories assigned to the employee are displayed in the 
scrolling list in the middle of the window, as shown in the example 
below.

If the employee is paid on an hourly basis, enter the number of 
hours he or she worked for each of the wage categories assigned to 
him or her. The payroll categories’ amounts are calculated 
automatically and displayed in the Amount column of the scrolling 
list.

Carefully review the information displayed in the scrolling list. It’s 
important to make sure that this information is correct before the 
paycheck is recorded. 

If you want to assign the transaction to a particular category, click 
the search icon to select a category from the Category List.

For more information about categories, see ‘Setting up Categories’ 
on page 43.
User Guide
Step 5: Distribute vacation and sick pay 
(optional)

You can distribute vacation or sick pay accrual wages on an 
employee’s paycheck. To do this, you should have already created 
accruals for your employee’s sick or vacation time. See ‘To create an 
Accrual category’ on page 121 for more information.

1 Enter the number of sick or vacation hours in the Hours column of 
the accrual wage.

The amount that appears in the Amount column is calculated 
automatically. When you record the transaction, the hours you 
entered will be subtracted from the number of hours the employee 
has accrued.

2 If you’re distributing wages for an accrual such as sick pay, you may 
also need to change the employee’s regular hourly-wage hours or 
amounts.

Step 6: Distribute other types of wages 
(optional)

You can include other types of pay, such as sales commissions, 
bonuses, or non-cash wages on an employee’s paycheck. To 
perform this step, the wages you intend to pay should already exist 
in MYOB AccountEdge, and should be assigned to the employee. 
For example, if you want to pay a bonus to the employee, a wage 
category called ‘Bonus’ must already exist in MYOB AccountEdge 
and should be assigned to the employee. 

For information on creating a wage category, see ‘To create a Wage 
category’ on page 120. For information on assigning this wage 
category to an employee, see ‘To enter payroll information’ on 
page 33.
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Step 7: Complete the paycheck 

When you have completed all entries in the Pay Employees 
window, there are a number of tasks you can perform with the 
transaction. Review all the options before you choose what you 
want to do.

� Print and record the paycheck. Click Print. The paycheck will be 
recorded before it is printed. For more information on printing 
paychecks, see ‘Printing paychecks’ on page 128. 

� Record the paycheck. To record the paycheck without printing it, 
click Record.

� Store the paycheck as recurring so that you can use it many times 
in the future. Click Save Recurring. In the Save Recurring 
Template window, enter the necessary information and click 
Save Template. (For more information on creating and using 
recurring transactions, see ‘Working with Recurring Transactions’ 
on page 116.)

Printing paychecks 

You can choose to print a paychecks, in the Pay Employees window 
at the time you enter the paychecks, or you can choose to print the 
paychecks, at a later time. You can print and reprint individual 
paychecks, or you can print several paychecks, at the same 
time—the choice is yours. 

For more information on printing paychecks, see the Printing Forms 
chapter on page 151. For detailed information, in MYOB Help, 
choose Payroll> Printing paychecks. 

For information on customizing the look of your printed paychecks, 
see ‘Customizing Forms’ on page 155. 
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Changing, deleting or reversing a paycheck 

Occasionally, you will find it necessary to make a change to a 
paycheck, you’ve already recorded. Unlike most other types of 
transactions in MYOB AccountEdge, once a paycheck, is recorded, 
you can’t change it directly. However, you can change a paycheck, 
if you remove or reverse the entire paycheck, and then write a new 
paycheck, that contains the correct information.

There may be times when you simply want to remove a paycheck. 
When this is the case, you can quickly remove the effects of such a 
transaction from your records. When you remove a recurring 
paycheck, the paycheck,. is removed from your list of recurring 
paycheck, only. Any transactions you recorded using a recurring 
paycheck, you remove will not be affected.

An important point to consider is if the paycheck, is changeable or 
unchangeable. If the transaction is changeable, you can remove the 
paycheck, altogether from your ledger.

Unchangeable transactions work differently. By reversing an 
unchangeable paycheck, the effects of the original will no longer be 
part of your ledger; however, a record of the reversed paycheck, 
called a reversing transaction, will remain. Then, you can enter a 
new, correct transaction to replace the one you reversed.

MORE INFORMATION

� To change the name or frequency of a recurring paycheck, go to 
MYOB Help and choose Payroll > Paying employees >Chaning, 
Removing or Reversing Paycheques > To change a recurring 
Paycheck’s Name and Or frequency. 

� To change a check’s line items and other information, go to 
MYOB Help and choose Payroll > Paying employees > Changing, 
deleting and reversing paychecks > To change a recurring paycheck's 
line items & other information.
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� To delete a check, go to MYOB Help and choose Payroll > Paying 
employees checks > Changing, deleting and reversing paychecks > 
To delete a paycheck.

� To delete a recurring paycheck, go to MYOB Help and follow this 
path Payroll > Paying employees checks > Changing, deleting and 
reversing paychecks > To delete a recurring paycheck.

� To reverse a paycheck, go to MYOB Help and choose Payroll > 
Paying employees checks > Changing, deleting and reversing 
paychecks > To reverse a paycheck.
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Reviewing Payroll Information
Keeping your payroll information up-to-date and accurate is a 
primary concern for all businesses. MYOB AccountEdge contains a 
number of tools that help you gain a quick picture of your payroll 
information. 

� The To Do List provides a quick way to review your transactions 
in MYOB AccountEdge, including recurring checks, recurring 
deposits and other General Journal transactions. 

� �he Analyze Payroll window can help you understand the 
details of your payroll information. It can help you spot possible 
inaccuracies in the amounts you’re paying to and deducting from 
your employees. The Analyze Payroll window will help you 
perform this important task by providing various summaries of an 
employee’s payroll data. 

� With Find Transactions, you can perform a simple as well as an 
advanced search for an account, card, or payroll category. For 
more information, see ‘To find a transaction using Find 
Transactions’ on page 110.

MORE INFORMATION

� To display a list of paychecks, go to MYOB Help and choose 
Payroll > Reviewing your payroll information > To display a list of all 
your paychecks.

� To display a list of recurring paychecks, go to MYOB Help and 
choose Payroll > Reviewing your payroll information > To display a 
list of recurring paychecks.

� To print a list of all paychecks, go to MYOB Help and follow this 
path – Payroll > Reviewing your payroll information > > To print a 
list of all your paychecks.
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� To print a list of recurring paychecks, go to MYOB Help and 
choose Payroll > Reviewing your payroll information > To print a list 
of all your recurring paychecks.

� To analyze the payroll activity, go to MYOB Help and choose 
Payroll > Reviewing your payroll information >> To Analyze your 
payroll activity. 
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 Chapter 10
Billing For

Time

MYOB AccountEdge’s powerful Time Billing feature allows businesses to track employees’ 
and vendors’ time used to complete tasks and services (activities) for clients and customers. 
It also allows businesses to track incidentals incurred in completing the work (items). The 
Time Billing feature is an great solution for many businesses—businesses that 
predominantly sell time, such as accountants and lawyers and businesses that sell both 
time and items such as interior designers and mechanics. 

The Time Billing feature is very flexible. You can establish activity billing rates based on 
the activity itself, such as consulting at $75 per hour and photocopying at 10 cents per copy. 
If you prefer, you can establish activity billing rates based on an hourly charge-out rate for 
a particular employee. For example, the employee John Smith’s hourly consulting rate may 
be $120 per hour, and the subcontractor Acme Industries’ charge out rate may be $150 per 
hour. You can even set an underlying cost to the activity where, for example, you may 
estimate that the hourly cost to employ Smith is $75 per hour, and Acme is $135 per hour.

All MYOB AccountEdge activities can be established as chargeable or non-chargeable. The 
ability to track non-chargeable activities can be very useful for businesses that want to 
record costs such as entertainment, which generally cannot be charged to the customer.

MYOB AccountEdge’s Time Billing makes it easy to enter and collate the activities 
undertaken for customers. The activities can be entered individually or grouped together 
into MYOB AccountEdge’s activity slips. The information can be quickly adjusted to 
generate Time Billing invoices, ready to send to your customers. Any items that you have 
sold to your customers can also be included with the activities in a single Time Billing 
invoice. 

You can view the history of your activities in the Activity Log. You can use the Diary View, 
which gives you the who, what and when of the activity, or the Detail View, which gives you 
details of the amounts that were billed.

Time Billing reports can be extensively filtered to give you the information you want 
included in the reports. These reports are a great management tool, allowing you to closely 
monitor how you and staff spend your time, and whether it is profitably spent.
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Setting Time Billing Preferences
There are three preferences that should be set before you start 
billing for time in MYOB AccountEdge.

� The Special billing unit preference should be set when you want 
to bill units of time of less than an hour. 

� The Rounding preference affects how you want elapsed time to 
be rounded.

� The Include items preference should be set if you want to 
include items for sale on Time Billing invoices. 

Go to the Setup menu and choose Preferences. The System view 
of the Preferences window is displayed. The preferences that apply 
to Time Billing are shown below. Set a preference by marking the 
checkbox next to that preference. 

Special billing units

Special billing units is a useful feature for organizations that need to 
track billable time in special units of one minute, six, ten, twelve, 
fifteen or thirty minutes. The unit of time you specify here will be 
the default billing unit when you create hourly activity slips. For 
example, you can specify six-minute Time Billing units, where an 
hour would be ten billing units of time. Any activity slips you have 
already created will be updated to use the special billing unit of 
time.

NOTE : Unit of Measurement shows as Hourly If you have set 
your preferences to use a special billing unit of time, the unit of 
measurement for all hourly activities will still show as Hour in the 
Activity Information window. This is because the billing unit is still 
based on an hour. Don’t change the Type for your activities from 
Hourly to Non-hourly, because the special billing unit will be used 
when you create an activity slip using an hourly activity.
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Rounding time in Time Billing

Time Billing allows you to set a preference for how you want units of 
time to be rounded when you use the Timer.

Choose to round Up To Next, Down To Previous or To Nearest. 
For example, if you have chosen Up To Next and are using 30 
minute billing units, 10 minutes would be rounded up to 30 
minutes on an activity slip.

If you are not using a special billing unit of time—that is, you are 
billing in hours—you can specify the rounding increment. For 
example, if you want to round the actual time you clock using the 
timer up to the next minute, choose Up To the Next and enter ‘1’ 
in the Minute Increment field. That way, if you clock 21 minutes 
and 32 seconds of an activity, 22 minutes will be entered 
automatically in the Actual Units field.

NOTE : Minute Increment field If you have specified a special time 
billing unit and a rounding rule, the Minute Increment field here is 
redundant and, therefore, is not displayed.

Including items on Time Billing invoices

This preference lets you include items on your Time Billing invoice 
and charge your customers for both activities and items on a single 
invoice. If this preference is marked, the selection list that appears in 
the Sales-Time Billing window includes both your activities and 
items. 

Note that only items for which you have marked the I Sell This Item 
checkbox in the Item Information window will be included in the 
selection list. 
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Setting Billing Rates
You can set billing rates that will automatically be displayed when 
you create an activity slip (you can still override these rates when 
you create the activity slip). The billing rate can be a rate set for the 
customer, the employee or vendor, or for the activity itself.

For example, for an activity such as the time spent photocopying, 
you might use a flat rate for all customers, in which case you would 
use the activity billing rate. For other activities, you might charge 
the customer according to the employee who performed the 
activity, the billing rate depending on factors such as the expertise 
and experience of the employee. 

To set a billing rate for the activity

You can set up a billing rate for each activity, regardless of the 
customer you are billing, or the employee or vendor who 
performed the activity. The billing rate for an activity is set in the 
Activity Information window. See ‘To create an activity’ on 
page 134.

To set a billing rate for customers

You can set up a billing rate for customers in their card. This option 
is useful if you are performing the same activities for multiple 
customers and want to charge each customer at a different rate. 

1 Display the Card Information window for the relevant customer 
and click the Selling Details tab. 

2 Enter the hourly billing rate excluding tax for the card in the 
Customer Billing Rate field and click OK. 

3 Set the activity to use the customer billing rate. See ‘To create an 
activity’ on page 134.
User Guide
To set a billing rate for vendors or employees

You can set a billing rate for an employee or vendor in their card. 
This option allows you to bill an activity at different rates according 
to the employee or vendor performing the activity. You can also 
track the costs associated with having the activity performed. This is 
particularly useful if you are sub-contracting work to a vendor. 

1 Display the vendor’s or employee’s Card Information window. 
Then do the following:

� Vendor cards—click the Buying Details tab.
� Employee cards—click the Billing Details tab and then click 

Time Billing.

2 Enter the hourly billing rate excluding tax for the card in the Vendor 
Billing Rate field or the Employee Billing Rate field. 

3 Enter the hourly cost to you of having this activity performed in the 
Cost per Hour field. 

4 Click OK.

5 Set the activity to use the employee or vendor billing rate. See ‘To 
create an activity’ on page 134.
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Creating Activities
In MYOB AccountEdge terms, the word activity is used to describe a 
task or service provided by your company for which you can track 
costs and bill customers on Time Billing invoices. Activities are 
primarily defined by their type—hourly or non-hourly—and by their 
status—chargeable or non-chargeable. 

To create an activity

1 Go to the Time Billing command center and click Activities List. 
The Activities List window is displayed. 

2 Click New. The Activity Information window is displayed. 

3 In the Profile view, enter an Activity ID and Activity Name.

4 Enter a description of the activity. Mark the Use Description on 
Sales checkbox if you want the description of the activity to appear 
in the Sales-New Time Billing window instead of the activity name. 
For detailed field help, click Help. 

5  Specify the type (Hourly or Non-hourly) and status (Chargeable or 
Non-chargeable) of the activity by selecting the appropriate radio 
buttons. If it is:

� an hourly, chargeable activity, choose the billing rate you want 
to use. The rate is the price you charge for one unit of the 
activity. You can 

-   use the rate you set up in the employee or vendor card, 
-   use the rate you set up in the customer card, or
-   specify a rate for this activity only. Enter the rate in the 

Activity Rate field.
� an hourly, non-chargeable activity, go to Step 7.
� a non-hourly, chargeable activity, enter a unit of measurement 

in the Unit of Measurement field and activity rate in the 
Activity Rate field.
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� a non-hourly, non-chargeable activity, specify the unit of 
measurement in the Unit of Measurement field and then go 
to Step 7.

The default Unit of Measurement for hourly activities is Hour. If you 
specified a special billing unit of time in the System view of the 
Preferences window, this field will still display as Hour, but time will 
be billed according to the special billing unit.

6 In the Income Account field, specify the account you want to use to 
track the income you receive for this activity. 

7 Mark the Taxable when Sold checkbox if this activity is taxable.

8 Complete the record. If this is:

� a chargeable activity, you can either 
-   edit the history of the activity (click the History tab and click 

the Help button in that window for more information), or
-   complete the record by clicking OK. The new activity will now 

be listed in the Activities List window.
� a non-chargeable activity, click OK. The new activity will now 

be listed in the Activities List window.

To change, inactivate or delete an activity

To change details of an activity, see ‘Changing a Record’ on 
page 105.

To inactivate an activity, see “Inactivating/Reactivating a Record” 
on page 107.

To remove an activity from your records, see ‘Deleting a Record’ on 
page 106.
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Creating Activity Slips
Activity slips are used to record activities performed for a customer 
and forms the basis for the bills you send your customer. You can bill 
the full amount for the activity, or bill part of it, leaving the balance 
for a later date.

Time Billing gives you two options for creating an activity slip: 

� creating a single activity slip, which allows you to enter the most 
detail about the activity slip, or 

� creating multiple activity slips, which allows you to enter multiple 
activity slips at once for an employee, while not entering quite as 
much detail for each.

When you create an activity slip, you can enter two cards: one for 
the employee or vendor who performed the activity for your 
company, and the other for the customer for whom your company 
performed the activity. If you’re creating an activity slip for a 
chargeable activity, you must enter both cards. 

To create a single activity slip

1 Go to the Time Billing command center and click Enter Activity 
Slip. 

2 In the Single Slip Entry view, enter details about the activity, such 
as the name of the employee who performed the activity, the name 
of the customer for whom the activity was performed, the activity 
User Guide
ID number and the number of units to be charged. Click Help for a 
detailed description of the fields in this window. 

3 Enter any adjustments in the Adjustment fields: enter the number 
of units of the adjustment in the first field. You can override the 
amount of the adjustment that automatically appears in the 
adjacent field. 

You can enter adjustment units or amounts as negative numbers if 
you want to indicate fewer hours or a lesser amount.

4 Enter any already billed amounts. If you have partially billed the 
customer on an invoice for this activity, enter the number of units 
already billed, in the first Already Billed field. (You can override the 
amount that appears in the adjacent field.) Your entry is subtracted 
from the Billable units and amount. The total units and amount 
that haven’t been billed yet appear in the Left to Bill fields.
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NOTE : Billing an activity In MYOB AccountEdge, “billing” an 
activity slip means recording a Time Billing invoice for the activity 
slip. If you enter units or an amount in the Already Billed fields of 
the Enter Activity Slip window, the amount won’t appear in the 
Sales Journal or in the activity’s history, but is only recorded for the 
activity slip.

5 Click Record. The activity slip is now recorded and will appear on 
reports. If you entered a chargeable activity on the activity slip, it 
will be available for billing in the Prepare Time Billing Invoice 
window. 

Note that you can record an activity slip by changing views. If you 
click the Multiple Slip Entry tab while creating an activity slip and 
you’ve entered the minimum required information in the Single 
Slip Entry view, the activity slip will be recorded before the new tab 
is displayed.

To create a single activity slip using the timer

The Enter Activity Slip window has a timer feature which allows 
you to record the time you spend performing an activity. When you 
have completed the activity, the information is already in the Enter 
Activity Slip window, eliminating unnecessary duplication of data 
entry. The timer is displayed on activity slips for hourly activities 
only.

To use the timer, you must leave the Enter Activity Slip window 
open until completion of the activity. You can still use other 
applications or other windows in MYOB AccountEdge during this 
time.

1 Go to the Time Billing command center and click Enter Activity 
Slip. The Enter Activity Slip window is displayed.

2 Enter the required details of the activity slip such as the date, 
customer name and activity name. Click Help for detailed field help.

3 Click Start to start the timer. If you haven’t entered a start time in 
the Start Time field, your computer’s current system time appears, 
and the timer begins ticking in the Elapsed Time field.
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NOTE : Entering a start time before current system time If 
you’ve entered a start time that is before the current system time, 
the difference will be added to the elapsed time measured by the 
timer. For example, if you entered 8:00 a.m. in the Start Time field 
and then clicked Start at 9:00 a.m., 1:00:00 will be displayed in the 
Elapsed Time field and the time calculated by the timer will be 
added to that amount.

4 Leave the Enter Activity Slip window open as you perform the 
activity; this allows the timer to track the time you’ve worked in the 
Elapsed Time field.

5 Click Stop to stop the timer when you have completed the activity 
or want to pause the timer. The current system time appears in the 
Stop Time field. The elapsed time is entered automatically in the 
Units field. 

You can edit the start and stop times if you want. The entries in the 
Actual Units and Elapsed Time fields will be updated 
automatically.

You can round your timer entries in the Actual Units field 
automatically. See ‘Rounding time in Time Billing’ on page 132.

6 If you want to resume timing an activity, click Start again. The entry 
in the Stop Time field will be cleared. The timer will continue 
incrementing, starting from your current elapsed time.

7 Click Record to record the timed activity when you have completed 
it.

To reset the timer

Click Clear at any time to clear the Elapsed Time, Start Time and 
Stop Time fields and set the Units field to zero.
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To create multiple activity slips

In addition to being able to create single activity slips in Time 
Billing, you can also create multiple activity slips together. In the 
Multiple Slip Entry view of the Enter Activity Slip window, one 
line in the list represents one activity slip. Although this view allows 
you to enter a little less detail on the activity slip, you can still view 
any activity slip in the Single Slip Entry view and enter more detail 
at a later stage.

1 Go to the Time Billing command center and click Enter Activity 
Slip. The Enter Activity Slip window is displayed. 

2 Click the Multiple Slip Entry tab. (For detailed field help, click 
Help.)

3 Enter the name of the employee (or vendor) performing the activity 
in the Employee field. Any historical activity slips you have created 
for the employee/vendor are listed, each line representing a single 
activity slip.

4 On the first blank line, enter details of the activity slip you want to 
create.

5 Press TAB or click Record to record the activity slip and move the 
insertion point to the next line, where you can begin creating a new 
activity slip for the employee (or vendor) you entered in the 
Employee (or Vendor) field.

NOTE : Activity slips are recorded as you create them, on a line 
per line basis Once you have entered an activity slip and pressed 
TAB to move to the next line, the activity slip is recorded. If you click 
Cancel after moving to the next line, the first activity slip is still 
recorded. A white zoom arrow displayed beside an activity slip 
indicates that the activity slip has been recorded. 
User Guide
6 Follow Step 4 and Step 5 for each activity slip you want to create. 
When you’ve entered and recorded all the activity slips you want to 
create, click Cancel to close the window.
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Working with Activity Slips
If you record many activity slips, it’s likely that you will want to 
review, make changes to or delete an activity slip at some point. 
Follow the relevant set of instructions below. 

To find and review an activity slip

1 Go to the Time Billing command center and click Activity Log. The 
View Activity Log window is displayed. 

2 Enter the name of the employee or vendor who performed the 
activity and, if you know it, the date range within which the activity 
was recorded. All activities that fit the criteria are listed. 

3 Click the Diary View tab and the Detail View tab to display 
different types of information about the activity slip. Click the zoom 
arrow next to an activity slip to view the activity slip in the Enter 
Activity Slip window. 
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To change an activity slip

1 Find the activity slip in the View Activity Log window and click the 
zoom arrow next to the activity slip you want to change.

2 Make the required changes either in the Single Slip Entry view or 
the Multiple Slip Entry view and click OK or Record.

To delete an activity slip 

You can only delete an activity slip that has not been billed yet. 

1 Find and select the activity slip you want to delete in the View 
Activity Log window (see ‘To find and review an activity slip’). 

2 Go to the Edit menu and choose Delete Activity Slip.
Creating Time Billing Invoices

There are two ways of creating a Time Billing invoice in MYOB 
AccountEdge:

� In the Prepare Time Billing Invoice window. This is the 
recommended way, because full details of activities and activity 
slips are recorded. See below. 

� In the Sales window. Use this method if you don’t need to record 
details of activities and activity slips or track work in progress. See 
‘To create a Time Billing invoice in the Sales window’ on 
page 140.

To create a Time Billing invoice

The Prepare Time Billing Invoice window allows you to enter and 
adjust the billing information for activity slips just as you would in 
the Enter Activity Slip window. As you make changes in the 
Prepare Time Billing Invoice window, your activity slip records are 
updated automatically.

1 Go to the Time Billing command center and click Prepare Time 
Billing Invoice. 

2 Highlight the customer for whom you want to create a Time Billing 
invoice and click OK. The Prepare Time Billing Invoice window is 
displayed, listing all the open activity slips for the selected customer.

3 Prepare the invoice.
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4 Click Prepare Invoice. The Sales-New Time Billing window 
displays the details of the Time Billing invoice.

You can enter items on this invoice only if you have set the Include 
items preference. See ‘Including items on Time Billing invoices’ on 
page 132.

A Filters Use these filters to find the required activity slip(s). 
Click Help for a description of these fields. 

B Bill Enter the amount or number of hours you want to 
bill for each activity slip here. Any activity slip with 
0.00 units or 0.00 in the Left to Bill column is 
considered billed in full.

C Adjustment Enter any adjustments you want to make for each 
activity slip here.

D Print Options Mark the relevant checkbox if you want to:

• Sort activity slips according to job number.

• Consolidate all activity slips with the same 
activity and job number on the invoice.

• Print the activity slip notes on the invoice.

B

A

D

C

User Guide
5 If you are selling items on this invoice, enter the following details for 
each item: 

� Enter the date in the Date field.
� Enter the quantity being sold in the Hrs/Units field.
� Enter the item number in the Activity field or press TAB and 

select the item from the list of items and activities that is 
displayed. 

� Enter the price of the item in the Rate field. 

Enter the job number and mark the Tx column if the activity is 
taxable. If you want to group and subtotal the items and activities 
separately on the invoice, you can do so by inserting headers, blank 
lines and subtotals as shown below. For more information, see 
‘Adding lines, subtotals and headers to invoices’ on page 63.

6 Enter additional information about the sale, such as the salesperson, 
referral source and shipping. For detailed field help, click Help. 

7 If you want to assign the transaction to a particular category, click 
the search icon to select a category from the Category List.

For more information about categories, see ‘Setting up Categories’ 
on page 43.

8 Decide what you want to do with the invoice. 

� Record the invoice. Click Record to record the invoice but print 
it later. 

� Print and record the invoice. Click Print. For more information 
about printing invoices, see the Printing Forms chapter on 
page 151.

� Save the invoice as a recurring template 
Click Save Recurring. Enter the necessary information about 
the template in the Save Recurring Template window and 
click Save Template. For more information about recurring 
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transactions, see ‘Working with Recurring Transactions’ on 
page 116.

NOTE : Saving Time Billing invoices as recurring You can save 
Time Billing invoices as recurring invoices, but no activity slips will 
be created when you use the recurring sale in the future. Recording 
the recurring sale also won’t update the activity slips you used to 
create the invoice in the Prepare Time Billing Invoice window. 

To create a Time Billing invoice in the Sales window

1 Go to the Sales command center and click Enter Sales. The Sales 
window is displayed.

2 Click Layout and select the Time Billing layout. 

3 Choose the customer you want to invoice in the Customer field.
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4 In the scrolling list, enter the following details for each activity that 
you are billing the customer: 

� Enter the date the activity was performed.
� Enter the number of units or hours being billed in the 

Hrs/Units field.
� Enter the activity name or press TAB in the Activity field and 

select the required activity from the list. 
� Enter the rate charged for a single unit or hour of the activity in 

the Rate field.
� Enter the job number and category if required.
� Mark the Tx column if the activity is taxable.

5 If you are selling items on this invoice, enter the details of each item 
in the scrolling list. Complete this step and the rest of the invoice 
following step 5 ‘To create a Time Billing invoice’ (see page 139).
Tracking Work in Progress
Work you’ve done for your clients that you haven’t billed yet is 
called work in progress. 

In MYOB AccountEdge, work in progress is represented by activity 
slips for chargeable activities you haven’t yet included on Time 
Billing invoices. Any activity slip that doesn’t have 0.00 or 0 units 
left to bill is considered work in progress. 

When you bill your clients on Time Billing invoices, your accounting 
records will reflect the sales transactions for the activities you’ve 
performed. However, from an accounting perspective, some 
accountants consider that your clients owe you for your work in 
progress, even if you haven’t yet billed your clients for it.
To adjust your accounting records to reflect work in 
progress

Activity slips are MYOB AccountEdge’s records of work in progress, 
but they don’t automatically reflect the value of your work in 
progress. Accounting entries are assigned to your linked accounts 
automatically only when activity slips are billed on a Time Billing 
invoice. If your work in progress routinely represents a significant 
amount of money, you should consider adjusting your accounting 
records to reflect it. 

For detailed instructions on how to adjust your books to reflect work 
in progress, in MYOB Help, choose Time Billing > Creating and 
managing activity slips > Tracking work in progress on your balance 
sheet > To adjust your books to reflect work in progress. 
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 Chapter 11
Recording

International
Transactions
In MYOB AccountEdge, you can enter transactions in a number of currencies in addition 
to your home currency, the U.S. dollar. The multicurrency features make it easy to record 
transactions in dollars, pounds, euros, yen or any other currency you use when buying and 
selling goods and services. MYOB AccountEdge also makes it easy to track overseas 
checking accounts and foreign assets and liabilities. 

If you deal in multiple currencies, it’s also important to track the effects of currency 
exchange rates on your business. MYOB AccountEdge provides detailed reports to help you 
manage both unrealized gains and losses (potential changes in the value of overseas 
transactions) and realized gains and losses (the actual changes in the value of your assets, 
liabilities and equity that occur when you exchange foreign currency for U.S. dollars).

Multicurrency is optional; if all your business is conducted with customers and vendors in 
the United States using dollars, there’s no need for you to take advantage of this feature. If 
you do want to use multicurrency, you need to mark the I Deal in Multiple Currencies 
option in the System view of the Preferences window.

You’ll also have to perform a number of setup steps, which are described in this chapter. 
For example, you’ll have to set up special accounts to track the transactions you make in 
each currency. If you plan to make sales in pounds, for instance, you’ll need to create a 
separate Accounts Receivable account for your sales to customers in the United Kingdom. 
Every foreign currency account you create will require a companion account known as an 
exchange account to track changes in the value of the transactions assigned to the 
account. Only Balance Sheet accounts—asset, liability and equity accounts—can be 
assigned a foreign currency. All other types of accounts are tracked using U.S. dollars.

Your local currency, the U.S. dollar, is set up automatically for you. As this currency is used 
to determine the value of all other currencies, it can’t be deleted, and its exchange value is 
fixed at 1. Before you begin entering transactions, you’ll also need to specify the proper 
currency for all your overseas customers and vendors. Only one currency can be used for 
each customer or vendor (unless you choose to set up multiple cards for them); this ensures 
that your records remain accurate, and it speeds up the task of entering transactions. 
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You must complete a number of steps before you begin recording 
multicurrency transactions in MYOB AccountEdge. Once setup is 
complete, you’ll enter multicurrency transactions the same way you 
enter transactions based on U.S. dollars.

Step 1: Select the multicurrency option

1 Go to the Setup menu and choose Preferences. The Preferences 
window is displayed. 

2 Mark the I Deal in Multiple Currencies (System-wide) checkbox 
in the System tab. 

Note that you cannot clear this checkbox once it has been selected. 

3 Click OK.

Step 2: Set up records for foreign currencies

MYOB AccountEdge provides you with records for several 
commonly used foreign currencies as well as your local currency. 
The following currencies have been set up for you already: 

United States dollar, Canadian dollar, European Union Euro, Great 
Britain pound, Australian dollar, Hong Kong dollar, Japanese yen 
and New Zealand dollar.

If you do business in any other currency, you’ll need to create a new 
record for the currency. Enter its current exchange rate and indicate 
how you want amounts in that currency to be displayed. Follow the 
instructions below. 

1 Go to the Lists menu and choose Currency List. The Currency List 
window is displayed. 

2 Click New. The Currency Information window is displayed. 

3 Enter details of the currency, such as a code, name, and current 
exchange rate. For detailed field help, click Help in this window. 
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Step 3: Create accounts to track foreign-
currency transactions

In order to track transactions in a foreign currency properly, you 
must create a number of accounts that are set up to use that 
currency rather than U.S dollars. You cannot simply use the same 
accounts you use for your U.S dollars transactions because the 
dollar and other currencies rarely trade at par with one another 
(that is, one dollar rarely buys exactly one monetary unit in any 
other currency).

NOTE : Foreign currency accounts automatically linked For every 
foreign currency account you create, MYOB AccountEdge will 
automatically create a linked exchange account. For example, if you 
create a Yen checking account, a Yen Exchange account will be 
created automatically. MYOB AccountEdge uses these ‘dual 
accounts’ so that both the foreign currency amount and the local 
currency equivalent of a transaction can be viewed in your Balance 
Sheet.

Note that you can let MYOB AccountEdge create the linked 
Exchange account for you or you can specify one yourself. To create 
an account, see ‘To add new accounts to your Accounts List’ on 
page 103. You will need to select the correct currency and 
exchange account in the Account Information window. 

Before you create an account, however, we suggest you review the 
following sections to get an understanding of the accounts you 
need to create. 

If you make foreign sales Here’s a list of the accounts you’re likely 
to need if you accept payment from customers in a foreign 
currency. Exchange accounts are also required for each of these 
accounts. 

� Asset account for tracking receivables (for instance, “Accounts 
Receivable-New Zealand”). This account must be assigned the 
foreign currency and not the U.S.dollar.
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� Checking account where customer receipts in the foreign 
currency will be deposited. This can be a U.S. funds account if 
your bank accepts deposits in other currencies.

� Liability account for deposits received (if you allow customers to 
make deposits on orders). This account can be assigned the 
currency code for either the foreign currency or the U.S.dollar.

NOTE : Grouping with undeposited funds Only receipt 
transactions which are in U.S. currency may be grouped as a deposit 
of undeposited funds. Also, you may only use a U.S currency 
account as the linked account for undeposited funds. 

If you make foreign purchases Here’s a list of the accounts you’re 
likely to need if you make payments to vendors in a foreign 
currency. Exchange accounts are also required for each of these 
accounts.

� Liability account for tracking payables (for instance, “Accounts 
Payable-Hong Kong”). This account must be assigned the foreign 
currency and not the U.S. dollar.

� Checking account that will be used to pay debts in a foreign 
currency. This can be a U.S. funds account if your bank writes 
checks for you in other currencies.

� Asset account for deposits paid (if you make deposits on orders). 
This account can be assigned the currency code for either the 
foreign currency or the U.S. dollar.

� Liability account for import duties collected (if you’re required to 
pay duty on goods you import). This account can be assigned the 
currency code for either the foreign currency or the U.S. dollar.

If you track unrealized gains and losses If you plan to track 
unrealized gains and losses, you need to create an income account 
for this purpose. You may want to name it “Unrealized Currency 
Gain/Loss” or something similar. We recommend that you consult 
your accountant to determine whether your business needs to track 
unrealized gains and losses and, if you do, the most appropriate 
User Guide
way for you to do so. See ‘Tracking Currency Gains and Losses’ on 
page 146 for more information. 

Depending upon your business, you may need to create additional 
accounts to track foreign checking accounts, assets held overseas 
and the like. If you’re unsure about the accounts you’ll need, your 
accountant or a MYOB Certified Consultant can assist you with this 
task.

Step 4: Assign accounts to foreign currencies

1 Go to the Lists menu and choose Currency List. The Currency List 
window is displayed.

2 Click the zoom arrow next to the currency to which you want to 
assign accounts. The Currency Information window is displayed.

3 Select the required tab. Click: 

� the Receivable Accounts tab if customers pay you in this currency.

� the Payable Accounts tab if you pay vendors in this currency.

4 Enter the relevant accounts in the appropriate fields. In the bottom 
section of the window, mark the options that apply to your 
business. As you mark options, additional fields will appear, and you 
can enter the accounts you’ll use to track various parts of your 
transactions, such as freight, deposits and discounts. For detailed 
field help, click Help in this window. 

5 Repeat this procedure for each currency for which you want to 
assign accounts.
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Step 5: Assign appropriate currencies to 
foreign customers and vendors

The currency used to make a transaction is determined by the 
currency assigned to the customer or vendor card you are using. 

A card can only use a single currency; so if you deal with a customer 
or vendor in multiple currencies, you will need to create a separate 
card for each currency. 

NOTE : A card with transactions You can’t change the currency of 
a card that you have already used in transactions. You will need to 
create a new card for the customer or vendor. 

You can link any type of card to a currency. Any transactions 
recorded for a card must be in the currency linked to the card. 

1 Go to the Card File command center and click Cards List. The 
Cards List is displayed.

2 Click the zoom arrow next to the required card to display the Card 
Information window. Make sure the Profile tab is selected.

3 Enter the currency you want to assign to the card in the Currency 
field. (The local currency is selected by default.) Click the search 
icon to make a selection from the currency list.

4 Click OK. Repeat this procedure for each card that you want to 
assign a foreign currency. 
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Creating Multicurrency Transactions
Once you’ve set up your currencies, you can begin entering 
transactions for them. Entering these transactions is easy—they’re 
just like standard transactions in U.S. dollars.

Multicurrency transactions can be recorded in the following areas in 
MYOB AccountEdge: 

� Sales, Receive Payments, and Settle Returns & Credits

� Purchases, Pay Bills, and Settle Returns & Debits

� Spend Money, Receive Money, Reconcile Accounts and General 
Journal entries.

Note that multicurrency is not available for Payroll, Inventory or 
Time Billing functions.

Specifying the exchange rate for a transaction

When entering a transaction, you can either use the default 
exchange rate for the currency or enter a new rate for that 
transaction, which will override the default. 
User Guide
To change the default exchange rate

1 Calculate the exchange rate first using the Currency Calculator. See 
‘Using the Currency Calculator’ on page 148.

2 Click Exchange Rate at the bottom of the transaction window. The 
Exchange Rate window is displayed.

3 Enter the new exchange rate in the Transaction Exchange Rate 
field. 

This will only affect the transaction that is currently displayed.

If you want to change the exchange rate for all future transactions 
that use this currency, mark the Update Current Exchange Rate in 
the Currency List with Transaction Exchange Rate checkbox.

4 Click OK.
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Tracking Currency Gains and Losses
Whenever you have a foreign bank account, changes in the 
currency exchange rates between that country and your home 
country can cause the value (as stated in your home currency) of 
your foreign bank account to fluctuate. When your local currency 
weakens relative to the foreign currency, the value of your foreign 
account increases, creating a currency‘gain.’ When your local 
currency strengthens, your foreign account experiences a ‘loss’ in 
value. Multicurrency can track these fluctuations.

Gains or losses in the value of a foreign account are considered 
unrealized while the money is still sitting in the foreign account. 
When the money is withdrawn from the account, either by using it 
to pay for a purchase or by converting it to local currency, the gain 
or loss is considered realized.

Tracking realized currency gains and losses

Realized currency gains and losses are tracked differently in MYOB 
AccountEdge. For realized gains or losses on sales and purchases, a 
posting is automatically made to the Currency Gain Loss account, 
whereas for realized currency gains and losses on 
transfers—deposits and withdrawals—you need to make a General 
Journal entry to the Currency Gain Loss account to record the 
currency gain or loss.

When you activate multicurrency in MYOB AccountEdge, a 
Currency Gain Loss account is automatically created.

NOTE : Large foreign currency exposure If you have a large 
foreign currency exposure, you may require a more detailed analysis 
than posting to a single Realized Gains/Losses account provides. In 
this case, we recommend that you consult your accountant for 
further advice about managing your foreign currency exposure.
Chapter 11 Recording International Transactions146
Sales & Purchases

At the time a currency gain or loss is realized, that is, a payment is 
received or made, an automatic posting is made to the Currency 
Gain Loss account and to the exchange account for the foreign 
currency.

The Currency Realized Gain/Loss report lists the currency gains and 
losses that have been automatically posted through sales and 
purchases during the month for foreign currency transactions.

EXAMPLE

Say you sell goods for $145 U.S. at an exchange rate of 1.45 dollars 
to the pound to a British customer. MYOB AccountEdge records the 
sale at $145 and records the £100 owed by the British customer. 
Using MYOB AccountEdge’s dual accounting system, $100 is 
posted to the British receivables account (which is actually $100 on 
the Balance Sheet), $45 to the British receivables exchange account 
and $145 to the sales account. 

In the following month, the British customer pays their account by 
depositing £100 into your London Checking account, but the 
exchange rate has changed from 1.45 to 1.3. dollars to the pound. 
The deposit is valued at $130. 
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You originally made a sale that at the time was worth $145. When 
you received payment, it was worth only $130. Therefore the $15 
difference is a realized currency loss, and will be posted to the 
British Receivables exchange account.

Transfers

Currency gains and losses that occur through the transfer of funds 
need to be recorded by a General Journal entry.

At the end of the month, you can look at the value of your foreign 
accounts and use MYOB AccountEdge’s Currency Calculator (from 
the Help menu) to calculate their ‘true’ values in local currency at 
that time. 

You can then create a General Journal entry where losses are posted 
as credits to the exchange account with a corresponding debit to 
your Currency Gain Loss account. Gains are posted as debits with a 
corresponding credit to your Currency Gain Loss account

EXAMPLE

Say the original balance in your London Checking account is zero; 
then you transfer $145 U.S. at an exchange rate of 1.45 dollars to 
the pound into your London Checking accoount. The $145 is 
converted to £100 and deposited it into your London Checking 
account. Using its dual account system, MYOB AccountEdge posts 
$100 to the London Checking account (which is shown as $100 on 
the balance sheet), and $45 to the London Checking exchange 
account.

The following week you withdraw that £100 from the bank at an 
exchange rate of 1.4 dollars to the pound. MYOB AccountEdge 
User Guide
values the withdrawal at $140. You put £100 into the account that 
at the time was worth $145. When you withdrew the £100 from the 
account, it was worth only $140. Therefore, the $5 difference is a 
realized currency loss.

If you looked at your Balance Sheet, you would see a zero value for 
the London Checking account, but $5 remaining in the London 
Checking exchange account. You need to post the $5 in the 
exchange account to your Currency Gain Loss account.

Unrealized currency gains and losses

An unrealized gain or loss is a potential gain or loss at any point in 
time between the recorded sale or purchase and the receipt/issuing 
of payment. No automatic postings are made to track unrealized 
gains or losses on foreign currency transactions.

Not all businesses need to track unrealized currency gains or 
losses—you should check with your accountant to determine 
whether or not your business needs to track them.

The Currency Unrealized Gain/Loss report lists the gain or loss 
made on each foreign currency. You can then use this information 
to make adjusting postings to each of your foreign currency 
accounts for your Balance Sheet and also to a Profit & Loss account.
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Working with Multicurrency
Using the Currency Calculator

If you receive a payment for a foreign currency invoice in your local 
currency, you can use MYOB AccountEdge’s Currency Calculator to 
quickly calculate the exchange rate based on the foreign and local 
amounts, or to calculate the foreign amounts based on the local 
amounts and the exchange rate.

You can access the Currency Calculator from any window in MYOB 
AccountEdge. Go to the Help menu and choose Currency 
Calculator. Click Help for help on using the calculator.

Reconciling accounts containing foreign 
transactions

When you are reconciling your bank statement, the foreign 
currency transaction amounts listed in your statement will often not 
match those listed in MYOB AccountEdge. This is because the 
exchange rate used by the bank is different from that used in MYOB 
AccountEdge at the time of the transaction. 

There are two methods by which you can allow for this:

� If you have your security preferences set to allow records to be 
changed, simply click the zoom arrow for the transaction in the 
Reconcile Accounts window to zoom to the original transaction. 
Click Exchange Rate and change the exchange rate to match the 
bank statement.

� If you have the security preferences set not to allow changes to 
records, just click the zoom arrow next to the transaction, choose 
Reverse Check Transaction from the Edit menu, and re-enter 
the check with the correct exchange rate.
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Multicurrency reports

There are three specific multicurrency reports, which are accessed 
from the Accounts tab of the Index to Reports window:

� The Currency List report, which lists all your currencies with their 
currency code, currency symbol and current exchange rate. 

� the Currency Realized Gain/Loss report, which displays realized 
gains or losses on transactions per account. 

� the Currency Unrealized Gain/Loss report, which displays 
unrealized gains or losses on transactions per account.

Transferring funds to a foreign account

You may want to transfer funds from a local currency account to a 
foreign account. This is easily done in MYOB AccountEdge through 
the Spend Money window.

1 Display the Spend Money window.

2 In the Account field, enter the local currency Checking account 
from which the check is being written.

3 Click Currency and choose the (foreign) currency of the account in 
which you want to make a deposit.

4 Enter the date, amount, payee, memo and check number.

5 In the Account # (or Name) field in the scrolling list, enter the 
account to which you want to allocate the transaction and record 
the transaction.
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Entering foreign currency transactions in a 
local account

In MYOB AccountEdge, you can enter foreign currency transactions 
in a local currency account. For example, you can accept a check 
from a British customer in pounds and bank it in an a U.S. checking 
account.

EXAMPLE

Let’s look at an example of how to accept a foreign currency check 
into a local currency account. Our example uses British pounds. 
Let’s also assume the exchange rate has changed from 1.45 to 1.6 
since you made the original sale. 

1 Display the Receive Payments window. 

2 Select the customer. The currency for this customer card is British 
pounds; so the currency button displays GBP. You have received a 
check from your customer for £5,000 for an outstanding invoice 
and you want to bank it in your U.S. checking account. 

3 Process the customer payment in the usual way, but make sure you 
enter your U.S. checking account in the Deposit to Account field.

4 Click Exchange Rate to check the default currency rate for the 
British pound to the U.S. dollar. Change the rate from the default 
rate of 1.45 to 1.6 and click OK. 

5 Enter £5,000 in the Amount Received field and allocate it to the 
outstanding invoice.

6 Record the payment.
User Guide
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 Chapter 12
Printing

Forms

In MYOB AccountEdge, the term ‘form’ refers to the printed documents you give clients, 
vendors, and employees. This includes invoices, statements, packing slips, bills, checks, 
and mailing and shipping labels.

MYOB AccountEdge uses a system of sophisticated filters to locate the forms you may need 
to print or reprint. For example, you can choose to print only unpaid and unprinted service 
invoices within a particular date and invoice number range. MYOB AccountEdge also 
gives you the ability to print forms as you enter your transactions. Simply click Print when 
entering checks, invoices, bills, etc., and MYOB AccountEdge will print your transaction 
using your previously selected form.

The appearance of forms can be extensively customized to suit your own purposes. The 
most commonly customized forms are invoices and statements, but checks, bills and 
labels can also be customized. You can change the size of the form, print multiple forms 
on a single page, change fonts, move fields, create text fields and add your own logos and 
graphics to forms. You can also create multiple forms of one type. You might, for example, 
create one invoice with your logo and another without it.

This chapter gives you detailed instructions about printing and customizing your forms. 
The process is very similar to that used by drawing and database applications.

You should be aware that your forms are stored within their own Forms folder within the 
MYOB AccountEdge folder. This allows you to share forms among your company files and 
easily transfer them from one computer to another. 
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Finding Forms
Each MYOB AccountEdge form can be found in the command 
center in which the form’s associated transaction was entered. 

BANKING COMMAND CENTER

SALES COMMAND CENTER

Type of form To find the form, click:

Checks Print Checks

Type of form To find the form, click:

Sales (item, service, time billing and professional) Print Invoices

Packing slips (item, service and professional) Print Invoices

Labels (item, service, time billing and 
professional)

Print Invoices

Statements (invoice and activity) Print Statements
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PURCHASES COMMAND CENTER

PAYROLL COMMAND  CENTER

CARD FILE  COMMAND CENTER 

Type of form To find the form, click:

Purchases (item, service and professional) Print Purchase Orders

Checks (payable) Print Checks

Type of form To find the form, click:

Paychecks Print Paychecks

Type of form To find the form, click:

Mailing labels Print Mailing Labels

Personalized letters Create Personalized Letters
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Printing Forms
Before you begin printing any forms, make sure your printer is set 
up properly. See ‘Preparing to Print Reports and Forms’ on 
page 170 for more information. 

Once you’ve found the form you want to print, you’re ready to 
make some decisions about how to print it. In general, there are 
four steps you need to follow to print a form:

� ‘Choose the information you want to print’ below.

� ‘Choose a form layout’ below.

� ‘Review the forms you’ve selected for printing’ on page 154.

� ‘Print the forms’ on page 154.

Step 1: Choose the information you want to 
print

Display the Forms Selection window for the form you want to 
print. This window varies slightly, depending upon the kind of form 
you want to print.
User Guide
In the top portion of the Forms Selection window, choose the 
various elements that you want to appear on your forms, including 
the type of information you want to print, the status of the 
transactions you want to print, and the date range and transaction 
numbers that apply to the form you plan to print. 

Step 2: Choose a form layout

The bottom section of the Forms Selection windows allows you to 
choose the layout you want to use when you print your forms. A 
number of layout choices are available, depending upon the type of 
form you’re currently working with.

� Select the pre-printed form layout if you want to print a form’s 
information onto paper that already contains lines, columns and 
headings. The pre-printed layout is designed to match most 
commonly used forms provided by third-party forms vendors.

� Select the plain paper form layout if you want to print a form’s 
information onto blank paper. Lines, columns and headings are 
automatically printed with the form’s information. 

� Select a user-customized form layout if you want to print a form 
you’ve customized using the Customize window. See ‘Adding 
Elements to a Form’ on page 157 for more information about 
MYOB AccountEdge’s forms-customization tools.
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Step 3: Review the forms you’ve selected for 
printing

Before you begin printing, you can to review the information that 
will be printed on your forms. 

� Click OK in the Forms Selection window. The Review Before 
Printing window is displayed, with the information that fits the 
criteria you specified in the Forms Selection window.

A Print column A transaction is marked for printing when a mark 
appears next to it in this column. If you don’t want 
to print a form for a transaction, click in this 
column next to the transaction to remove the 
mark.

B Zoom arrow Click the zoom arrow to view more information 
about a particular transaction.

C Print xx Copies field Enter the number of copies you want to print.

D Packing Slips/Labels If you want to print packing slips or mailing labels 
immediately after printing your invoices, enter the 
number of copies in these fields.

C

D

A B
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Step 4: Print the forms

When you’ve finished reviewing the information that appears in this 
window, you’re ready to print. Click Print in the Review Before 
Printing window.
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Customizing Forms
MYOB AccountEdge’s forms customizing feature allows you to 
change the look and content of your printed checks, invoices, 
packing slips, shipping labels, statements, bills, paychecks and 
mailing labels. 

You can change the size of a form, add text fields, draw lines and 
boxes, paste graphics on the form, move fields, change the size of 
fields and more.

You can save your customized forms and simply select the required 
form as the occasion demands.

CAUTION : Saving backups of customizing forms Make a backup 
of your Forms folder before customizing any forms so you can 
always revert to the originals. After customizing forms, you should 
consider making further backups of the Forms folder containing 
your custom forms.

Step 1: Display the form in the Customize 
window

1 Display the Forms Selection window for the form you want to 
customize.

2 When you’ve finished making selections in the Forms Selection 
window, click Customize. The Customize window is displayed, and 
the Form menu appears in the menu bar at the top of the screen.
User Guide
A Preview button Click Preview to view your form on your computer 
screen.

B Inactive data fields Inactive data fields are shown in dimmed text and 
won't be printed on your form unless you activate 
them. You can hide inactive data fields by choosing 
Hide Inactive Fields from the Form menu at the 
top of the screen. To re-activate them, choose 
Show Inactive Fields from the Form menu.

C Tool palette The tool palette provides you with customization 
tools for your forms.

D Text fields Text fields don't have surrounding boxes like data 
fields do. What you see in a text field is what 
actually gets printed.

E Active data fields Active data fields are ready to be printed on a form. 
You can inactivate active data fields so they don't 
display on your form. See ‘To inactivate a data 
field’ on page 159.

A B DC E
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A note about customizing checks

A check has two parts—the check and the stub. To customize the 
entire check, you’ll need to customize the stub form and the check 
form separately. Once the check is displayed in the Customize 
window, you can switch between the stub layout and the check 
layout by using the Form menu. 

� Go to the Form menu at the top of the screen and choose the 
appropriate stub layout, for example Regular Stub Layout or 
Payable Stub Layout.

For more information, in MYOB Help, choose Reports and Forms > 
Customizing forms > Tips for customizing checks.

Step 2: Set up form properties

1 Go to the Form menu and choose Forms Info. The Forms 
Information window is displayed. 

2 Specify the number of forms you want to print per page.

3 Choose the required type of paper from the Page pop-up list.

4 Enter the margins for the page. 

5 Specify the width and length of the form (not the paper) in the 
Form Size field. For example, if you are printing four checks per 
page, enter the width and length of a single check. 

Step 3: Customize the form using the Tool 
palette

Customize the form according to your needs. For more 
information, see ‘Adding Elements to a Form’ on page 157.

Step 4: Preview the customized form

At any time during the customization process, you can display an 
on-screen preview of your work. 
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1 In the Customize window, click Preview. The Print Preview 
window displays the form.

2 If you want to view the form in more detail, click the zoom buttons 
on the left side of the Print Preview window.

3 If you want to check your current printer and page settings, click 
Print Setup.

4 When you’ve finished previewing the form, click OK in the Print 
Preview window.

Step 5: Save the customized form

When you’re satisfied with the changes you’ve made to the form, 
you should save the customized form.

� If you want to save changes to a custom form you created 
previously, click Save Form.

� If you want to create a new custom form layout that contains the 
changes you’ve made, click Save Form As. The Save As dialog 
box is displayed; enter a name and a brief description for the new 
layout and click OK.

Step 6: Print the customized form

Printing a customized form is the same task as printing an 
unchanged MYOB AccountEdge form. 

1 Display the Forms Selection window for the form you customized.

2 In the bottom section of the window, select the customized form 
you want to print.

3 Click OK to begin the printing process.
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Adding Elements to a Form
You can add new elements—data fields, text fields, lines, rectangles 
and pictures—to your form in the Customize window. 

To add a text field to a form

1 Click the text tool, and then click the location on the form where 
you want the new text field to appear. A new text field, labeled 
“Text Field,” is displayed.

2 Double-click the new field. The Field Information window is 
displayed.

3 Type the text you want to appear in the new field you created, in 
the Text field of the Field Information window.

4 Click OK to close the Field Information window. The new field 
containing the text you typed is displayed in the Customize 
window.

If the text you entered is longer than the size of the new text field, 
you may need to change the size of the text field. For more 
information, see ‘To change the size of a data field, text field, 
rectangle or picture’ on page 158. 

To draw a line on a form

1 Click the line tool and then click the location on the form where you 
want the line to begin; a cross appears on your computer screen. 

2 Drag the cross to where you want the line to end and then release 
the mouse button. 
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To draw a rectangle on a form

1 Click the rectangle tool and then click the location on the form 
where you want the top left corner of the rectangle to appear; a 
cross appears on your computer screen. 

2 Drag the cross to where you want the bottom right corner of the 
rectangle to appear, and then release the mouse button.

To add a picture or logo to a form 

You can load PICT, TIFF and JPG files directly to a MYOB 
AccountEdge form. If the picture you want to use is in a format 
other than PICT (for example JPEG or GIF), you can copy that 
graphic onto the clipboard and then paste it on the form. You can 
display nearly any picture that appears on the clipboard, regardless 
of its original format. 

1 If the graphic is in a format other than PICT, copy the graphic to the 
clipboard using your graphic application.

2 Click the picture tool in the Customize window in MYOB 
AccountEdge. Then click the location on the form where you want 
the picture to appear. A picture field appears.

3 Double-click the picture field. The Field Information window is 
displayed. 

� If the graphic is a PICT, TIFF or JPEG, file, click Load. The Open 
dialog box is displayed. Select the PICT, TIFF or JPEG, file and click 
Open. The graphic appears in the Field Information window.

� If the graphic is in a format other than PICT, TIFF or JPEG, (and 
you have copied it to the clipboard), click Paste Picture. The 
graphic appears in the Field Information window.

4 Click OK to close the Field Information window. The picture is 
displayed in the Customize window.
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To activate a data field

1 In the Customize window, double-click the field you want to 
activate. The Field Information window is displayed.

2 Click the Active radio button.

3 Click OK.

To copy and paste a data field

1 Click the data field once to select it.

2 Go to the Edit menu and choose Copy.

3 If you want to paste the data field onto another form, display that 
form in the Customize window.

4 Go to the Edit menu and choose Paste. A copy of the data field 
appears in the window.

Changing elements on the form

You can make changes to the data fields, text fields, lines, rectangles 
and pictures on your form in the Customize window. 

To change the size of a data field, text field, 
rectangle or picture

1 Highlight the field you want to change; a solid line appears around 
it.

A small square, called a handle appears in the bottom right corner 
of the field.

2 Simply drag the handle to change the size of the field.

To change the length of a line

1 Select the line you want to change.
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Two small squares—called “handles”— appear on each end of the 
line. 

2 Drag either handle so that the line is the required length.

To change the font characteristics of several fields 
at once

1 Holding down the SHIFT key, click those fields for which you want to 
change the font, so that they are all selected.

2 Go to the Form menu at the top of the screen and choose Change 
Fonts. 

3 Change the font type and size and click Apply to Selected.

To change the font characteristics of a single data 
field or text field

1 Double-click the field you want to change. The Field Information 
window is displayed.

2 Make your choices in the Justify, Font, Size and Style fields in this 
window and click OK.

To change the text in a text field

1 Double-click the text field in the Customize window. The Field 
Information window is displayed.

2 Change the text in the Text field of the Field Information window.

3 Click OK.

To change the thickness of a line or rectangle

1 Double-click the line or rectangle in the Customize window. The 
Field Information window is displayed.

2 Choose a thickness in the Line Size section of the Field 
Information window.
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3 Click OK.

Moving elements around on the form

You can change the position of the data fields, text fields, lines, 
rectangles and pictures on your form in the Customize window. 

There are two ways to move an element in the Customize window: 

� Use the pointer to select the element you want and drag it to the 
new location.

� Change the element’s exact coordinates. 

To drag an element to a new location

1 Click the element and hold down the mouse button. Notice that 
the cursor turns to a hand. 

2 Drag the element to the desired location. In the example below, the 
Invoice # field is being dragged below its original position. 

To change an element’s coordinates

1 Double-click the element you want to move. The Field Information 
window is displayed.

2 In the Field Location boxes, enter the distance from the top and left 
edges of the form where you want the element to begin.

3 Click OK.

Removing elements from the form

You may want to remove some of the text fields, lines, rectangles 
and pictures on your form in the Customize window. 
User Guide
To remove a text field, line, rectangle or picture 
from a form

� Select the element and press DELETE on your keyboard. 

To inactivate a data field

If you don’t want a particular data field to be printed on a form, you 
can inactivate the data field. 

1 In the Customize window, double-click the field you want to 
inactivate; the Field Information window is displayed.

2 Click the Inactive radio button

3 Click OK.

To hide inactive fields

1 Choose Hide Inactive Fields from the Form menu at the top of the 
screen. All inactive data fields are hidden.

2 To display these fields again, choose Show Inactive Fields from the 
Form menu.
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 Chapter 13
Using

Reports

MYOB AccountEdge allows you to see your business from over a hundred different 
perspectives because that’s how many reports you have at your fingertips. These reports 
provide you with comprehensive information about your business, from detailed lists of 
your business’s activities to highly summarized reports.

These reports are all grouped by command center in the Index to Reports window; so 
finding the report you need is the easy task it should be. Just recall the command center 
you used to enter the information you need; then look at the reports for that command 
center. For example, the Accounts command center deals with accounts and General 
Journal entries; so this is where you will find account inquiries, profit & loss reports and 
balance sheet reports. The Sales command center deals with sales to customers; so this is 
where you will find detailed and summarized reports outlining your sales sorted by 
customer, item, amounts outstanding, and more. If you need more information, just look 
at the report description to the right of the report in the Index to Reports window.

Once you have found the report you want, you can display the report on screen, open the 
report in Microsoft Excel, print the report, or e-mail or fax the report. You can also save the 
report as a text file readable by most applications, as a HTML report suitable for the 
Internet, and as a Portable Document Format (PDF) file.

MYOB AccountEdge even allows you to customize the look and content of many reports to 
suit your own needs. Make sure you spend some time looking at the reports. You will be 
amazed by the information MYOB AccountEdge makes available to you about your 
business.
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Finding Reports
You can easily locate reports using the Index to Reports window.

� Go to the Reports menu and choose Index to Reports. The 
Index to Reports window is displayed.

A Click a tab to view the reports associated with that 
tab. Click Custom to view your custom reports.

B Highlight a report and click View Sample to view a 
sample of that report.

C Click Print to print the selected report.

D Click Send To to send the selected report by fax or 
e-mail, to save the report to disk as a PDF file, 
HTML file or text file, or to open the report in 
Microsoft Excel.

E Click Customize to choose the information you 
want to appear on the selected report and how 
you want that information to appear.

F Read a short description of the report you have 
selected here.

G Click Display to view an on-screen version of the 
selected report.

A B DC E F G
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For detailed information about the fields in the Index to Reports 
window, click Help.

For guidelines and tips for using the many reports available in 
MYOB AccountEdge, in MYOB Help, choose Reports and Forms, click 
the topic MYOB Report Advisor.
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Customizing Reports
MYOB AccountEdge gives you complete control of the content and 
appearance of your reports. You can customize your reports in three 
different ways:

� Determining the amount of information to include on a report, 
see ‘Filtering reports’ below.

� Choosing the type of information to include on a report, see 
‘Designing reports’ on page 164.

� Determining the appearance of a report, see ‘Formatting reports’ 
on page 165.

You can use any combination of these three methods to customize 
a report. If you want, you can customize a report, print it 
immediately, and then revert the report back to its original settings. 
Alternatively, if you want to retain a report’s modifications, you can 
customize the report and save it. When you save a customized 
report, the report is known as a custom report and appears in the 
Custom tab of the Index to Reports window.

Filtering reports

You can control the amount of information that appears on your 
reports by using filters. Filters allow you to choose specific pieces or 
ranges of data that can be included on a single report. For example, 
if you want to print a Customer Payments (Closed Invoices) report 
for customer Eileen Martin for the months of May to July, you can 
use MYOB AccountEdge’s filters to select those criteria only.
User Guide
To filter reports using the customize button

1 Go to the Reports menu and choose Index to Reports. The Index 
to Reports window is displayed.

2 Locate the report you want to print and highlight it. Then click 
Customize at the bottom of the window. The Report 
Customization window is displayed. The filters in the Report 
Customization window vary, depending upon the report you’re 
filtering.

3 Make the required entries and selections in the Report 
Customization window.

You can now print or display the report with the filters you selected.

A The top section of the Report Customization 
window typically allows you to choose the range of 
topics that will be included in the report.

B The middle section of the Report Customization 
window typically allows you to choose ranges of 
criteria, such as dates, that will be included in the 
report.

A

B
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To filter reports using the report toolbar

You can use the report toolbar to make changes to the filtering 
options of the report. This toolbar allows you to change basic 
filtering options, such as date ranges and sorting options without 
having to display the Report Customization window. You can also 
choose to display a screen report or a print preview of the report. 
See ‘To display reports on your computer screen’ on page 167.

1 Go to the Reports menu and choose Index to Reports. The Index 
to Reports window is displayed.

2 Locate the report you want to view or print. Highlight it and click 
Display. The Screen Report window is displayed.

3 Make the required entries and selections in the toolbar that is 
displayed in the top section of the Screen Report window. 

4 Click Redisplay. The report is refreshed with the new filtering 
options applied. To make further filtering selections, click 
Customize. See ‘To filter reports using the customize button’ on 
page 163

Using wildcards to filter reports Wildcards are special characters 
that give you more flexibility in selecting various records, such as 
account numbers and invoice numbers, to print on reports that use 
that type of information. You can use two wildcard characters, the 
asterisk (*) and the question mark (?), when filtering your reports.

THE ASTERISK

� Using the asterisk in the Report Customization window allows 
you to print a report for a specific group of records. For example, 
to select only the accounts whose numbers begin with 1, enter 1* 
in the Selected field in the Report Customization window.
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THE QUESTION MARK

� Using the question mark wildcard, you can limit your report to 
elements that contain only a specific number of characters. For 
example, to limit the report to three-character jobs that begin 
with C, enter C?? in the Selected field in the Report 
Customization window

Designing reports

Using the Report Designer, you can choose what type of 
information you want to include in reports. For example, if you 
want to print the average cost of items on a sales report, you can 
choose to do so by designing the report so it includes the average 
cost.

T IP

Reordering columns If you want to change the order in which the 
information is printed on your reports or displayed on screen, display the report 
and choose Screen Report from the View drop-down list. You can then drag the 
column headers to their new position.

1 Go to the Reports menu and choose Index to Reports. The Index 
to Reports window is displayed.

2 Locate the report you want to design and highlight it.

3 Click Customize. The Report Customization window is displayed. 
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4 Click Design at the bottom of the window. The Report Design 
window displays the fields that are available to be printed on the 
report you’ve selected.

5 Click OK when you have finished. 

A The fields in the Field Name column are those that 
are available for the selected report. Mark a field's 
Display column to include that field on the report. 
Drag the fields up or down the column to indicate 
the order in which you want the fields to be 
printed on the report. The fields at the top of the 
Report Design window will appear at the left end 
of the report.

B Fields marked with an X in the Display column are 
set to be printed on the selected report.

A B
User Guide
Formatting reports

You can modify the look of individual reports by using different font 
styles, sizes, colors, alignments and effects, and by changing the 
report’s page margins.

1 Go to the Reports menu and choose Index to Reports. The Index 
to Reports window is displayed.

2 Locate the report you want to format and highlight it.

3 Click Customize. The Report Customization window is displayed. 

4 Click Format. The Report Format window is displayed.

A The left side of the Report Format window 
contains all the sections of the report you're 
working with. Click a section to begin making 
changes to it.

B If you’ve formatted a report and want to change it 
back to its original format, click this button.

C After choosing the section of the report you want 
to customize, make selections from the lists and 
boxes here.

D Make entries in the margin fields to change the 
report's margins.

C

D
B

A
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5 Click OK when you have finished. 

Saving custom reports

If you plan to use a specific report’s design and format many times 
in the future, you can customize the report once and save the 
changes so you can use the modified report whenever you want.

1 Customize your report using the filters, and design and format tools 
available in the Report Customization window. When you’ve 
finished in each window, make sure you click OK to record your 
changes.

2 Display on-screen (by clicking Display) the report you want to save 
as a custom report.

3 Reorder or resize the columns if required. See ‘To display reports on 
your computer screen’ on page 167.

4 Click Save As. The Save As dialog box is displayed.

5 Enter a name and a brief description of the custom report and click 
OK. The Screen Report window is displayed again. 

6 Click Close. The Index to Reports window is displayed.

7 Click the Custom tab. Your custom report will be listed here. 

You can perform the same tasks with custom reports as you do with 
any other MYOB AccountEdge report, including printing them, 
displaying them on your computer screen, and saving them as files 
on disk. See ‘Working with Reports’ on page 167 for more 
information.
Chapter 13 Using Reports166
 MYOB AccountEdge, Version 3 us



Working with Reports
Once you’ve chosen the report you want to print and have made 
the customizations you need, you’re ready to see the finished 
product. In MYOB AccountEdge tasks, you can perform these tasks 
with reports: 

� ‘To print reports on your printer’ below

� ‘To display reports on your computer screen’ below

� ‘To save reports to files on disk’ on page 168

� ‘To send reports by e-mail’ on page 168

� ‘To send reports by fax’ on page 168

� ‘To view the report in Microsoft Excel’ on page 169

To print reports on your printer

You can print reports individually or in batches (see ‘Printing Report 
Batches’ on page 172). Before you can print a report or a report 
batch, however, you need to make sure your computer, printer, and 
MYOB AccountEdge system are properly set up for printing (for 
more information, see ‘Preparing to Print Reports and Forms’ on 
page 170).

1 Go to the Reports menu and choose Index to Reports. The Index 
to Reports window is displayed.

2 Locate the report you want to view or print. Highlight it and click 
Display. The Screen Report window is displayed.

3 Make any changes to the column positions or sizes. See ‘To display 
reports on your computer screen’ below

4 Choose Print Preview from the View drop-down list in the report 
toolbar to check the layout and format of the report before you 
print it. To make changes, choose Screen Report from the View 
User Guide
pop-up menu, make the necessary changes and then choose Print 
Preview again.

5 Click Print.

To display reports on your computer screen

By clicking the Display button in the Index to Reports window, 
you can display an on-screen version of the report in the MYOB 
AccountEdge system. This view of the report enables you to resize 
columns and rearrange columns. When viewing the screen report, 
page breaks, page numbers, the company name and address are 
not displayed. To view a print preview of the report, see ‘To print 
reports on your printer’ below.

1 Go to the Reports menu and choose Index to Reports. The Index 
to Reports window is displayed.

2 Locate the report you want to view or print. Highlight it and click 
Display. The Screen Report window is displayed.

3 Make your changes to the screen view of the report:

� Drag the column header of a column to move it to a new 
position.

� Position the mouse cursor over the (*) icon of a column header 
and then drag it to resize the report column. Only columns that 
have this icon can be resized.

4 Click Save As to save the new report layout as a Custom Report. 
This new format will be available from the Custom tab of the Index 
to Reports window (see ‘Saving custom reports’ on page 166 for 
more information).
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To save reports to files on disk

When you save a report as a file, you have the flexibility to do 
whatever you want with the report—you can further modify it using 
a word-processing application, move it to another computer for 
printing or simply save it for your permanent records.

1 Go to the Reports menu and choose Index to Reports. The Index 
to Reports window is displayed.

2 Locate the report you want to display and highlight it.

3 Click Send To and choose one of the following formats:

� PDF (Portable Document Format) File. 

� If the recipient is using Mac OS X, save the report as a PDF file. 
The person who receives the report can simply double-click to 
open. 

� If the recipient is not using Mac OS X, save the report as a PDF 
file. The person who receives the report must have software 
capable of opening a PDF file. To view a PDF file, you need 
Adobe Acrobat Reader, a free application distributed by Adobe 
Systems. You can install Acrobat Reader from your MYOB 
AccountEdge CD-ROM or download for free from the Adobe 
website.

� HTML File. When you save a report in HTML (Hypertext Markup 
Language) format, the report can be viewed in World Wide Web 
browsers such as Internet Explorer.

� Tab-Delimited Text File. When you save a report in tab-
delimited format, the individual bits of information in the report 
are separated by tab characters. 

� Comma-Separated Text File. When you save a report in 
comma-separated format, the individual bits of information in 
the report are separated by commas. 

� Simple Text File. When you save a report in text format, the 
individual bits of information are separated by spaces so the 
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appearance of the report is as similar as possible to a printed version 
of the report.

When you select the format you want to use, the Save dialog box is 
displayed.

4 Specify a name and location for the file you’re creating and click 
Save.

To send reports by e-mail

1 Go to the Reports menu and choose Index to Reports. The Index 
to Reports window is displayed. 

2 Locate and highlight the report you want to e-mail. 

3 Click Send To and choose E-mail. The E-mail window is displayed.

4 Enter an e-mail address in the E-Mail Address field and make other 
entries as required. 

5 Click Send. The e-mail is sent to your default e-mail application’s 
Outbox. Send the file from your e-mail application as you would 
normally.

To send reports by fax

1 Go to the Reports menu and choose Index to Reports. The Index 
to Reports window is displayed. 

2 Highlight the report you want to fax. 

3 To send fax:

� OS 8.6- 9.x users Click Send To and choose Fax. A dialog box 
from your fax application is displayed.

� Mac OS X users Click Send To and choose Print and select 
the print driver for your fax software.

4 Use your fax application as you normally would to send the fax.
MYOB AccountEdge, Version 3 us



To view the report in Microsoft Excel

You must have Microsoft Excel installed on your computer.

1 Go to the Reports menu and choose Index to Reports. The Index 
to Reports window is displayed. 

2 Highlight the required report. 

3 Click Send To and choose Excel. Microsoft Excel starts and the 
selected report is displayed in Excel.
User Guide
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Preparing to Print Reports and Forms
If you’ve properly set up your printer and computer, printing 
reports and forms using MYOB AccountEdge usually takes only a 
few clicks of your mouse. This section contains important 
information about setting up your printing environment so you can 
successfully print your MYOB AccountEdge information.

Preparing your printer

If you plan to print documents on paper using a printer, bear in 
mind that your printer must be configured properly before the 
information can be printed. MYOB AccountEdge is compatible with 
most popular printers, but each type of printer on the market today 
is different from the next. If you’re unsure about how your 
computer works with your printer or if you’ve had printing 
problems in the past, make sure you understand the capabilities of 
your printer before you attempt to print MYOB AccountEdge 
documents.

1 Make sure that your printer is properly connected to your 
computer.

2 Turn your printer on.

3 Load the paper you want to use and make sure it’s loaded properly.

Preparing your computer

A great deal of the printing process is controlled by software used to 
send information to your printer. This software, commonly known 
as printer driver software, is normally supplied by your printer’s 
manufacturer. Printer drivers play a large part in determining 
how—and whether—information is printed using your printer. In 
many cases, printer drivers are already installed on your computer 
when you purchase it, or are supplied on CD when you purchase 
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your printer. Printer drivers are not included in the MYOB 
AccountEdge package.

To ensure you have the latest printer software drivers, visit the 
manufacturers website. More information about setting up your 
printer with your computer is located in the documentation for 
your computer and printer.

Preparing MYOB AccountEdge for printing

You’ve got a number of options within MYOB AccountEdge for 
personalizing your printed documents and determining the process 
by which you print reports and forms. This section describes those 
options.

To choose page setup options

The selections you make in the Page Setup window determine how 
your documents will look on paper.

The Page Setup window varies, depending upon the printer and 
printer driver software you use. Usually, however, these windows 
allow you to choose options such as your page orientation, paper 
size and print quality.

1 Go to the File menu and choose Page Setup.

2 Review your page setup information before you attempt to print an 
MYOB AccountEdge document.

To choose default fonts for reports and forms

Every report and form in MYOB AccountEdge is assigned a default 
font—that is, a font that’s automatically designated for your use by 
MYOB AccountEdge—when you begin using a new MYOB 
AccountEdge company file. Until you change it, the font assigned 
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when you created the company file will be the default font for all 
your reports and forms.

Note that the changes you make in the Report Format window 
won’t affect any reports or forms that you have already customized.

1 Go to the File menu and choose Default Fonts. The Default Font 
Selection window is displayed.

2 Click either Reports or Forms, depending upon the type of 
document for which you want to change the default font.

3 Choose the font style and size for the printed characters on your 
documents. When you choose a font style and size for reports, use 
the sample box in the right half of the window to preview how the 
font looks. 

4 Click OK when you have finished.
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Printing Report Batches
Report batches are groups of reports you set up that allow you to 
print several reports at a time. You can set up report batches to serve 
a number of purposes. For example, you may want to create a report 
batch that contains all your regular monthly financial statements; 
with a few clicks of the mouse, you can start the printing process so 
the reports print while you work on other important tasks. Report 
batches are created and maintained in the Report Batches and 
New/Edit Batch windows. Printing a report batch is slightly different 
from printing an individual report. Instead of making entries and 
selections in the Report Customization window before you print, 
you’ll use the Report Batches window to choose the reporting period 
for the batches you want to print.

NOTE : Single-user access Please note that this task requires single-
user access. For more information, see “Tasks that require single-user 
access” on page 193.

To create a report batch

1 Go to the Reports menu and choose Report Batches. The Report 
Batches window is displayed. 

2 Click New and enter an appropriate name for the batch.

3 Choose the reports that belong to the batch by clicking the name of 
each report. A mark will appear next to each selected report, 
indicating that it is included in the new batch. 

To remove a report from the batch, click the name a second time.

NOTE : Some reports can’t be included in batches Some reports, 
such as the Reconciliation report, can’t be added to report batches 
because you need to specify information to be printed each time 
you want to print the report. 
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4 Click OK. The Report Batches window is displayed again, with the 
name of the new batch in the scrolling list. To print the report 
batch, see the following section for instructions. 

To print a report batch

1 Display the Report Batches window. 

2 Select the relevant period from the Period drop-down list.

You can choose any of the months or quarters in the current fiscal 
year, or you can choose to print information for the entire year to 
date.

Your selection in the Period list affects different types of reports in 
different ways. For example, if you choose January, Activity reports 
will show job activity information from January 1 to January 31 and 
Balance Sheet reports will show information as of January 31. 

3 Choose a report batch for printing and click Print.

To change a report batch

1 Display the Report Batches window. 

2 Highlight the name of the batch you want to change and click Edit. 
The Edit Batch window is displayed.

You can change the name of the batch and the reports contained in 
the batch.

3 Click OK to save your changes.

To delete a report batch

1 Display the Report Batches window. 

2 Highlight the name of the batch you want to delete.

3 Go to the Edit menu and choose Delete Batch.
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 Chapter 14
End of
Period

Procedures
It is important to ensure that your accounting records are accurate. Reconciling the 
accounts on a regular basis will help you and your accountant know that your books are 
complete and balanced.

You should reconcile your system with any source documents and resources available to 
you. For example, the checking account can be reconciled with the bank statement, 
vendors’ balances can be checked against statements, and customers’ balances verified. If 
possible, your inventory should be counted, valued and, where necessary, adjusted in 
MYOB AccountEdge.

Other end of month procedures include reviewing your trial balance, budgets and cash 
flow, paying payroll taxes and purging information that is no longer needed.

End of year procedures are carried out at the end of your fiscal year and include any 
adjustments you need to make to your system so it agrees with your accountant’s final 
records, such as recording depreciation. You also need to make sure that any matters that 
need attention in the current year are finalized. Then follow the procedures in this chapter 
to reconcile the system and to close the year. By closing the year in MYOB AccountEdge, 
you are effectively bringing the company file up to date and removing information not 
required in the new year. This will also make the system more efficient and manageable. 

If you use the Payroll feature in MYOB AccountEdge, there are additional procedures that 
you need to complete at the end of the year. This involves printing W-2 forms and 1099 
statements, reviewing payroll reports and closing the payroll year.
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Month-end Procedures
The following is a list of tasks we suggest you complete at month-
end. Depending on the nature of your business, some of these tasks 
may not apply to you.

Month-end procedures are usually performed at the end of every 
month, but they can be done at any time during the month. The 
key to success is to perform these tasks regularly. Some tasks need 
to be performed at a specified time every month. Consult your 
accountant if you're unsure which of these tasks are required for 
your business.

Step Action

1 Review your trial balance

2 Review and adjust budgets

3 Review cash flow

4 Review the order status of items

5 Purge information that’s no longer needed

6 Reconcile checking accounts

7 Pay payroll taxes

8 Complete other month-end procedures (optional)

9 Verify and back up your company file

10 Lock the accounting period (recommended)
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Step 1: Review your trial balance

Reviewing a Trial Balance report—also known to accountants as a 
general ledger—regularly is an optional month-end task, but it can 
make your job easier in the future. If you regularly review your trial 
balance, you'll spot incorrectly recorded amounts quickly and will 
be able to fix them without much effort. If you decide to skip this 
procedure, however, and an error appears, you may find yourself 
sifting through several months’ worth of transactions trying to find 
the one that's incorrect.

The Trial Balance [Detail] report can be found in the Accounts tab of 
the Index to Reports window. For more information on filtering, 
displaying and printing reports, see ‘Using Reports’ on page 161. 

When you review the Trial Balance report, look for: 

� Entries that seem unusually high or low for the account that 
has been affected 

� Debit amounts for accounts that normally have credit entries 
and vice versa 

� Unusually high or low ending balances 
� An unusually high or low number of entries for a specific 

account

If the information in the Trial Balance report is acceptable, print the 
reports you want to keep as part of your permanent business 
records. Suggested reports include the Balance Sheet, Profit and 
Loss Statement, Payables Aging report, Receivables Aging report 
and all journal reports.
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Step 2: Review and adjust budgets

Reviewing the monthly amounts you've budgeted for your 
accounts will help you keep your fingers on the pulse of your 
business. The best way to do this in MYOB AccountEdge is to 
consult a special balance sheet called the Balance Sheet [Budget 
Analysis] report, that's designed specifically for budget analysis.

You can print the Balance Sheet [Budget Analysis] report, which lists 
your accounts' actual balances for the current month, along with 
the amounts you budgeted for them. If you've determined that 
changes need to be made to the amounts you've budgeted for the 
coming months, you can adjust your budget. 

The Balance Sheet [Budget Analysis] report is available from the 
Accounts tab of the Index to Reports window. For more 
information on displaying and printing a report, see ‘Using Reports’ 
on page 161. 

For more information on what to look for when reviewing your 
budget, in MYOB Help, see Month-end tasks > Performing month-
end tasks > Reviewing and adjusting budgets > To review your budget 
inventory items.

Step 3: Review cash flow

Having an acceptable supply of available cash can often make a 
huge difference in determining how well your company performs 
next month. In MYOB AccountEdge, you can use the Cash Flow 
Worksheet window to estimate your short-term cash needs by 
using information you've entered throughout MYOB AccountEdge 
to create a forecast of the future of your checking accounts.

The information used in the Cash Flow Worksheet window to 
forecast cash needs comes from recurring Spend Money and 
Receive Money transaction information that you've entered in 
MYOB AccountEdge, as well as the sales and purchases that will fall 
due during the time frame you've selected.
User Guide
As each company's business practices are unique, we can't tell you 
precisely what you should look for when reviewing your cash flow. 
Your accountant can give you additional ideas based on the way 
your company does business.

To view the Cash Flow Worksheet:

1 From any command center, click Analysis and hold down the 
mouse button. Then choose Cash Flow from the list that 
appears.The Cash Flow Worksheet window is displayed.

2 Click Help in the Cash Flow Worksheet window for information on 
using this window. 

Step 4: Review the order status of items

Knowing what items you have on hand is fairly simple. Knowing 
which items are on order from vendors and promised to customers 
is more complicated. Many businesses keep what they call an 
“order book.” It's what they use to track the comings and goings of 
inventory items. 

The Analyze Inventory window functions as your “order book” by 
monitoring what you have on hand, on order from vendors, and 
committed to customers (sales orders).

To display the Analyze Inventory window, go to the Inventory 
command center and click Analysis.

The Analyze Inventory window allows you to review the current 
status of the items you’ve entered into the MYOB system. Note that 
the fields in this window are display-only; that is, you cannot 
change any of the information using this window. 
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Step 5: Purge information that's no longer 
needed

After you’ve used MYOB AccountEdge for a long time, you'll notice 
that the size of your company file has grown considerably. 
Information such as journal entries, invoices, bills, activity slips and 
business contacts build up over time. When your company file has 
grown larger than you want it to, you may want to remove parts of 
the data that are no longer needed from the file. The process of 
removing data from your company file is called purging. 

Business contacts can be purged at any time. 

You can purge activity slips that haven't been billed on invoices. If 
you've billed an activity slip on an invoice, you can purge that 
activity slip only if the invoice on which it was billed has been 
purged.

For more information on purging data, in MYOB Help, choose 
Month-end tasks > Performing month-end tasks > Purging information 
thats no longer needed.

Step 6: Reconcile checking accounts

To ensure the accuracy of your business records, you should keep a 
record of your checking accounts’ balances matched up with your 
bank's records. This task is called reconciling accounts. 

Before you reconcile your checking account

Before you reconcile your account, you need to make sure that all 
the checks and deposits that appear on your bank statement are 
entered in MYOB AccountEdge. 

Importing bank statements into MYOB AccountEdge If you have 
online banking, you can speed up account reconciliation by 
importing your bank statement into MYOB AccountEdge and 
having MYOB AccountEdge match the transactions on your bank 
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automatically appear as cleared in the Reconcile Accounts window. 
Any transactions that appear on your bank statement that have not 
been entered in MYOB AccountEdge can be added to the system by 
following a few simple steps. You can also manually match a 
transaction on your bank statement with a transaction in MYOB 
AccountEdge. Statements are imported by using Get Statement in 
the Reconcile Accounts window or the Bank Register. For 
instructions, see “Importing Statements into MYOB Accounting 
Plus” on page 69.

To reconcile your checking account

1 Go to the Banking command center and click Reconcile Accounts. 
The Reconcile Accounts window is displayed. 

2 Enter the account you want to reconcile in the Account field.

3 Enter the ending balance on your bank statement in the New 
Statement Balance field. 

4 Enter the closing date that appears on your bank statement in the 
Bank Statement Date field. Only transactions dated on or before 
that date will appear in the scrolling list.

5 If you haven’t already imported your bank statement and would like 
to, click Get Statement in this window. See “Importing Statements 
into MYOB Accounting Plus” on page 69 for instructions.

6 Mark all the checks and deposits that are on your bank statement by 
clicking in the column on the left in the Reconcile Accounts 
window.

If you’ve imported your statement and matched the statement 
transactions with those in MYOB AccountEdge, you will notice that 
these transactions have a mark in the column on the left, indicating 
that they are already cleared. 
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7 If you need to record a bank service charge or interest that appears 
on the statement, click Bank Entry and enter these amounts. For 
field help, click Help in the Record Service Charges and Interest 
Earned window. Click Record. 

8 Click Reconcile in the Reconcile Accounts window. A window is 
displayed, indicating whether your account is reconciled or out of 
balance. 

� If your account is reconciled, you have the option of printing 
the Reconciliation report by clicking Print Report 
(recommended). Once the report is printed, the Reconcile 
Accounts window is displayed again. Click Reconcile again to 
complete the reconciliation process. 
If you don’t want to print the report, simply click Reconcile. 
The transactions you marked are considered cleared, and 
won’t appear in the Reconcile Accounts window the next 
time you display it. 

� If your account is out of balance, a window will indicate the 
amount by which your account is out of balance, and will 
provide you with a few ideas of how the out-of-balance 
situation might have occurred. 

Here are some additional things you might want to verify:

� Are all the checks and deposits that appear on your bank 
statement marked in the Reconcile Accounts window? Check 
to be sure the deposit and withdrawal amounts that appear on 
the Total Cleared line near the bottom of the Reconcile 
Accounts window are the same as the total deposit and 
withdrawal amounts on your bank statement.

� Did you mistakenly mark a transaction that doesn't appear on 
your bank statement?

� Did you make the correct entry in the New Statement 
Balance field? (Make sure you entered the ending balance 
from your statement and not your beginning balance.) 

� Are all deposits accounted for? If the bank statement shows a 
higher balance than the balance calculated by MYOB 
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AccountEdge, a previously cleared deposit may have been 
deleted and not re-entered, or re-entered but not marked as 
cleared.

Step 7: Pay payroll taxes

Payroll taxes need to be paid on a regular basis. Consult your 
accountant or the appropriate government agencies if you're 
unsure about how or when to file payroll taxes.

You can use the Tax Liabilities report to determine the taxes you 
owe to the government agencies. The amounts on the Tax 
Liabilities report reflect the payroll tax amounts recorded on 
paychecks.

The Tax Liabilities report is available from the Payroll tab of the 
Index to Reports window. For more information on filtering, 
displaying and printing reports, see ‘Using Reports’ on page 161.

Once you've determined the payroll tax amounts you owe, you 
need to create a Spend Money transaction to pay payroll taxes to 
the appropriate government agencies. 

In the Account # (or Name) column of the Spend Money window, 
enter the linked liability account you've selected to track each 
payroll tax. When the transaction is recorded, the liability account 
will be decreased by the amount you've entered for each payroll 
tax. 

Step 8: Complete other month-end procedures

Many procedures in MYOB AccountEdge can also be considered 
month-end procedures. The following procedures might be 
performed at the end of the month at your company:

� Print customer statements (see ‘Printing Forms’ on page 151).

� Analyze sales (see ‘Reviewing your Sales Information’ on 
page 65).
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� Analyze purchases (see ‘Reviewing your Purchase Information’ on 
page 80).

� Count items in inventory (see ‘Counting Inventory’ on page 93).

� Record unrealized gains and losses (see ‘Unrealized currency 
gains and losses’ on page 147).

For additional information on completing the above tasks, in MYOB 
Help, choose Month-end tasks, click the topic Month-end tasks > 
Performing month-end tasks > Other month-end procedures.

Step 9: Verify and back up your company file

We strongly recommend that you make a backup of your company 
file and check the file for errors during the backup process. For 
instructions, see ‘Backing up your Company File’ on page 187. 
Mark this backup clearly and put it in storage as part of your 
permanent records. 

Step 10: Lock the accounting period

After you have completed your month-end tasks, we suggest that 
you “lock” that month using the Lock Periods feature. This will 
prevent you from inadvertently making an entry in a month in 
which you don't want new entries. 

1 Go to the Setup menu and choose Preferences. The Preferences 
window is displayed. 

2 Click the Security tab.

3 Mark the Lock Periods: Disallow Entries Up to and including 
(System-wide) checkbox and choose the relevant month from the 
drop-down list.

This selection merely places a temporary lock on the month you 
selected and all months before it. If, at a later time, you need to 
make an entry in a locked month—for example, you locked May 
and now want to make an entry in April—you can change your 
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selection in the Preferences window so that month is “unlocked.” 
For example, if you choose March as your locked month, April 
becomes available for transaction entry again.
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Year-end Procedures
This section describes the tasks you need to perform at the end of 
your fiscal year and at the end of your payroll year (if you use the 
Payroll feature) to prepare your MYOB AccountEdge system for the 
coming year. 

End of payroll year

You must close the payroll year in the last month of your payroll 
year or soon after. Otherwise, you will not be able to enter 
paychecks for the next payroll year. You should close your payroll 
year first before closing your fiscal year. For more information, see 
‘Starting a New Fiscal Year’ on page 180.

End of fiscal year

MYOB AccountEdge doesn’t require that you close your fiscal year 
at any particular time. You can continue to use MYOB AccountEdge 
for up to twelve months after the last month of your current fiscal 
year without concern. MYOB AccountEdge allows you to track 
information for the previous, current and next fiscal years. 
(However, if you don’t close your fiscal year at the end of your 
current fiscal year, you won’t be able to print current information on 
some reports.) See ‘Starting a New Fiscal Year’ on page 180.
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Starting a New Fiscal Year
Complete the tasks listed below to close your fiscal year and start a 
new fiscal year. 

Step 1: Print reports

Print all the reports that you want to keep that show the previous 
year’s transaction activity. You might consider printing a copy of 
each journal, because they show all transaction activity for a 
specified period.

Step 2: Verify your company file

Verify your company file to check for inconsistencies and minor 
errors before they cause serious problems. For instructions, see 
‘Checking your company file for errors’ on page 190. 

Step 3: Back up your company file

We strongly recommend that you make multiple backups of your 
company file before closing the year and that you store these 
backups in different locations. After you start a new fiscal year, the 
only way you can view the detail of transactions that were purged 
from the company file during the Start a New Year process is to 

Step Action

1 Print reports

2 Verify your company file

3 Back up your company file

4 Start a new fiscal year

5 Optimize your company file
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restore a backup of the company file. For more information, see 
‘Backing up your Company File’ on page 187. 

Step 4: Start a new fiscal year

If you have completed steps 1 - 3, you are now ready to start a new 
fiscal year.

To the best of your ability, make sure that all transactions for the 
year that’s ending are entered in MYOB AccountEdge before you 
begin closing the year. That way, you can avoid making adjusting 
General Journal entries in the new year and your yearly records will 
be more accurate. This will also make it easier for you to compare 
your company’s performance from one year to the next. If you have 
an accountant who produces your year-end financial reports, you 
may need to wait for your accountant to provide you with any 
adjusting entries that may be needed.

When you start a new fiscal year:

� The previous fiscal year’s monthly totals for all accounts are 
changed to “last year” categories. If “last year” amounts already 
existed, those amounts will be replaced.

� All closed sales, closed purchases and journal entries assigned to 
closed sales and closed purchases are purged.

� The balance of your current-year earnings account is transferred 
to your retained earnings account.

� The balances of your income, cost of sales, expense, other 
income and other expense accounts are returned to zero. 

If you want, the new fiscal year can be changed so it ends in a 
different month than the previous fiscal year. (If you choose to make 
this change, check with an accountant about how to report 
information for a “short” fiscal year.)
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NOTE : Single-user access Please note that the task of starting a 
new fiscal year requires single-user access. For more information, see 
‘Tasks that require single-user access’ on page 193.

To start a new fiscal year

1 Go to the File menu and choose Start a New Year and then Start a 
New Fiscal Year. The Start a New Fiscal Year Assistant is displayed. 

2 Follow the instructions that appear on your computer screen. Click 
Help in these windows if you need help. 

Step 5: Optimize your company file

After you start a new fiscal year, we recommend that you optimize 
your company file. Optimizing your company file reduces its size 
and makes it more efficient. See ‘Optimizing your company file’ 
on page 190.
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Starting a New Payroll Year
Complete the tasks below to close your payroll year and start a new 
payroll year. 

Step 1: Process the last paychecks for the year

You must make sure that all paychecks for the current payroll year 
have been entered. For more information, see ‘Paying your 
Employees’ on page 193. 

Step 2: Print year-end payroll forms

You can use MYOB AccountEdge to print W-2 forms for your 
employees and 1099 statements for your vendors to use at tax time. 
Information for W-2 forms and 1099 statements is tracked using the 
Current Payroll Year for your company file. 

For more information on printing W-2 forms and 1099 statements, 
in MYOB Help, click Year-end Tasks > Performing year-end tasks > 
Printing year-end payroll forms.

Step Action

1 Process the last paychecks for the year

2 Print year-end payroll forms

3 Print payroll reports

4 Back up your company file

5 Start a new payroll year

6 Optimize your company file
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and Year-end Tasks > Performing year-end tasks > Working with 1099 
vendors and statements.

You can enter or change amounts that print on W-2 forms and 1099 
statements by manually adjusting the amounts that were calculated 
by MYOB AccountEdge. If, for example, you want to print a 1099 
statement for a vendor whom you haven’t designated a 1099 
vendor, you can enter the amounts you wish to print on the 1099 
statement for the vendor. The changes won’t affect transactions or 
reports in MYOB AccountEdge; the changes will only print on the 
W-2 forms and 1099 statements. You can also choose to revert to 
the amounts calculated by MYOB AccountEdge.

For more information on entering or changing amounts that print 
on W-2 forms and 1099 statements, in MYOB Help, click Year-end 
Tasks > Performing year-end tasks > To enter or change amounts that 
print on a 1099 statement. 

Step 3: Print payroll reports

Print the following payroll reports at a minimum:

� Register report. This report shows the pay history of your 
employees. 

� Activity (Summary) report. This report shows the paychecks that 
have been recorded but will not include manual adjustments 
made in an employee’s Pay History window (in their card).

Review these reports to spot potential issues or concerns. Look for 
figures that seem out of the ordinary or unexpected. 
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Step 4: Back up your company file

Before you start a new payroll year, make sure you make a backup of 
your company file. Once the year is closed, detailed payroll 
information is no longer available and W-2 forms, 1099 statements 
and other reports cannot be printed for that year. If you’ve made a 
backup, however, you can restore that backup and print the 
necessary documents. 

For more information, see ‘Backing up your Company File’ on 
page 187. 

Step 5: Start a new payroll year 

NOTE : Single-user access Please note that this task requires single-
user access. For more information, see ‘Tasks that require single-user 
access’ on page 193.

1 Go to the File menu, choose Start a New Year and then Start a 
New Payroll Year.

2 Follow the directions onscreen, which will prompt you step-by-step 
through the process. Click Help in these windows for detailed help. 

Starting a new payroll year will:

� clear the payroll history from the employee cards for the previous 
year.

� prevent you from printing payroll reports for the previous year. 

� prevent you from editing or deleting paychecks for the previous 
year. 

If you have set up a vacation pay employer expense as an Accrual 
type and have selected to carry over remaining expenses to the next 
year, MYOB AccountEdge will carry over those balances to the new 
payroll year. 
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Step 6: Optimize your company file

After you start a new payroll year, we recommend that you optimize 
your company file. Optimizing your company file reduces its size 
and makes it more efficient. For more information, see ‘Optimizing 
your company file’ on page 190.
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 Chapter 15
Maintaining

Your
Company

File
This chapter is about protecting your data. Your company’s accounting information is kept 
in a single, convenient file called the “company file” in MYOB AccountEdge. This includes 
your Accounts List, details about your customers, vendors and employees, your list of 
items, and all your transactions.

Every time you record a transaction, it is written to the hard disk. Theoretically, there is no 
limit to the number of transactions you can enter in MYOB AccountEdge—the only 
constraint is that a very large company file might compromise performance.

Now, think of how much time you have spent customizing your company file, setting it up 
and entering all your transactions. Imagine having a computer failure and having to do it 
all again. You wouldn’t want to start over; that’s why it’s important to know what you can 
do to avoid such a situation. You need to know how to back up, restore and verify your 
company file.

You may need to restore a backup at any time, as a simple bump of the computer or a power 
surge can cause a computer to restart at just the wrong time and corrupt a company file. 
Company files can also be lost by hard disk failures and theft. In all cases, the only 
protection is a backup. If possible, you should keep your backup separate from your 
computer—preferably off-site.

Sometimes you might not realize you have a problem. Company file corruptions can hide in 
the file until you attempt to access that part of the file with the error. MYOB AccountEdge 
provides the Verify Company File function to protect you against this. We recommend 
that you check your company file for errors before you back up and as you open it in the 
morning.

Please read this chapter carefully and practice verifying, backing up and restoring your 
company file.

This chapter also shows you how to use passwords to prevent people from accessing 
confidential data. You can have a master password for your entire company file and sub-
passwords to protect individual areas of your company file, such as payroll.
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Setting up Passwords
In MYOB AccountEdge, you can use a security system based on a 
master password and several sub-passwords. The master password is 
used to control access to the entire MYOB AccountEdge system; this 
password is used to create sub-passwords. You can have only one 
master password in a single company file.

Sub-passwords are used to control access to various sections of the 
MYOB AccountEdge system, such as individual command centers. If 
your system uses passwords, you’ll enter the password when you 
start MYOB AccountEdge or switch from one company file to 
another. Users will be able to access those areas to which their 
password has been assigned access privileges. You can set up any 
combination of sub-passwords in your security system.

Make sure single-user file locking is on before you set up passwords 
(see “Tasks that require single-user access” on page 193).

To set up the Master password

Make sure you write down the password in a safe place. 

1 Go to the Setup menu and choose Preferences. The Preferences 
window is displayed. 

2 Click the Security tab and then click Password. The Set up 
Passwords window is displayed.

3 Enter your master password and click Record New Password. You 
can type in upper or lowercase; passwords are not case-sensitive.

4 Review the password you typed and click OK. The Password Access 
window is displayed. 

5 Either exit the password windows by clicking OK, or begin setting 
up sub-passwords in the Password Access window (see ‘To set up 
sub-passwords’ below).
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To set up sub-passwords

1 Click New in the Password Access window. 

2 Enter the new sub-password and click Record New Password. The 
Password Access window is redisplayed, with the new sub-
password appearing in the list on the left side of the window. 

3 Make sure the sub-password is highlighted in the list. 

4 Select the command centers and windows that users with this 
password won’t have access to by clicking the appropriate names. 
When you select a command center or a window, an X will appear 
in the Not Allowed column next to the label you selected. If you 
select a command center or a window that opens other windows, 
an X will also appear next to the names of the other windows. 

5 Click OK. The new sub-password you’ve created becomes active.

For information on changing passwords, changing a sub-
password’s access rights and deleting a password, in MYOB Help, 
choose Setup > Creating and using passwords > Using master 
passwords and sub-passwords. 
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Backing up your Company File
Your business generates an enormous amount of data. Computers 
are very reliable, but not perfect. You should back up (make copies 
of) your MYOB AccountEdge data on a regular basis. 

Backing up is the copying of computer files to some form of storage 
device. If you have a relatively small company file, you can simply 
copy the MYOB AccountEdge company file to a separate CD. 
Otherwise, you can use MYOB AccountEdge’s automatic backup to 
create a compressed version of your company file (with a ‘.sit’ 
extension).

Don’t put your backups on the same hard drive as MYOB 
AccountEdge—a single disaster can wipe out all your records.

Do make multiple backups. Sometimes disks fail in subtle ways. A 
disk failure can corrupt a big chunk of your data in such a way that 
you may not notice it during a session. Once you copy the 
damaged data onto your only backup, you’re stuck: you will not 
have a valid backup and will need to re-create your company file. 
Multiple backups give you a greater degree of protection.

When to back up your data

We recommend:

� Daily backups—Rotational. If you use MYOB AccountEdge every 
day, make a backup disk for each day of the week. If you use 
MYOB AccountEdge on a more sporadic basis, make two backup 
copies and rotate them. Label them clearly each time to keep 
track of which is your most recent backup.

� Monthly backups—Archival. After completing all entries for a 
month, make an archive copy and label the disk—for example, 
MYOB AccountEdge November 2002 Archive. 

� Yearly backups—Archival. After completing all entries for a year, 
make an archive copy and label it, for example, MYOB 
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AccountEdge 2002-03 Yearly Archive. Make this backup 
immediately before running Start A New Year.

� Backup before upgrade. Before you upgrade to a new version of 
MYOB AccountEdge, you should always back up your company 
file. 

Put your monthly and yearly backups in a safe place, preferably 
away from your office. Do not use these disks again. You can 
reload these backups to look at information you may have 
purged later on or to produce certain backdated reports.

NOTE : Single-user access Please note that making a backup 
requires single-user access. For more information, see “Tasks that 
require single-user access” on page 193.

To make a backup of your data

The Backup command creates a backup of the company file you're 
currently using, and compresses it to a smaller, more manageable 
size.

NOTE : Back up customized documents Any customized forms, 
reports, OfficeLink letters or spreadsheet templates you’ve created 
should be backed up with your company file. Select Backup all data 
when you are backing up customized documents. 

1 Select the correct disk for the backup you are doing (daily, monthly, 
yearly, as specified in ‘When to back up your data’ on page 187). If 
this is the first time you are doing this type of backup, select a newly 
formatted disk and label it clearly. Insert the disk into the disk drive.

2 Go to the File menu and choose Backup. The AccountEdge 
Company File Backup dialog box is displayed. 

NOTE : If the backup process does not work When you installed 
MYOB AccountEdge, special software used for the backup process 
was also installed. If a message is displayed when you try to use the 
Backup command, this software may have been removed from the 
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location where it needs to exist. You may need to reinstall MYOB 
AccountEdge to use this feature.

3 Decide the type of backup you want.

� To back up your company file and templates, mark the Backup 
all data checkbox.

� To back up your company file only, mark the Backup 
Company File only checkbox.

4 Choose whether you want to check for errors before making your 
backup and click Continue. We recommend checking for errors, so 
that should you need to revert to a backup, data integrity is 
ensured. The Save dialog box is displayed.

5 Specify the location where you want to store the backup file.

6 Name the backup file or accept the default name. Make sure the file 
is saved with the extension ‘.sit.’ In this exampe, we are saving the 
MondayBackup.sit file to a CD.

7 Click Save to begin creating your backup file. You may get a 
message saying that the file exists. Make sure you are not 
overwriting another backup you want to keep. 

Make sure you label all your backups with enough information to 
tell you when they were done and where you were up to in data 
entry– for example ‘Monday 8/9/02’ or ‘Backup as of 8/9/02.’
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Restoring a Backup of your Company File
The Restore command closes the company file you’re currently 
using, decompresses an MYOB AccountEdge backup file so you can 
use it and opens the backup file. 

While the Restore function will not let you restore a file with the 
same name as one already in the location to which you are 
restoring, you should always be aware of the risks with restoring 
files and the possibility of overwriting a file you need. If you aren't 
careful, this is one area which potentially can cause you many hours 
of lost work. When in doubt, take an additional backup before 
restoring. Be sure to label all backups with enough information to 
tell you when they were done and where you were up to in data 
entry.

NOTE : Single-user access This task requires single-user access. For 
more information, see “Tasks that require single-user access” on 
page 193.

To restore a backup

1 Select the disk from which you want to restore and insert it in the 
disk drive.

2 Go to the File menu and choose Restore. The Open dialog is 
displayed.

3 Choose the backup file you want to restore. The current disk being 
accessed is displayed on the top section of the window. Select the 
disk in which you stored your backup file. A list of all files on the disk 
is displayed. Select the file you need with the mouse and then click 
Open.

4 Choose the destination for the restored file. You should restore the 
company file to the same folder which contains your MYOB 
AccountEdge application (usually the MYOB AccountEdge folder). 
Choose the disk and then the folder to which you want to restore 
the company file, and then click Choose. 
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A message is displayed, letting you know that the backup file will be 
saved with a suffix of ‘.old’ — for example Fothergill & Co.old.

If you are just reviewing historical information, leave the name as it 
is. If you intend to go on using this restored copy as your primary 
company file, you should rename it after the restore is complete.

5 Click OK to complete the restore.
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Working with your Company File
Checking your company file for errors

In addition to having MYOB AccountEdge automatically check your 
company file for errors before a backup, you can check your 
company file any time you choose.

By checking your company file for errors, you can catch minor 
inconsistencies in the file before they cause serious problems

NOTE : Single-user access This task requires single-user access. For 
more information, see “Tasks that require single-user access” on 
page 193.

To check your company file for errors

1 Got to the File menu and choose Verify Company File. A 
confirmation dialog box is displayed. 

2 Click OK to confirm that you want to verify your company file. 
MYOB AccountEdge will scan your company file for errors.

When the file verification process is complete, a message will be 
displayed, describing the results of the process. 

� If no errors were found, congratulations! Click OK to end the 
company file verification process. 

� If your company file is corrupted, you will need to restore from 
your most recent backup. See ‘Restoring a Backup of your 
Company File’ on page 189.

Optimizing your company file

Over time, your MYOB AccountEdge company file will grow 
considerably in size. As you enter transactions, then remove or 
purge them, the file will have unused areas that once contained 
these transactions. These unused areas can affect the efficiency with 
which MYOB AccountEdge works with the company file and they 
consume space on your hard disk that can be used for other 
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purposes. We recommend that you use the MYOB AccountEdge 
Optimization Assistant to remove the unused areas in the company 
file and keep your accounting software running in top form.

Purging information that is no longer needed

Purging is the process of removing data from your company file. 
After you’ve used MYOB AccountEdge for a long time, you’ll notice 
that the size of your company file has grown considerably. 
Information such as journal entries, sales, purchases, activity slips, 
business contacts and sales history figures build up over time. When 
your company file has grown larger than you want it to, you can 
remove the parts of the data that are no longer needed from the 
file. 

For instructions on purging data, in MYOB Help choose Month-End 
Tasks> Performing month-end tasks and click the topic Purging 
information that’s no longer needed. 

Unable to open company 
file—troubleshooting 

When a MYOB AccountEdge company file is open, a temporary file 
called a lock file is created in the folder where the company file is 
stored. This file, called Lock0001.flk, keeps track of who is using the 
company file. When all users have logged out of the company file, 
the lock file is deleted automatically.

Sometimes, however, the lock file may not delete itself 
automatically. This can happen if your computer crashes or an error 
causes your company file to close unexpectedly. Locked files can 
accumulate in the company file folder even when no company files 
are in use; this can result in error messages appearing when you try 
to access your company file again. 
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To resolve these error messages, you must make sure that all users 
log out of the company file and close down their MYOB 
AccountEdge software. You then need to view the folder that 
contains the company file and delete any lock files that it contains. 
You should then be able to open your company file without an 
error.

CAUTION : A lock file should not be deleted when you are 
optimizing your company file. 

POSSIBLE ERROR MESSAGES THAT MAY APPEAR AS A  
RESULT OF LOCK FILES

Someone else is currently signed on with the same User ID This 
message indicates that either someone is using the company file 
with your User ID or that a lock file from a previous session still 
exists. 

No more than ten company files in any folder may be opened at 
one time While it’s unlikely there are actually ten company files 
open in your MYOB AccountEdge folder, this message indicates 
there are ten lock files in the folder, and only ten lock files can be 
created in one folder. 

You have reached the maximum number of simultaneous users 
allowed under your MYOB AccountEdge Workstation License If 
you know this is incorrect, the problem may be a lock file.
User Guide
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Using your Company File on a Network
The power behind MYOB AccountEdge lies in its ability to run on 
your company's network, with more than one person using the 
same company file at the same time. Using this power, you'll be able 
to get more of your accounting functions completed more quickly. 
MYOB AccountEdge operates a little differently from software 
programs that don't run on networks. As your accounting records 
are vital to your business, it's important for you to understand how 
MYOB AccountEdge works in your network environment. The way 
you set up a company file in MYOB AccountEdge can affect the 
people in your company who use the company file.

NOTE : This section on using your company file on a network 
applies to you only if you are using Mac OS version 8.6 or 
version 9 If you are using Mac OS X, please refer to the Late-
Breaking Changes section in the MYOB Learning Center for more 
information on Mac OS X and multi-user capability. 

How preferences work in a network 
environment

Some of the preferences you can choose in the MYOB AccountEdge 
Preferences window can affect how everyone works with your 
company file. As these preferences, known as system-wide 
preferences, may affect other people, it's a good idea to be aware of 
the effects of each selection you make in the Preferences window.

Each system-wide preference is clearly marked with the word 
System-wide in the Preferences window.

For more information about preferences, in MYOB Help, choose 
Setup > Personalizing your company, click the topic Customizing your 
MYOB AccountEdge system and then click Customizing work 
preferences. 
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How passwords work in a network 
environment 

You can safeguard your company's accounting data by setting up 
passwords that prevent people from using parts of the company file 
that they don't need to use. See ‘Setting up Passwords’ on 
page 186 for information on setting up passwords.

When you use the Password Access window to restrict access to 
specific windows in MYOB AccountEdge, you may also restrict 
access to information shown in lists and reports throughout the 
entire MYOB AccountEdge system. For example, if you set up a 
password so 'Person A' can't use the Purchases window, 'Person A' 
will also be restricted from seeing any entries created in that 
window in MYOB AccountEdge, such as those that normally appear 
in the Purchases and Payables Journal report or the Find 
Transactions window. This ensures that 'Person A' has no 
opportunity to view your company's purchasing records. Any 
information that doesn't apply to purchases, however, would still be 
displayed.
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Protecting your accounting data using file 
locking

When two or more people use MYOB AccountEdge simultaneously 
to keep accounting records for your company, they all access the 
same company file at the same time. This means that two or more 
users might be entering sales, writing checks, creating customer 
cards and so on, at the same time. 

MYOB AccountEdge uses a special function called file locking that 
makes it possible for more than one user to enter information in the 
same company file at the same time. File locking is one of many 
features built into MYOB software that allow you and your 
coworkers to work together in MYOB AccountEdge.

As more than one person can use a MYOB AccountEdge company 
file, you might run into situations where two or more people are 
making entries at the same time. There also are times when 
important maintenance procedures affect your entire company file, 
such as when you back up a company file. In each case, MYOB 
software uses file locking to protect your accounting data. File 
locking can take two forms: multi-user file locking and single-user file 
locking. 

Multi-user file locking 

Multi-user file locking is used by MYOB AccountEdge when more 
than one person is entering information into the same company file 
at the same time. It's used to prevent different pieces of data from 
“colliding” into each other when they're simultaneously entered 
into your company file; such a situation, if not prevented, could 
seriously damage the company file.

Another instance of multi-user file locking occurs when you're 
working with a particular record in the Sales, Purchases, Historical 
Sale, Historical Purchase, Receive Payments, Pay Bills, Settle 
Returns & Credits and Settle Returns & Debits windows. If you've 
User Guide
marked the Automatically Refresh Lists When Information 
Changes preference, when another person changes or removes the 
same record you're working with in one of the windows listed 
above, the window you're using will automatically close.

Tasks that require single-user access 

When you share your company file on a network, several users can 
have access to the company file at the same time. However, a few 
important MYOB AccountEdge tasks require that only one user is 
using the company file. Many of these tasks are file maintenance 
procedures, such as backing up your company file and checking 
your company file for errors. These tasks require the ‘full attention’ 
of the company file while they’re being performed. Single-user file 
locking ensures that only one user is using a company file when 
these tasks are being performed.

When you begin to perform a task that requires a single-user file 
lock, other users cannot have the company file open. If you attempt 
to begin one of these tasks when the file is open on another user’s 
workstation, MYOB AccountEdge will prevent you from starting the 
task. Similarly, if a single-user file lock is in effect on a company file, 
no other users will be able to open the file. 

When you open a company file, you can specify that you want to 
activate single-user file locking. In the Sign-On window that is 
displayed when you start up MYOB AccountEdge, choose the 
Single-User Access option.

HINT : View a list of users To quickly check whether other users 
are currently using the company file, go to the File menu and 
choose Active Workstations.

The tasks in which single-user file locking occurs include:

� Backing up a company file

� Restoring a backup file

� Company File Verification—checking a company file for errors
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� Purging journal entries, activity slips, closed sales/purchases and 
business contacts (contact log)

� Exporting MYOB AccountEdge data 

� Importing data into MYOB AccountEdge

� Starting a new fiscal year

� Starting a new payroll year

� Loading payroll tax tablesCreating, changing or deleting report 
batches

� Optimizing a company file

� Setting up, changing or removing passwords

� Setting up, changing or removing an employee’s payroll 
information

� Creating, changing or removing payroll categories

Printing and displaying reports when others 
are using the same company file

When you're printing reports on your printer or displaying reports 
on your computer screen and other people are using the same 
company file, you can choose to activate multi-user file locking 
yourself.

Before you print or display a report, open the Report 
Customization window for the report. You can mark the Prevent 
Data Changes During Report Generation checkbox to activate 
multi-user file locking and prevent other users from adding, 
changing or removing any information from the company file while 
MYOB AccountEdge is generating the report. When you print or 
display the report while this checkbox is marked, the report will be 
as up to date and accurate as possible.

Keep in mind, however, that a few MYOB AccountEdge reports take 
some time to be generated. You might want to consider printing 
these lengthy reports at times (for example, at the end of the work 
day) when other users won't be forced to wait for the report to be 
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generated before they can begin making entries into the company 
file again.

You can also leave the Prevent Data Changes During Report 
Generation checkbox unmarked. When you do this, other users 
will be able to continue making entries in the company file, but your 
report may not look exactly the way you intended. If another user 
changes information that affects the report as it's being printed or 
displayed, that particular entry may be indicated by zeroes or blank 
spaces on the report. In addition, new entries that other users make 
might affect the total amounts on some reports. With this in mind, 
you should consider printing or displaying the report at a time 
when you know that no entries are being that which will affect the 
completeness of the report.
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Storing custom reports on a network

When you create custom reports in MYOB AccountEdge, the 
information about the custom reports is stored on your 
workstation's hard disk, not on the network. Other users of the 
same company file won't be able to use your custom reports unless 
you copy the custom reports' information to the appropriate 
locations on their workstations. (You may want to ask your system 
administrator to perform this task.)

Your custom report information is stored in the CUSTOM folder 
inside the folder on your workstation in which MYOB software is 
installed. You can use the Finder to copy the custom report files 
onto other users' workstations.

NOTE : If you've created custom reports with a previous MYOB 
product If you've created custom reports with a previous MYOB 
product, you may not be able to display and print them using 
MYOB AccountEdge Version 3. As a result of the addition of new 
report fields, changes of field names or changes to the length of 
information that will be displayed and printed for a field, your 
custom reports may not be available in MYOB AccountEdge Version 
3. You may need to customize those reports again.

Displaying up to date information

Each time you open a list window (such as the Find Transactions 
window), or display an MYOB AccountEdge report in the Screen 
Report window, the information that is displayed matches the 
contents of the company file as of the moment you opened the list 
or displayed the report. However, if you keep the list or report 
displayed on your computer screen for some time, the data that 
other users enter during that time may make the information on 
your screen obsolete or incorrect. With this in mind, it’s a good idea 
to keep the information that’s displayed on your computer screen as 
up to date as possible; that way you’ll be sure you’re equipped with 
the latest data when you make your company’s financial decisions.
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� To have the information displayed on your screen updated 
automatically, mark the Automatically Refresh Lists when 
Information Changes checkbox in the System view of the 
Preferences window (from the Setup menu, choose 
Preferences and then click the System tab). 

� To manually update the information displayed on your screen, go 
to the Window menu and choose Refresh All. To update an on-
screen report in the Screen Report window, you’ll need to re-
display the report using the procedure you originally followed to 
display the report.

NOTE : Automatically refreshing information will make the 
system operate more slowly for everyone Carefully consider 
whether you need to have on-screen information refreshed 
automatically. If you choose this option, MYOB AccountEdge will 
operate more slowly for everyone who's accessing it. If speedier data 
entry is a priority for you, we recommend that you choose to 
manually refresh information on a regular basis.
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Optimizing the performance of MYOB 
AccountEdge

As it relies on the network to get the job done, MYOB AccountEdge 
needs network hardware and software components to be working 
as seamlessly as possible. The following list outlines a number of 
ways in which you can get the most out of your accounting system 
in the least amount of time.

� Use single-user access whenever possible.

� Exit MYOB AccountEdge when you're not using the application.

� Optimize your company file frequently (see ‘Optimizing your 
company file’ on page 190).

� Do not mark the Automatically Refresh Lists When Information 
Changes checkbox in the Preferences window.

� Do not check for duplicate document numbers.

� Use Easy-Fill when entering card names, account names, and 
item numbers or names.

� Enter accurate transactions.

� Avoid leaving list windows open on your computer screen.

� Make additions and changes to “master records” when you're 
the only person using the company file.

� Use only a few linked accounts for inventoried items.

� Combine line item quantities on sales and purchases.

� Mark the Prevent Data Changes During Report Generation 
checkbox in the Preferences window.

� Generate large reports when you're the only person using the 
company file.

� Print reports by a specific month instead of by a date range.

For more information on each of the above, in MYOB Help, choose 
Setup > Networking with MYOB AccountEdge > Optimizing 
AccountEdge.
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Appendix A Importing and Exporting
Data
Importing Accounting Data
MYOB AccountEdge allows you to take various bits of information 
entered in other software applications and incorporate it into your 
company file. You can also incorporate information entered in one 
MYOB software company file into another MYOB software 
company file. This process is called importing data.

You can import the following types of information into MYOB 
AccountEdge: accounts, items, cards, sales, purchases, activities, 
activity slips and journal entries. 

Importing from CaseWare You can import journal entries from 
CaseWare directly into MYOB AccountEdge. For more 
information, see ‘Exporting to and Importing from CaseWare’ on 
page 200.

If you are importing from Quicken In MYOB Help, choose 
Importing/Exporting and click the topic To import QIF 
information.... 

To import data

Before you start the import process in MYOB AccountEdge, you will 
need to export the data you want from the software application 
you’ve used to create the data. The data you want to import must 
be stored in a file, known as an import file, that uses either the tab-
delimited or comma-separated file format.
1 Go to the File menu, choose Import Data, and then choose the 
type of data you want to import. The Import File window is 
displayed.

2 Select the import file format and the type of the first record and 
enter other information as required. For more information, click 
Help. 

3 Click Continue. The Open dialog box is displayed.

4 Locate the import file and click Open. The Import Data window is 
displayed. 

5 Match the import fields with the MYOB AccountEdge fields. To do 
this, highlight the name of a field in the Import Fields column. 
Then match it with a field in the AccountEdge Fields column by 
clicking that field. When you click the AccountEdge Fields column, 
the import field you selected will appear in the Matching Import 
Field column. 
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NOTE : Some fields must be imported MYOB AccountEdge fields 
that have asterisks (*) next to them must have matching import file 
fields assigned to them. 
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If you want to remove an import field from the Matching Import 
Field column, simply click it. If all the fields in the import file match 
the fields in the AccountEdge Fields column, you can match all the 
fields at one time by clicking Match All at the bottom of the 
window.

6 After you have matched the fields, click Import. The data is 
imported into MYOB AccountEdge. If you get a warning or an error 
message indicating that the import was not successful, refer to the 
import log file in your MYOB AccountEdge application folder for a 
list of errors or warnings. This is a text file—readable by most word 
processors—that lists any problems encountered during the import.
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Exporting Data from MYOB AccountEdge
You can take various data entered in MYOB AccountEdge and use it 
in other software applications or in other MYOB software company 
files. This process is called exporting data.

You can export the following types of information from MYOB 
AccountEdge: accounts, items, cards, activities and activity slips, 
journal entries, sales and purchases.

You can export data from MYOB AccountEdge in a tab-delimited or 
comma-separated file format. 

For more information, in MYOB Help, choose Importing/Exporting 
and click the topic Importing/Exporting > Exporting data from MYOB 
AccountEdge > To export data from AccountEdge.

NOTE : Single-user access Please note that this task requires single-
user access. For more information, see “Tasks that require single-user 
access” on page 193.

To export data

1 Go to the File menu, choose Export Data, and then choose the 
type of data you want to export. The Export File window is 
displayed. 

2 Select the export file format and enter other information in this 
window. For detailed field help, click Help. 

3 Click Continue. The Export Data window is displayed.

4 Choose the MYOB AccountEdge fields you want to export, and the 
order in which you want to export them. To do this, click on the first 
field you want to export in the AccountEdge Fields column. The 
title Field 1 will appear in the Export Order column next to the field 
you selected. The field name will appear at the top of the Export 
Fields column on the left side of the window. 
User Guide
5 Repeat the previous step for each field you want to export.

NOTE : Some fields must be exported MYOB AccountEdge fields 
that have asterisks (*) next to them must be included in the Export 
Fields column before you can export any data.

If you want to remove a field’s name from the Export Fields 
column, click the field’s name in the MYOB AccountEdge Fields 
column. If you want to export all the fields in the order they’re 
shown in the AccountEdge Fields column, click Match All. 

6 When you have selected the fields, click Export. In the dialog box 
that is displayed, enter a file name and location for the export file 
and click Save. The file is exported.
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Exporting to and Importing from CaseWare
Accountants routinely ask their clients to provide financial 
information in an electronic format that can be loaded into their 
software applications. This makes it easier for the accountants to 
examine and analyze their clients’ records. After examining their 
records, accountants may make adjustments to the records that 
need to be entered into MYOB AccountEdge. 

If your accountant requests an electronic copy of your accounting 
records, you can use MYOB AccountEdge to create a comma-
separated text file that can be read by CaseWare, a client write-up 
software package that is popular among accountants. 

The file that is created through the export process will contain your 
company information, account information and journal entries. See 
‘To export to CaseWare’ below.

If your accountant makes adjusting journal entries that he or she 
wants you to enter into your MYOB AccountEdge company file, you 
can also use MYOB AccountEdge to import an electronic copy of 
the journal entries that your accountant gives you. All transactions 
will be imported as General Journal entries. See ‘To import from 
CaseWare’ below.

To export to CaseWare

1 Make a backup of your MYOB AccountEdge company file. 

2 Go to the File menu, choose Accountant Link and then Export to 
CaseWare. The Export File window is displayed. 

3 If you want to export journal entries in addition to company 
information and accounts, mark the Include Journal Entries in 
Export File checkbox. (Keep in mind, however, that exporting 
journal entries may take some time, and probably will create a very 
large export file.) 
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4 From the Dated to end of list, choose the most recent month you 
want to include in the file. All journal entries from the first day of the 
fiscal year through the last day of the month you selected will be 
included in the text file. 

5 When you’re ready to create the CaseWare export file, click Export. 

6 In the dialog box that is displayed, specify a location and file name 
for the export file (do not change the .TXT file name extension). 
Click OK or Save to begin creating the CaseWare export file. 

When the file has been created, you're ready to send the file to your 
accountant, who can then import it into CaseWare.

To import from CaseWare

Before you begin the import process, you should obtain from your 
accountant the import file containing the General Journal entries 
that you want to import.

NOTE : Single-user access Please note that this task requires single-
user access. For more information, see “Tasks that require single-user 
access” on page 193.

1 Make a backup of your MYOB AccountEdge company file.

2 Go to the File menu, choose Accountant Link and then Import 
from CaseWare. The Open dialog box is displayed.

3 Locate the import file that your accountant sent you and click Open. 
The import process begins immediately. 

If you get a warning or an error message indicating that the import 

was not successful, refer to the import log file in your MYOB 

AccountEdge program folder for a list of errors or warnings. This is a 

text file—readable by most word processors—that lists any 

problems encountered during the import.
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Appendix B More Tools for Managing
Your Business

In addition to being a superior accounting system, MYOB OfficeLink templates to create the letters quickly. OfficeLink then 

AccountEdge can be an effective business management tool. This 
section lists some tools available in MYOB AccountEdge. They are 
described in detail in MYOB Help. 

Maintaining a Contact Log

The Contact Log in MYOB AccountEdge lets you maintain a 
comprehensive list of business contacts, which includes sales, 
purchases, phone calls, mailings and so on, for every person and 
company in your Card File. Use your business contacts and the 
Contact Log as your “diary.” When a customer or vendor calls, you 
can use the Contact Log to document a complete history of your 
business relationship with that contact.

You can even use the business contacts you enter in MYOB 
AccountEdge to create a system of billing for the time you spend 
with your customers. See Chapter 10, ‘Billing For Time,’ on 
page 131.

For more information on creating and maintaining a contact log in 
MYOB AccountEdge, in MYOB Help, choose Cards > Maintaining 
business contacts.

Creating personalized letters

Communication with your business contacts is essential to the 
success of your business. With OfficeLink, you can easily create 
personalized letters to your clients, whether it is a note of 
appreciation, a reminder about unpaid invoices, or a letter 
conveying the status of an order. You can use one of the many 
seamlessly exports the letters and your contacts’ card file 
information into your word processing application, where you can 
print them.

For more information on how to use OfficeLink, in MYOB Help 
choose Reports and Forms > OfficeLink and click the topic Creating 
personalized letters using OfficeLink.

Setting up reminders using the To Do List

The To Do List in MYOB AccountEdge contains lists of reminders 
that inform you to perform your regular business tasks on a 
consistent basis. The To Do List will tell you, at a glance, when you 
need to recontact a client, when your stock needs to be reordered, 
when your discounts expire, and much more. MYOB AccountEdge 
uses the dates you set up in the Business Calendar window to add 
reminders to the To Do List. If the number of days for a 
reminder—except for money due to you that’s overdue—places the 
reminder on a non-business day, the reminder will be moved to the 
previous business day. 

For more information on how to use the To Do List, click To Do List 
in any command centerand click Help . 
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Organizing your cards 

Identifiers are one-letter labels you can assign to cards to help you 
organize your cards into groups. When you create reports or view 
information about cards, you can limit the information you view to 
that of a specific group of cards by indicating the identifiers you’ve 
assigned to the cards in that group.

To create identifiers

1 Go to the Lists menu and choose Identifiers. The Identifiers 
window provides a field for each of the 26 letters of the alphabet. 

2 Enter a description for as many of the identifiers as you want and 
click OK.

To assign identifiers to a card

1 Display the required card in the Card Information window.

2 Click the Card Details tab and click Identifiers. 

3 Mark the checkbox beside the identifiers you want to assign to the 
card. 

4 Click OK. 

Recording additional information about your 
cards

If you need to record additional information about your cards that 
may be specific to your business, you can use the custom lists and 
fields in the Card Information window to do so. MYOB 
AccountEdge contains three custom lists and three custom fields for 
each card type. You can label them according to your needs.

Custom fields allow you to enter any information you like—for 
example, they can be used to indicate an employee's last review 
date. You then use the Report Design feature to display that 
information on your reports. 
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Custom lists enable you to create lists of predefined attributes that 
remain standard over time and can be used to sort your cards—for 
example, they can be used to sort customers according to your sales 
territories. You then use MYOB AccountEdge’s Report Filter to 
choose which sales territory list you want to display in your report.

For information about creating custom lists and custom fields for 
your cards, in MYOB Help, choose Setup, click a topic under the 
heading Using custom lists and fields in the Table of Contents.

Linking a picture to a record

You can link a picture—a PICT file, TIFF and JPG—to a card or item. 
The picture is displayed in the Card Information or Item 
Information window.

The pictures are stored in the Graphics folder in your MYOB 
AccountEdge application folder. If you move your company file, you 
must move the Graphics folder to the same location to continue 
displaying the pictures.

To display a picture

1 Display the required card in the Card Information window (or item 
in the Item Information window). 

2 Click the Card Details tab (or the Item Details tab) and double-
click the picture file area. The Picture Information window is 
displayed.

3 Click Link. The Open dialog box is displayed.

4 Locate the graphic file you want to display for this card or item and 
then click OK or Open. The Picture Information window is 
displayed, with the selected picture appearing on the right. 

5 Click OK. The picture appears in the Card Details/Item Details tab.
MYOB AccountEdge, Version 3 us



To change the picture

If you want to replace the displayed picture with another, double-
click the displayed picture and continue with step 3 of the above 
procedure. 

To remove a displayed picture

If you want to remove the displayed picture from the Card 
Details/Item Details tab, double-click the picture. In the Picture 
Information window, click Unlink and then click OK. The graphic 
will disappear from the Card Details/Item Details tab but will 
remain in the Graphics folder.

Using the Business Calendar

MYOB AccountEdge has a Business Calendar that you can 
customize to suit the needs of your business. You can: 

� Establish the days on which your business is closed for the 
upcoming year, so reminders on your To Do List appear on 
open-for-business days. 

� Note which days of the year contain important company events.

Display the Business Calendar by choosing Business Calendar from 
the Setup menu. For more information on using the Business 
Calendar, click Help in this window. 
User Guide
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using on a network 192

company information, entering 15

components, using to auto-build 
items 90

consolidated tax codes 36

contact log 201

Contact Log Entry window 201

contact reminder 201

conversion month
defined 14
entering 15

Copy From button 37

cost of sales, account for tracking 38

Count Inventory window 40 93

counting inventory 93

credit card
recording payments 57
recording purchases 57

credit card statement
importing into MYOB 55
matching transactions with 55

credit terms
changing customer terms during 

sale 61
changing when recording a 

purchase 75
setting up default 25 28

Credit Terms window 61 75

currency calculator 148

Currency Information window 142

Currency List window 142

custom fields
recording card details using 202
recording item details using 98

custom forms
adding pictures and logos 157
changing font characteristics 158
custom checks 156
drawing lines on forms 157
drawing rectangles on forms 157
hiding inactive fields 159
hiding inactive forms 159
inactivating fields 159
moving elements around on the 

form 159
previewing a customized form 156
printing a customized form 156
removing elements 159
resizing elements 158
saving a customized form 156
setting up page properties 156
specifying form size 156
using the Tool palette 157

custom lists
printing on purchases and 

invoices 99
using in cards 202
using to filter inventory reports 99
using to group items 99

custom price levels 97

customer credits
creating by reversing a sale 70
creating manually 70
deleting 114
issuing to customers 70
settling by applying to a sale 71
settling by writing a refund check 72

customer overpayments 68

customer payments
discount for early payment 68
group with undeposited funds 67

customer statements
printing 153

customers
assigning a price level to 98
changing credit terms of during 

sale 61
creating cards 26
setting billing rates for 133
setting up default credit terms 25

customizing MYOB 21
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[data ] [ Internet banking]
D

data
importing from other 

applications 197
limiting access to. See passwords
removal of data no longer 

needed 190

data fields
changing font characteristics of sev-

eral fields at once 158
changing font characteristics of sin-

gle field on a form 158
changing size of 158
forms, changing font characteristics 

of 158
inactivating on a form 159

data file. See company file

deduction categories
assigning to employees 122
creating 122
deleting 125
editing 125

deduction categories, creating 120

deductions, linked account for 32

deleting
records 106
transactions 114

deposits
recording 50
recording in the Bank Register 53
saving as recurring 49

Detail accounts 22

discounts
giving customers 62
receiving early payment discount 

from vendor 83
receiving from vendor 76
reversing customer payments 

with 115
reversing vendor payments with 115

E

early payment discount 68
User Guide
Easy Setup Assistant 20

Easy-Fill 21

e-mail
purchases 77
sales 63
sending reports by 168

Employee Payroll Information 
window 33

employees
assigning accrual category to 121
assigning deduction category to 122
assigning employer expense cate-

gory to 123
creating cards 32
pay history, entering 34
paying 126
setting billing rates for 133
viewing sales history for 67

employer expense categories
assigning to employees 123
creating 120 122
deleting 125
editing 125

employer expenses, linked account 
for 31

end-of-month. See month-end tasks

end-of-year
end of fiscal year tasks 179 180
end of payroll year tasks 182

entitlement categories
creating 120

errors, checking for in company 
file 190

Excel, viewing MYOB reports in 169

exchange accounts for tracking for-
eign transactions 142

expiring discounts alert 201

Export Data window 199

exporting data
to CaseWare 200
to MYOB 199
F

faxing
purchases 77
reports 168
sales 63

Field Information window 159

file locking
single-user 193
using to protect your data 193

finance charges
calculating 69
deleting 69

Find Transactions
description 17
finding transactions using 110

finished item, defined 90

fiscal year
end-of-year tasks 179 180
last month of 14
starting a new year 180
tasks to perform at end of 179
what is your fiscal year? 14
when to close 179

fonts
changing on individual reports 165
characteristics of, changing on 

forms 158

foreign currency
adding a new currency 142
making changes to 105

foreign purchases. See multicurrency

foreign sales. See multicurrency

Form menu 155

forms
customizing. See custom forms
finding 152
plain paper layout, choosing 153
preparing to print 170
pre-printed layout, choosing 153
printing 153
reviewing before printing 154

Forms Selection window 153

freight, charging customer for 62
G

General Journal entries
exporting data

to CaseWare 200
importing data

to CaseWare 200

Get Statement button 55

Getting Started guide 11

H

Header accounts 22

headers, using to group line items in 
transactions 63 77

Help buttons, in windows 11

historical purchases, entering 30

historical sales, entering 27

HTML format, saving reports in 168

I

I Buy this Item 37

I Inventory this Item 37

I Sell this Item 37

Identifiers, using to group cards 202

import file formats, for importing 
statements 55

import log file 198

importing
bank statements 55
credit card statements 55
data from CaseWare 200
data from other applications 197

inactivating records not used 
frequently 107

Index to Reports window 162

initial bank reconciliation 41

international transactions. See multi-
currency

Internet banking
Importing statements 55
recording transfers 58
Index 207



[Internet, viewing online help file on 21] [opening balances]
Internet, viewing online help file 
on 21

inventory
auto-building items 91
auto-building items using the To Do 

List 92
changing prices of 96
counting 93
custom lists and reports 99
custom price levels 97
making adjustments to 88
making transfers 90
reports 95
using custom fields 98
using custom lists 99

Inventory command center 88

invoices
creating time billing invoices 138
entering 60
entering line items on 61
inserting blank lines in 63
printing 153
printing custom lists on 99
showing subtotal of line items on 63
using headers to group line items 

on 63

Item Information window 37 202

items
asset account for tracking value 

of 38
auto-building 91
auto-building using the To Do 

List 92
average cost, how it’s calculated 96
base selling price 39
changing prices of 96
changing prices of multiple items at 

once 96
counting 93
creating item records 37
default reorder quantity 39
deleting 106
entering opening quantities and 

value 40
exporting 199
finding 104
Index208
finished item, defined 90
I Buy this Item checkbox 37
I Inventory this Item checkbox 37
I Sell this Item checkbox 37
importing 197
including on time billing 

invoices 132
last cost 96
linking picture to 202
making adjustments to account for 

loss 88
making changes to 105
making inventory transfers 90
number per buying unit 38
number per selling unit 39
price levels, setting custom 97
setting restocking alert 39
setting up 37
using custom fields for recording 

details of 98
using custom lists to group 99
viewing purchase history 81 95
viewing sales history 67

Items Register
finding transactions using 112

J

jobs
assigning to purchase 76
budget allocation 45
changing levels of 44
deleting 106
Detail jobs 44
entering opening balances 44
finding 104
Header jobs 44
making changes to 105
setting up 42

journal entries
exporting 199
importing 197

L

last cost 96
learning tools 10

line items
defined 75
entering in the Purchases 

window 75
entering in the Sales window 61
inserting blank lines between 63 77
showing subtotal of 63 77
using headers to group 63 77

lines
changing the length of 158
forms, drawing on 157

linked accounts
setting up payroll accounts 31
setting up purchase accounts 28
setting up sales accounts 26

lists
adding records to 102
deleting records from 106
inactivating records in 107

Lock Periods preference 178

logos
adding to forms 157
changing size of on forms 158

M

Mail Merge button 66

mailing labels, printing 153

mailouts 201

Match Transaction window 55

matching transactions 55

minimum stock levels 39

month-end tasks
closing accounting period after 

completing 178
paying payroll taxes 177
reconciling accounts 176
reviewing and adjusting 

budgets 175
reviewing cash flow 175
reviewing order status of items 175
reviewing your trial balance 174

multicurrency
’I deal in multiple currencies’ 
preference 142

accounts for tracking foreign 
purchases 143

accounts for tracking foreign 
sales 142

adding a new foreign currency 142
exchange accounts 142
reports 148
setting up MYOB for 141
tracking realized currency 

gains/losses 146
transferring funds to foreign 

account 148
unrealized gains and losses 147

MYOB Help 10

MYOB software
starting 12

N

network
how passwords work on 192
how preferences work on 192
printing reports 194
storing custom reports on 195
using your company file on 192

New Company File Assistant 14

new company file, creating 14

new features in this version 12

new year
starting a new fiscal year 180
starting a new payroll year 183

non-cash wages, including on 
paycheck 127

O

OfficeLink
creating collection letters 66
creating personalized letters 201

online banking, importing 
statements 55

online help. See MYOB Help

opening balances
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[optimizing your company file 190 ] [realized gains and losses ]
entering for accounts 23
entering for jobs 44

optimizing your company file 190

orders
converting an order to a bill 79
converting an order to an invoice 65
converting several orders to bills at 

once 79
converting several orders to invoices 

at once 65
entering purchase orders 74
entering sales orders 60

overdue invoices
creating collection letters using 

OfficeLink 66
viewing list of 66

overpayment by customer 68

P

Password Access window 186

passwords
how they work in a network 

environment 192
setting up master password 186
setting up sub-passwords 186

pay basis 33

Pay Bills window 82 83

Pay Employees window 126

pay frequency, specifying 33

pay history
entering for employees 34

pay history, entering for 
employees 34

payables, analyzing 81 95

paychecks
changing 128
deleting 128
including types of wages on 127
linked account for 31
printing 128 153
reversing 128
saving as recurring 128
writing 126
User Guide
payment method, setting up 
default 25

payroll
setting up 31
setting up linked accounts 31

payroll categories
assigning to employees 34
creating 120
deleting 106 125
editing 125
finding 104
making changes to 105
reviewing 32
reviewing on paycheck 126

payroll checks. See paychecks

Payroll Easy Setup Assistant 31

payroll taxes
defined 124
paying 177

payroll year
end-of-year tasks 182
entering current 31
starting a new year 183
when to close 179

pending purchases. See purchase 
orders

pending sales. See sales orders

personalized letters
creating 201
printing 153

pictures
adding to forms 157
changing size of on forms 158
linking to card records 202
linking to item records 202
removing from records 203
replacing in records 203

Portable Document Format (PDF) file
saving purchases as 77
saving reports as 168
saving sales as 63

preferences
how they work on a network 192
I Prefer to Use Help From the 

Internet 21
Prevent Data Changes During Report 
Generation 194

Select and Display Account Name, 
Not Account Number 21

setting up 21
system-wide preferences 192
time billing 132
Transactions CAN’T be Changed 21 

115

Prepare Bank Deposit window 50 
114

price levels
assigning to customer 98
creating custom 97

prices
changing item prices 96
changing prices of multiple items at 

once 96

printers, preparing to print reports 
and forms 170

printing
checks as you record them 52
choosing page setup options 170
invoices as they are recorded 63
payments as they are recorded 83
purchases as they are recorded 77
reports when others are using com-

pany file 194

purchase activity, viewing 111

purchase details, setting up 28

purchase history
viewing for items 81 95
viewing for vendors 81

purchase layout, setting up 
default 28

purchase orders
entering 74
printing 153

purchases
assigning jobs to 76
changing credit terms when 

recording 75
changing status of 78
choosing type of 74
deleting 114
e-mailing 77
entering 74
exporting 199
faxing 77
from overseas vendors. See multicur-

rency
historical purchases, entering 30
importing 197
inserting blank lines in 77
line items on, entering 75
printing custom lists on 99
recording 74
recording in the Bank Register 53
reports 81
saving as a PDF file 77
saving as recurring 77
setting up linked accounts 28
viewing list of unpaid purchases 80 

94
with credit card 57

Purchases command center 74

Purchases Easy Setup Assistant 28

Purchases Register
finding transactions using 111

Purchases window
showing subtotal of line items 77
using headers to group line items 77

purging information 190

Q

Quicken, data import 197

quotes
converting to orders or bills 78
converting to orders or invoices 64
recording a vendor’s quote 74
recording quotes made to 

customers 60

R

reactivating a record 107

realized gains and losses
tracking on sales and purchases 146
tracking on transfers 146
Index 209



[Receive Money window 48] [tax tables]
Receive Money window 48

receive payments 67

receive payments, recording in the 
Bank Register 53

Receiving Money 48

receiving payments (account transac-
tions)

grouping with undeposited funds 67

receiving payments (cash transac-
tions)

grouping with undeposited funds 48

Reconcile Accounts window 41

reconciling accounts
at month-end 176
for the first time 41
matching transactions with bank 

statement 55

Record Journal entries
exporting to CaseWare 200
importing from CaseWare 200

records
creating new 102
deleting 106
making active or inactive 107
making changes to 105

rectangles
forms, drawing on 157

recurring transactions
creating 116
deleting 118
making changes to 118
saving checks as recurring 52
saving deposits as recurring 49
saving paycheck as recurring 128
saving purchases as recurring 77
saving sales as recurring 63
using 117

refreshing lists, in a multi-user 
environment 195

refunds. See customer credits; vendor 
debits

removing
transactions 114

reorder quantity, setting for items 39
Index210
report batches
creating 172
deleting 172
making changes to 172
printing 172

Report Design window 165

reports
custom reports, storing on 

network 195
customizing 163
designing 164
displaing onscreen 167
filtering information appearing 

on 163
finding 162
formatting 165
inventory reports 95
multicurrency reports 148
preparing to print 170
printing when others are using com-

pany file 194
purchase reports 81
sales reports 66
saving as a comma-separated text 

file 168
saving as a PDF file 168
saving as a simple text file 168
saving as a tab-delimited text 

file 168
saving as an HTML file 168
saving custom reports 166
sending by e-mail 168
sending by fax 168
using custom lists as filters 99
using wildcards to filter 164
viewing in Microsoft Excel 169
viewing sample of 162

restoring a backup 189

returns. See customer credits; vendor 
debits

reversing transactions 115

Review Sales Before Printing 
window 154

rounding time, in time billing 132
S

sale layout
selecting 60
setting default 25

sales
analyzing sales activity 66
changing status of 64
choosing type of 60
deleting 114
e-mailing 63
entering 60
entering historical sales 27
exporting 199
faxing 63
importing 197
income account for tracking sales 38
recording in the Bank Register 53
reviewing information about 65
saving as a PDF file 63
saving as recurring 63
setting up linked accounts 26
setting up sales details 25
to overseas customers. See multicur-

rency
viewing list of unpaid sales 66

Sales command center 60

sales commissions, including on 
paycheck 127

Sales Easy Setup Assistant 25

sales history, viewing for item, cus-
tomer or employee 67

sales orders
entering 60
printing 153

Sales Register
finding transactions using 110
viewing and editing sales in 110

sales reports, viewing 66

Sales window
showing subtotal of line items 63
using headers to group line items 63

Sales-New Time Billing window 139

sample company file, experimenting 
with 12
Save Recurring Template 
window 116

search fields, using to find 
records 104

search icons 18

selling details, setting up default 
entries 25

Set Item Prices window 96

Settle Returns & Credits window 71

Settle Returns & Debits window 86

sharing company file on a 
network 192

sick pay, including on paycheck 127

Sign-On window 193

single-user access, tasks that 
require 193

single-user file locking 193

Social Security Number, entering an 
employee’s 33

Spend Money window 51

spending money 51

Split button 54

stock quantities, entering 40

stock reorder alert 201

subtotal, showing in transactions 63 
77

suppliers. See vendors

T

tabs, using to find records in lists 104

tax 106

tax codes
consolidated tax codes 36
creating 35
making changes to 105
setting up default for purchases 28
setting up default for sales 25

tax tables
checking Revision Date 124
loading 31
updating to latest revision 124
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[telephone banking, recording transfers 58] [zoom arrows 17]
telephone banking, recording 
transfers 58

text fields
adding to forms 157
changing font characteristics of 158
changing size of on forms 158
description of 155

thirteen accounting periods 15

time billing
activities, creating 134
activities, defined 134
activity slips 135
adjusting accounts to reflect work in 

progress 140
creating invoices 138
creating invoices in the Sales 

window 140
including items on invoices 132
rounding time 132
setting billing rates 133
setting preferences 132
tracking work in progress 140
using a timer 136
using special billing units 132

timer
resetting 136
using when billing for time 136

To Do List
auto-building items using 92
description 17
making vendor payments from 80
setting up reminders 201

Tool palette 155 157

tracking employees’ time. See time 
billing

Transaction Journal window 113

Transaction Journal, finding transac-
tions using 113

Transactions
adding to MYOB from bank or credit 

card statement 57

transactions
creating recurring 116
deleting 114
finding 110
User Guide
making changes to 114
reversing 115
transactions that cannot be 

changed 114
using recurring transactions 117

Transactions CAN’T be Changed 
preference 21 115

Transfer Inventory window 90

transferring inventory 90

Trial Balance report, reviewing at 
month-end 174

U

unchangeable transactions 115

uncleared transactions, matching 55

undeposited funds
grouping payments (account trans-

actions) with 67
grouping payments (cash transac-

tions) with 48
preparing bank deposit for 50

unpaid invoices, sending reminders 
to customers with 201

unrealized currency gains and 
losses 147

Use Recurring button 117

user guide 10

users, viewing list of 193

V

Vaction pay, including on 
paycheck 127

vendor debits
creating by reversing purchase 84
creating manually 84
deleting 114
settling 85

vendors
creating cards 29
credit terms, changing when record-

ing purchase 75
entering discounts from 76
item number 38
paying 82
paying in the Bank Register 53
receiving early payment discount 

from 83
recording quote received from 74
setting up default credit terms 28
viewing purchase history 81

Verify Company File command 190

View Contact Log window 201

voiding check number 58

W

W-2 forms, printing at year-end 182

wage categories
creating 120
deleting 125
editing 125

wages
linked account for 31
paying sick pay wages 127
paying vacation wages 127

Welcome to MYOB window 12

Widgets & Co., sample company 
file 12

wildcards, using to filter reports 164

Withholding Payer Number (WPN), 
entering 31

work in progress
adjusting accounts to reflect 140
tracking 140

Y

year
fiscal 179
starting a new payroll year 183
starting new fiscal year 180

year, fiscal 179

year-end
fiscal year-end 179 180
payroll year-end 182
Z

zoom arrows 17
Index 211
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